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Preface 
 
Design Processing consists of the generation of Design Data for Construction Plan and Right of 
Way Plan Deliverables and coordination/oversight of other Plan Deliverables. Designers utilize the 
InRoads platform for the generation of the Design database(s) used in the development of highway 
project plans. MicroStation is the CADD platform utilized for the generation of highway project 
plans. 
 
These Design Guidelines have been developed as part of the statewide GDOT implementation of 
MicroStation V8i and InRoads V8i Select Series 2. The intent of this document is to provide 
guidelines and standards for generating Design Data in InRoads V8i Select Series 2.  These 
guidelines must be followed in detail in order to conform to the current GDOT standards for 
producing the required design data for plan deliverables.  Updates to this document will be made 
periodically when minor revisions, additional information, and/or enhancements are added. 
 
 
 
If there is any approved deviation from the standard file and data naming/feature style conventions 
as prescribed by this document - a detailed description of the deviation(s) and approved reasons for 
the deviation(s) shall be documented and included with the project files in electronic format. 
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Contact Information 
 
To submit any comments or questions regarding the information contained in this document, 
please contact the Office of Design Policy & Support team by email at the following address: 
 
SolutionsCenter@dot.ga.gov  
 
In the Email Subject Header, please reference the InRoads Design Guidelines. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:SolutionsCenter@dot.ga.gov?subject=InRoads%20Design%20Guidelines


 vi 

This Page Left Intentionally Blank 
 

 

 



Table of Contents    InRoads Design Guidelines SS2 

vii 
  

TABLE OF CONTENTS 
1. PROJECT INITIALIZATION STANDARDS .................................................................................................. 1-2 

1.1 GDOT STANDARD FILES –MICROSTATION AND INROADS ........................................................................... 1-3 
1.2 STANDARD PROJECT STRUCTURE ................................................................................................................... 1-5 
1.3 STARTING A DESIGN PROJECT IN INROADS .................................................................................................... 1-6 

1.3.1 Copy and Rename the SDE DGN Files and SDE InRoads Files ............................................................. 1-6 
1.3.2 Copy the “Standards” folder which is downloaded from InRoadsALL.exe ............................................ 1-8 

1.4 STARTING MICROSTATION V8I AND INROADS V8I ....................................................................................... 1-9 
1.4.1 Steps to Create a Design “Working” DGN File .................................................................................... 1-10 
1.4.2 Steps to open an existing Design “Working” DGN File ........................................................................ 1-13 

1.5 OVERVIEW OF INROADS INTERFACE ............................................................................................................ 1-14 
1.6 INROADS PROJECT DEFAULTS ...................................................................................................................... 1-15 
1.7 DESIGN DEFAULT PREFERENCES .................................................................................................................. 1-18 
1.8 INROADS “LOCKS”........................................................................................................................................ 1-20 
1.9 APPLICATION AND VARIABLE MANAGER ADD-INS ..................................................................................... 1-22 

1.9.1 Steps to select the Application Add-Ins: ................................................................................................. 1-22 
1.9.2 Steps to select the Variable Manager Add-Ins: ...................................................................................... 1-23 

2. STANDARD CONVENTIONS ............................................................................................................................ 2-2 
2.1 PROJECT AND FILE NAMING CONVENTIONS ................................................................................................... 2-3 

2.1.1 Standard Project Naming Conventions .................................................................................................... 2-3 
2.1.2 Standard File Naming Conventions .......................................................................................................... 2-4 

2.2 STANDARD GEOMETRY OBJECT NAMES AND FEATURE STYLES ................................................................... 2-5 
2.2.1 Standard Design and Survey Object Naming Conventions ...................................................................... 2-6 
2.2.2 Standard Geometry Survey and Design Feature Style Conventions ........................................................ 2-8 

2.3 STANDARD DESIGN FEATURE STYLES .......................................................................................................... 2-11 
2.4 STANDARD FILE INFORMATION .................................................................................................................... 2-15 
2.5 STANDARD PREFERENCE FILE (XIN) AND GDOT PREFERENCES ................................................................ 2-16 

2.5.1 Standard Preference File (XIN) Configuration ...................................................................................... 2-16 
2.5.2 Standard Preference File (XIN) Details ................................................................................................. 2-17 
2.5.3 GDOT Preferences .................................................................................................................................. 2-18 

2.6 GDOT STANDARD INROADS PHOTOGRAMMETRIC FEATURE CODES.......................................................... 2-32 
2.7 GDOT STANDARD INROADS FIELD SURVEY FEATURE CODES ................................................................... 2-33 

3. HORIZONTAL ALIGNMENTS ......................................................................................................................... 3-2 
3.1 HORIZONTAL ALIGNMENT OVERVIEW ........................................................................................................... 3-3 
3.2 HORIZONTAL ALIGNMENT AND COGO POINT NAMES/FEATURE STYLES .................................................... 3-4 
3.3 COGO POINTS AND ALIGNMENT POINTS ....................................................................................................... 3-6 
3.4 VIEW HORIZONTAL ANNOTATION PREFERENCES .......................................................................................... 3-7 
3.5 VIEW HORIZONTAL ANNOTATION FILTERS .................................................................................................... 3-9 
3.6 REVIEWING HORIZONTAL ALIGNMENTS ...................................................................................................... 3-10 

4. VERTICAL ALIGNMENTS ................................................................................................................................ 4-2 
4.1 VERTICAL ALIGNMENT OVERVIEW ................................................................................................................ 4-3 
4.2 VERTICAL ALIGNMENT NAMES AND FEATURE STYLES ................................................................................. 4-4 
4.3 VERTICAL ALIGNMENT PREFERENCES ........................................................................................................... 4-5 
4.4 VERTICAL ALIGNMENT ANNOTATION PREFERENCES .................................................................................... 4-6 
4.5 REVIEWING VERTICAL ALIGNMENTS ............................................................................................................. 4-7 

5. IMPORT GRAPHICS AND PLACE CURVE TABLES ................................................................................. 5-2 
5.1 IMPORT GRAPHICS OVERVIEW........................................................................................................................ 5-3 
5.2 IMPORT GRAPHICS - NAMES/FEATURE STYLES .............................................................................................. 5-4 
5.3 CURVE TABLE OVERVIEW .............................................................................................................................. 5-5 
5.4 CURVE TABLE PREFERENCES ......................................................................................................................... 5-6 



Table of Contents   InRoads Design Guidelines SS2 

 viii 

6. PROFILE SHEETS ............................................................................................................................................... 6-2 
6.1 PROFILE SHEETS OVERVIEW ........................................................................................................................... 6-3 
6.2 PLAN AND PROFILE GENERATOR INFORMATION ............................................................................................ 6-4 
6.3 VERTICAL ALIGNMENT PREFERENCES ........................................................................................................... 6-5 
6.4 VERTICAL ALIGNMENT ANNOTATION PREFERENCES .................................................................................... 6-6 

7. COMPONENT AND TEMPLATE CREATION .............................................................................................. 7-2 
7.1 COMPONENT AND TEMPLATE CREATION OVERVIEW ..................................................................................... 7-3 
7.2 ITL TEMPLATE LIBRARY AND NAMING CONVENTIONS ................................................................................. 7-4 
7.3 GDOT STANDARD COMPONENTS................................................................................................................... 7-5 
7.4 GDOT STANDARD POINT NAMES .................................................................................................................. 7-6 
7.5 GDOT STANDARD FEATURE STYLES ........................................................................................................... 7-10 
7.6 GDOT COMPONENT HELP FILES .................................................................................................................. 7-12 

8. ROADWAY DESIGNER ...................................................................................................................................... 8-2 
8.1 ROADWAY DESIGNER OVERVIEW .................................................................................................................. 8-3 
8.2 ROADWAY DESIGNER WORKFLOW ................................................................................................................ 8-4 
8.3 IRD (ROADWAY DESIGN) NAMING CONVENTIONS........................................................................................ 8-5 
8.4 CORRIDOR NAMING CONVENTIONS ................................................................................................................ 8-6 
8.5 SUPERELEVATION PROCESS WORKFLOW ....................................................................................................... 8-7 
8.6 DESIGN SURFACE NAMING CONVENTIONS/PREFERENCE .............................................................................. 8-8 
8.7 BOGUS SURFACE NAMING CONVENTIONS FOR TARGET ALIASING ............................................................... 8-9 

9. CROSS SECTION SHEETS/ANNOTATION GENERATION ...................................................................... 9-2 
9.1 CROSS SECTION SHEETS/ANNOTATION OVERVIEW ....................................................................................... 9-3 
9.2 FINISHED DESIGN SURFACE (.DTM) PREFERENCE ........................................................................................ 9-4 
9.3 CROSS SECTION SHEET SCALE FACTOR ......................................................................................................... 9-5 
9.4 CROSS SECTION SHEET PREFERENCES ............................................................................................................ 9-6 
9.5 CROSS SECTION SHEET ANNOTATION PREFERENCES ..................................................................................... 9-7 

10. CONSTRUCTION LIMITS ............................................................................................................................... 10-2 
10.1 CONSTRUCTION LIMITS, DITCHES AND DITCH FLOW ARROWS OVERVIEW ................................................ 10-3 
10.2 CONSTRUCTION LIMITS FEATURE STYLES ................................................................................................... 10-4 
10.3 ROADWAY DITCHES FEATURE STYLE .......................................................................................................... 10-5 
10.4 DITCH FLOW ARROW PREFERENCE .............................................................................................................. 10-6 
10.5 DITCH FLOW ARROW ANNOTATE FEATURE STYLE ..................................................................................... 10-7 
10.6 CONSTRUCTION LIMITS DGN AND DITCHES/DITCH FLOW ARROWS DGN ................................................ 10-8 

11. EARTHWORK .................................................................................................................................................... 11-2 
11.1 EARTHWORK OVERVIEW .............................................................................................................................. 11-3 
11.2 MICROSTATION – VIEW ATTRIBUTES SETTING ............................................................................................ 11-4 
11.3 CROSS SECTION PREFERENCES ..................................................................................................................... 11-5 
11.4 GDOT EARTHWORK VOLUMES PREFERENCE .............................................................................................. 11-6 
11.5 GDOT EARTHWORK VOLUME REPORT ........................................................................................................ 11-7 

12. REQUIRED RIGHT OF WAY .......................................................................................................................... 12-2 
12.1 RIGHT OF WAY OVERVIEW ........................................................................................................................... 12-3 
12.2 R/W ALIGNMENT AND COGO POINT NAMES/FEATURE STYLES ................................................................ 12-4 
12.3 R/W COGO POINTS AND ALIGNMENT POINTS ............................................................................................ 12-6 
12.4 R/W VIEW HORIZONTAL ANNOTATION PREFERENCE .................................................................................. 12-7 
12.5 R/W VIEW HORIZONTAL ANNOTATION FILTERS ......................................................................................... 12-8 
12.6 REVIEWING HORIZONTAL R/W ALIGNMENTS .............................................................................................. 12-9 
12.7 R/W DGN FILE GENERATION..................................................................................................................... 12-10 
12.8 R/W AND EASEMENT TABLES (STYLE SHEETS) ......................................................................................... 12-11 
12.9 R/W DEED (STYLE SHEETS) ....................................................................................................................... 12-12 



Table of Contents   InRoads Design Guidelines SS2 

 ix 

13. SURVEY ENHANCEMENTS ........................................................................................................................... 13-2 
13.1 SURVEY ENHANCEMENTS OVERVIEW .......................................................................................................... 13-3 
13.2 SURVEY ENHANCEMENTS TO THE DTM ....................................................................................................... 13-6 
13.3 SURVEY ENHANCEMENTS TO THE ALG ....................................................................................................... 13-7 
13.4 SURVEY ENHANCEMENTS TO THE DGN ....................................................................................................... 13-8 

14. INROADS STYLE SHEETS .............................................................................................................................. 14-2 
14.1 INROADS STYLE SHEETS OVERVIEW ............................................................................................................ 14-3 
14.2 LOCATION OF GDOT STYLE SHEETS............................................................................................................ 14-4 
14.3 LOCATION OF GDOT STYLE SHEET HELP FILES .......................................................................................... 14-5 
14.4 DESCRIPTIONS OF GDOT STYLE SHEETS ..................................................................................................... 14-6 

15. ADDITIONAL FILE DELIVERABLES .......................................................................................................... 15-2 
15.1 ADDITIONAL FILE DELIVERABLES OVERVIEW ............................................................................................. 15-3 
15.2 INROADS FILE DELIVERABLES TO GDOT .................................................................................................... 15-4 

15.2.1 Write Stakeout Data to a Data Collector using InRoads LandXML...................................................... 15-5 
15.2.2 Generate GDOT Deed File(s) ................................................................................................................. 15-8 
15.2.3 InRoads Project Data Sheet(s) ................................................................................................................ 15-9 
15.2.4 GDOT InRoads Design Data Quality Assurance Checklist ................................................................. 15-11 

15.3 INROADS FILE DELIVERABLES TO CONTRACTORS ..................................................................................... 15-13 
15.3.1 Alignment File Descriptions ................................................................................................................. 15-14 
15.3.2 Alignment Report Files ......................................................................................................................... 15-15 
15.3.3 End-Area Report Files ........................................................................................................................... 15-16 
15.3.4 GPS Grading Report Files ..................................................................................................................... 15-17 





Table of Figures  InRoads Design Guidelines SS2  

xi 
  

TABLE OF FIGURES 

Figure 1-1   Starting MicroStation V8i and InRoads V8i ..............................................................1-10 
Figure 1-2   MicroStation New File Window .................................................................................1-11 
Figure 1-3   Main MicroStation V8i Window ................................................................................1-12 
Figure 1-4   Main InRoads V8i Window ........................................................................................1-12 
Figure 1-5   Starting MicroStation V8i and InRoads V8i ..............................................................1-13 
Figure 1-6   Project Defaults ...........................................................................................................1-17 
Figure 1-7   Design Default Settings ..............................................................................................1-19 
Figure 3-1   Review Horizontal Alignment ....................................................................................3-10 
Figure 4-1   Review Vertical Alignment .......................................................................................... 4-7 
Figure 12-1   Review Horizontal Alignment ..................................................................................12-9 
Figure 15-1   LandXML ..................................................................................................................15-7 

 

 

 
 
 



Table of Tables   InRoads Design Guidelines SS2  
  

x 

TABLE OF TABLES 

Table 1.1 ............................................................................................................................................. 1-5 
Table 1.2 ............................................................................................................................................. 1-7 
Table 1.3 ............................................................................................................................................. 1-7 
Table 1.4 ............................................................................................................................................. 1-8 
Table 1.5 ............................................................................................................................................. 1-9 
Table 1.6 ...........................................................................................................................................1-15 
Table 1.7 ...........................................................................................................................................1-20 
Table 1.8 ...........................................................................................................................................1-21 
Table 2.1 ............................................................................................................................................. 2-3 
Table 2.2 ............................................................................................................................................. 2-4 
Table 2.3 ............................................................................................................................................. 2-6 
Table 2.4 ............................................................................................................................................. 2-6 
Table 2.5 ............................................................................................................................................. 2-7 
Table 2.6 ............................................................................................................................................. 2-7 
Table 2.7 ............................................................................................................................................. 2-9 
Table 2.8 ...........................................................................................................................................2-10 
Table 2.9 ...........................................................................................................................................2-12 
Table 2.10 .........................................................................................................................................2-13 
Table 2.11 .........................................................................................................................................2-15 
Table 2.12 .........................................................................................................................................2-16 
Table 3.1 ............................................................................................................................................. 3-4 
Table 3.2 ............................................................................................................................................. 3-4 
Table 3.3 ............................................................................................................................................. 3-5 
Table 3.4 ............................................................................................................................................. 3-7 
Table 3.5 ............................................................................................................................................. 3-8 
Table 3.6 ............................................................................................................................................. 3-8 
Table 3.7 ............................................................................................................................................. 3-9 
Table 4.1 ............................................................................................................................................. 4-4 
Table 4.2 ............................................................................................................................................. 4-4 
Table 4.3 ............................................................................................................................................. 4-5 
Table 4.4 ............................................................................................................................................. 4-6 
Table 4.5 ............................................................................................................................................. 4-6 
Table 5.1 ............................................................................................................................................. 5-4 
Table 5.2 ............................................................................................................................................. 5-4 
Table 5.3 ............................................................................................................................................. 5-6 
Table 6.1 ............................................................................................................................................. 6-4 
Table 6.2 ............................................................................................................................................. 6-5 
Table 6.3 ............................................................................................................................................. 6-6 
Table 6.4 ............................................................................................................................................. 6-6 
Table 7.1 ............................................................................................................................................. 7-4 
Table 7.2 ............................................................................................................................................. 7-5 
Table 7.3 ............................................................................................................................................. 7-6 
Table 7.4 ...........................................................................................................................................7-10 
Table 8.1 ............................................................................................................................................. 8-5 



Table of Tables   InRoads Design Guidelines SS2  
  

x 

Table 8.2 ............................................................................................................................................. 8-6 
Table 8.3 ............................................................................................................................................. 8-8 
Table 8.4 ............................................................................................................................................. 8-8 
Table 8.5 ............................................................................................................................................. 8-9 
Table 9.1 ............................................................................................................................................. 9-4 
Table 9.2 ............................................................................................................................................. 9-5 
Table 9.3 ............................................................................................................................................. 9-6 
Table 9.4 ............................................................................................................................................. 9-7 
Table 10.1 .........................................................................................................................................10-4 
Table 10.2 .........................................................................................................................................10-5 
Table 10.3 .........................................................................................................................................10-6 
Table 10.4 .........................................................................................................................................10-7 
Table 10.5 .........................................................................................................................................10-8 
Table 11.1 .........................................................................................................................................11-4 
Table 11.2 .........................................................................................................................................11-5 
Table 11.3 .........................................................................................................................................11-6 
Table 11.4 .........................................................................................................................................11-7 
Table 12.1 .........................................................................................................................................12-4 
Table 12.2 .........................................................................................................................................12-4 
Table 12.3 .........................................................................................................................................12-5 
Table 12.4 .........................................................................................................................................12-7 
Table 12.5 .........................................................................................................................................12-8 
Table 12.6 ...................................................................................................................................... 12-10 
Table 12.7 ...................................................................................................................................... 12-11 
Table 12.8 ...................................................................................................................................... 12-12 
Table 13.1 .........................................................................................................................................13-8 
Table 14.1 .........................................................................................................................................14-6 
Table 15.2 .........................................................................................................................................15-8 
Table 15.3 ...................................................................................................................................... 15-14 
Table 15.4 ...................................................................................................................................... 15-15 
Table 15.5 ...................................................................................................................................... 15-16 
Table 15.6 ...................................................................................................................................... 15-17 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

xi 
 

Overview 
 
These Guidelines cover the GDOT standards for generating Design Data by utilizing the 
MicroStation V8i and InRoads V8i Select Series 2 software(s).  The procedures depict the Project 
Initialization Standards and Conventions to create an InRoads Design Project to GDOT format and 
the processes to create/generate the files which are to be submitted as deliverables to the 
Construction and Right of Way Offices. 
 
For detailed Design Processing instructions please refer to the Training Manual:  
Introduction to InRoads for Design  
 
Document Content 
Below is a list of topics covered in this document: 
 

• Project Initialization Standards 
• Standard Conventions 
• Horizontal Alignments 
• Vertical Alignments 
• Import Graphics and Place Curve Tables 
• Profile Sheets   
• Component and Template Creation 
• Roadway Designer 
• Cross Section Sheets/Annotation Generation 
• Construction Limits 
• Earthwork 
• Required Right of Way 
• Survey Enhancements 
• InRoads Style Sheets 
• Additional File Deliverables 
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Project Initialization Standards  
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1. Project Initialization Standards 

Project Initialization Standards have been established in order to promote consistency and assist in 
the organization of project data.  These standard project schemes help to ensure uniformity for all 
users who may work on the project.  
 
This section covers the following topics: 
 
● GDOT Standard Files (MicroStation and InRoads) 
● Standard Project Structure 
● Starting MicroStation V8i and InRoads V8i Select Series 2 
● Overview of InRoads Interface 
● InRoads Project Defaults 
● Design Default Preferences 
● InRoads “Locks” 
● Application and Variable Manager Add-Ins 
● Initiating a Design Project in InRoads 
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1.1 GDOT Standard Files –MicroStation and InRoads  
In order to conform to current policy for plan deliverables – GDOT provides the requisite files 
needed to standardize InRoads and MicroStation to GDOT requirements.  The first step in the 
development of an InRoads and MicroStation Project is to ensure that these standard files are 
being utilized.  Instructions for downloading/installing the executables are included on the 
GDOT R.O.A.D.S. web page (see the links depicted below).  These files are required for any 
Survey/Design Data Projects generated for GDOT.    
 
 
• MicroStation Standard Files Location For Internal GDOT Users – a server location has 

been established to map a drive (an N:\ Drive)  in order to access the latest MicroStation 
Files. Once the internal user maps the N:\ drive – all of the standard MicroStation Files will 
be available through this mapped drive. 
 

• MicroStation Standard Files Location For External Users -   a  MicroStation  
    (CaddALL.exe) executable file is available and located in a download   
     executable which can be accessed from the GDOT  R.O.A.D.S. web page. This executable  

contains all of the GDOT MicroStation V8i  Select Series 2 standard files. This file can be 
downloaded by navigating to the MicroStation and InRoads links from the following 
location:     
 
 http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx 

 
• InRoads Standard Files Location For Internal and External Users -  an InRoadsALL 
     executable file (InRoadsALL.exe) is available and located in a download   
     executable which can be accessed from the GDOT  R.O.A.D.S. web page. This executable  

contains all of the GDOT InRoads V8i Select Series 2 standard files. This file can be 
downloaded by navigating to the MicroStation and InRoads links from the following 
location:      

 
        http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
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The InRoadsALL.exe file contains all of the standard GDOT files which are required to 
generate projects to GDOT standards. The user will perform the following steps to extract 
and set-up the GDOT Standard InRoads Files: 
 

1. Close MicroStation V8i and InRoads V8i Select Series 2 if they are still open. 
 

2. Navigate to the InRoads links from the following web page:  
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx 
 

3. Save the InRoadsALL.exe file to the hard drive and then double click the file.  
 

4. The self-extractor will download the GDOT InRoads Standard Files  to the 
following locations:  

a. C:\InRoads Data\Standards\ 
 GDOT_Standard V8i_SS2.xin 
 GDOT_Standard V8i_SS2.itl 
 Project_Data_Sheet_MultipleAlign.docm 
 Photogrammetry_InRoads QA.pdf 
 Survey Data Processing_InRoads QA.pdf 
 Design Data_InRoads QA.pdf 
 GDOT (PI#) Pay Item Database.mdb 

 
b. C:\InRoads Data\Component Documentation 

 GDOT Component Description Help Documentation 
 

c. C:\InRoads Data\Style Sheet Documentation 
 GDOT Style Sheet Help Documentation 

 
d. C:\InRoads Data\Style Sheets\GDOT\ 

 GDOT Style Sheets 
 

5. For detailed instructions on downloading and installing InRoadsALL.exe - navigate 
to the InRoads links from the GDOT  R.O.A.D.S. web page and click on the 
Downloading and Running InRoadsALL.pdf document for installing these 
standard files. 
 
 
 
 
 
 
 
 
 
 
 

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
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1.2 Standard Project Structure 
The standard File Structure for InRoads is a Project Folder (which is named for the PI # of the 
Project – Example:  1234567) located as a sub-folder under C:\InRoads Data – Example: 
C:\InRoads Data\1234567.  The Project Files are then located directly under the PI # – 
Example: C:\InRoads Data\1234567 -- This Project Folder contains the individual InRoads 
Data Files. (See Table 1.1) 
 
 

Table 1.1 
InRoads Project Structure 

 
InRoads Project Structure C:\InRoads Data\PI Number 

 

InRoads Project Structure 
(Example) 

C:\InRoads Data\1234567 
 

 
  Some examples of InRoads Data File Types are: 
 
1. .DTM ------- (Digital Terrain Model File) – contains Surface data 
2. .FWD ------- (Survey File) – contains Field Survey data 
3. .ALG-------- (Geometry File) – contains Geometric Point, Horizontal and Vertical data 
4. .IRD -------- (Roadway Design File) – contains the Design Surface data 
5. .RWK------- (Project File) – contains project data for InRoads files in ASCII format 
6. .ITL--------- (InRoads Template File) – contains InRoads Templates for cross-sections 
7. .SDB-------- (Drainage File) – contains the InRoads Storm and Sanitary data   
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is highly recommended to backup the Project Folder (which contains these individual data 
files) after each work session to your Group Account on the GDOT Server if you are a 
GDOT Employee (or to an appropriate Business Server if you are a GDOT Consultant).  
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1.3 Starting a Design Project in InRoads 
After creating the Design Project folder of C:\InRoads Data\PI Number, – the Designer will 
copy the data received from the SDE to the C:\InRoads Data\PI Number folder. The Designer 
will then copy the Standards folder (which is downloaded through the InRoadsALL.exe 
executable) to the C:\InRoads Data\PI Number folder. 
 

1.3.1 Copy and Rename the SDE DGN Files and SDE InRoads Files 
 

The Designer will receive from the SDE (Survey Data Engineer) some or all of the 
following eight electronic files. These files will be made available for copying from 
SDECommon for Internal GDOT Users.  These files will be located on SDECommon under 
the applicable Project PI Number in a sub-folder named “SDE”.  

 
• PI#_SDE.alg (InRoads Geometry file) 
• PI#_SDE.dtm (InRoads Digital Terrain Model) 
• PI#_TOPO.dgn (Existing Topo features) 
• PI#_PROP.dgn (Existing Property Information) 
• PI#_UTLE.dgn  (Existing Utility features) 
• PI#_PSR.xls (Property Statistics Report) 
• PI#_Hydraulics.docx (Hydraulics report) 
• PI#_Misc.txt (Miscellaneous information SDE deems important.  This file may 

not be included.) 
 
 

1. The Designer will copy this “SDE” folder to the PI# folder on the group account for 
backup.  The Designer is not to work directly from these files but from copies of them.  
 

2. The Designer will also copy this “SDE” folder to the InRoads Data\ PI Number folder.  
The Designer will then copy the individual files located in the “SDE” folder directly to 
the following path:    C:\InRoads Data\PI Number and rename the files according to 
the examples depicted below. 
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**DGN Files –The DGN Files received from the SDE contain an underbar (_) in the file name. 
The reason for this is to assist in differentiating DGN data received from the SDE from that of 
the Design DGN files.  This will assist in organization of data during the enhancement processes.  
The Designer must rename the DGN files from the SDE naming convention to the Design 
naming convention in order for the MicroStation customized Macros to function correctly and to 
conform to the current EDG (Electronic Data Guidelines).  If the Designer does not rename the 
DGN files (and remove the underbars) – the GDOT MicroStation Macros may not function.  
 

Table 1.2 
Re-name SDE DGN Files 

SDE DGN FILE NAME Rename To  DESIGN DGN FILE NAME 
PI#_TOPO.dgn  PI#TOPO.dgn 

PI#_PROP.dgn  PI#PROP.dgn 

PI#_UTLE.dgn  PI#UTLE.dgn 
 
 
**InRoads Files –The InRoads Files received from the SDE must be renamed internally AND 
externally to the Design Naming Convention. 
 
 

Table 1.3 
Re-name SDE InRoads Files  

SDE INROADS FILE NAME Rename To  DESIGN INROADS FILE NAME 
PI#_SDE.alg  PI#_Design.alg 

PI#_SDE.dtm  PI#_Exist.dtm 
 

 
**For detailed instructions regarding the above re-naming process -- please refer to Lab 2 in the 
Design Training Manual:   Introduction to InRoads for Design. 
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1.3.2 Copy the “Standards” folder which is downloaded from InRoadsALL.exe 
 

Important Step:  
After installing InRoadsALL.exe – the user will copy the Standards folder under 
C:\InRoads Data\ to the Project Location. The rest of the Standard Files will remain in 
the default install location.  
 
Whenever a new Project is created – the Designer will download and install 
InRoadsALL.exe. The files will be extracted to the Default Location(s). The reason for the 
install is to ensure the user has the latest published XIN File. The Designer will then 
perform the following step: 
 
 
• The user will copy the C:\InRoads Data\Standards Folder to the InRoads Data\PI# \ 

folder. (Example: C:\InRoads Data\1234567\Standards).   
 

The reason for copying the Standards folder to the Project Folder is that the XIN and ITL 
are project specific and need to be modified during the life of the project. The XIN and the 
ITL will be submitted with the Design Project data so that other users will have access to the 
Templates/Components in the ITL and any project specific preferences or filters that may be 
added to the XIN. 
 
 

Table 1.4 
Copy Standards Folder to Project Folder  

C:\InRoads Data\Standards Copy To  C:\InRoads Data\PI #  
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1.4 Starting MicroStation V8i and InRoads V8i 
The user will be working in both MicroStation V8i Select Series 2 (the CADD Software) and 
InRoads Suite V8i Select Series 2 (the Survey/Design Software).  The MicroStation CADD 
Software is used for the viewing and manipulation of graphics derived from InRoads. The 
InRoads Software is the database in which the Surveying/Design data is created and processed.  
The user will select the standard GDOT 3D “seed” file or GDOT 2D “seed” file to use as the 
“seed” DGN  in order to create the three or two dimensional “Working” DGN file(s). The user 
may desire to work in 3D for the “working” DGN and 2D for plans production DGN’s.  The 
“Working” DGN file(s) are used to display the temporary and/or permanent graphics in 
InRoads.  
 

 This section details the following processes: 
  

● Steps to Create a Design “Working” DGN File 
● Steps to Open an Existing Design “Working” DGN File 

 
 

The “Working” DGN file will be saved to the following folder location: 
C:\InRoads Data\PI Number\Standards 
 
  
 

Table 1.5 
Standard Naming Convention of the “Working” DGN File 

 
Working DGN File Name C:\InRoads Data\PI Number\Standards 

 
GDOT 3D Working File.dgn or 
GDOT 2D Working File.dgn  

 
 
The MicroStation software will open first before InRoads. After the MicroStation Splash 
Screen appears, the MicroStation Manager dialog (See Figure 1-1) will open so that a 
“Working” DGN file can be created or an existing “Working” DGN file can be opened. The 
InRoads software can then be initiated.   
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1.4.1 Steps to Create a Design “Working” DGN File 
 The Design “Working” DGN file will be created from the GDOT_V8_3D.dgn or 

GDOT_V8_2D.dgn seed file.  Following are the steps to create a Design “Working” DGN  
 File: 
  

Please Note:  The current seed file in the MicroStation configuration defaults to a 2D Seed 
File. If the user prefers to create a 3D seed file instead - then the user will need to browse to 
select the 3D Seed file as depicted in the steps below.  Following are the steps to create a 3D 
“Working” DGN File: 

 
1. From the desktop, double-click on the GDOT Microstation V8i SS2 (x86) icon.  

 
 
 
 
 

 
 

2. After the MicroStation Splash Screen appears, the MicroStation Manager dialog 
box will open. (See Figure 1-1).   

 
 

 
                      Figure 1-1   Starting MicroStation V8i and InRoads V8i 

3. In the MicroStation Manager dialog box, click on the New File icon  (See 
Figure 1-1) depicted above. The New File command will be used to create the 
“Working” DGN file. 

Double click on the 
icon labeled 
GDOT MicroStation 
V8i SS2 (x86). 

New File Icon 
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4. After the New File   command is selected, the MicroStation New File dialog 
box will open. (See Figure 1-2).   

 
• Click in the Save in: Pulldown - and browse to the C:\InRoads Data\PI Number\

 Standards location to save the new “Working” DGN file 
• In the File name: Pulldown – enter GDOT 3D Working File.dgn  
• In the Save as type: Pulldown – select MicroStation DGN Files (*.dgn) 
• In the Seed: Field  - Click the Browse button to select the seed file named   
       GDOT_V8_3D.dgn  

 
The Seed File should already be entered in the field based on the current MicroStation 
configuration.   

 
The inputs should now be similar to the screen capture depicted in Figure 1-2 (as shown 
below).   
 

     
 

 

 

 

 

 

Figure 1-2   MicroStation New File Window 

5. Click the Save command button and the MicroStation Manager dialog box will 
appear. 

 
6. In the MicroStation Manager Dialog box – highlight the file just created (GDOT 3D 

Working File.dgn) and click the Open button. 
 
7. The MicroStation V8i Select Series 2 interface will then finish opening. 
8.  In the Main MicroStation Pull-down Menu – click on the following InRoads pull-

downs:  
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9. Select InRoads  InRoads Suite (SELECTseries 2) V8i 08.11.07.566 - and the 
InRoads V8i Select Series 2 interface will open. Once InRoads and MicroStation 
are up and running, the desktop should look similar to that of Figure 1-3 and  
Figure 1-4.  

   

 
                                            Figure 1-3   Main MicroStation V8i Window 
  

  

 

 

                                                Figure 1-4   Main InRoads V8i Window 
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1.4.2 Steps to open an existing Design “Working” DGN File 
 If the Design “Working” DGN file has been created previously – use the following steps to 

open a Design “Working” DGN File: 
 

 
1. From the desktop, double-click on the GDOT MicroStation V8i SS2 (x86) icon.  

 
 
 
 
 
 

 
2. After the MicroStation Splash Screen appears, the MicroStation Manager dialog  

box will open. (See Figure 1-5).   
    

 
                             Figure 1-5   Starting MicroStation V8i and InRoads V8i 

3. In the MicroStation Manager dialog box, browse to the C:\InRoads Data\PI 
Number\Standards location and highlight the (GDOT 3D Working File.dgn) and 
click the Open button. 
 

4. The MicroStation V8i Select Series 2 interface will then finish opening. Then select 
InRoads InRoads Suite (SELECTseries 2) V8i 08.11.07.566— and the InRoads 
V8i Select Series 2 interface will open. Once InRoads and MicroStation are up and 
running, the desktop should look similar to that of previous screen captures Figure 1-3 
and Figure 1-4.  

Double click on the icon 
labeled 
GDOT MicroStation  
V8i SS2 (x86). 
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1.5 Overview of InRoads Interface 
As mentioned previously - the user will be working in both the InRoads Design Software and 
the MicroStation CADD Software.  The InRoads Software is the database in which the 
Design data is created and processed.    

 
 

Shown below is a diagram which depicts the InRoads Explorer objects and a brief overview of 
the InRoads Explorer Interface: 
 

 
 
 
 
 
 

 
 
 
 
 
 

• Workspace Bar – Contains all of the InRoads Project Data information   
• Menu Bar – Contains the pull-down menus to access InRoads commands  
• Toolbars – Contains default and customized toolbars to access InRoads commands 
• Feedback Pane – Contains details of selected Project Data from the Workspace Bar 
• Scroll Bar – Enables the user to view more of the InRoads Explorer Interface. (The Scroll 

Bar may not be visible if the InRoads Interface is already viewed to extents). 
• Status Bar – Contains InRoads messages and prompts (Please note:  InRoads may direct 

you to locate something graphically in MicroStation -- some of these prompts may display 
in the MicroStation Status Bar instead).  It is very important that the user review both the 
InRoads and the MicroStation Status Bar for prompts and information. 

 
 

Menu Bar Toolbars 

Status Bar Scroll Bar 

Workspace 
Bar 

Feedback 
Pane 
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1.6 InRoads Project Defaults 
The InRoads Project Defaults setting allows you to define the “default folder locations” for 
projects.  A Project Default configuration can then be saved for each project so that multiple 
projects can be accessed.  This configuration allows you to easily navigate between projects. 
Once the Project Folder locations are saved in the Configuration, the projects can then be 
accessed by selecting the appropriate Project Configuration Name.  The Project Defaults also 
contain the location for selecting the standard GDOT InRoads Preference File 
(GDOT_StandardV8i_SS2.xin). 
 
The standard Project Default configuration for Design projects will be PI#_Design. Each 
Design Project Default will consist of this naming structure in order to easily navigate between 
projects. (See Table 1.6)  
 
**Once the Project Default Location is set for a particular project – this will also be the default 
folder location whenever the InRoads commands of FileSave and FileClose are used.   
 

Table 1.6 

Project Defaults Configuration 

Project Default Structure PI Number_Design 
 

Project Default Structure 
(Example) 

1234567_Design 
 

 
 Following are the steps to create a Design Project Default Configuration 
 (Substitute the appropriate PI # as required): 
 

1. Click FileProject Defaults from the InRoads pull-down menu to access the Set 
Project Defaults dialog box. 
 

2. Click New and enter 1234567_Design in the New Configuration dialog box. Then 
click OK. 
 

3. Under the Default Preferences section - Click in the Preferences (*.xin): field and 
then click the Browse button to navigate to the following file:   
C:\InRoads Data\1234567\Standards\GDOT_Standard V8i_SS2.xin file and click 
Open. 
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4. Under the Default Directory Paths Section - Click in the Project Default Directory: 
field and then click the Browse button to navigate to the folder:  
C:\InRoads Data\1234567\. Next - click Open. 
 

5. Under the Default Directory Paths Section – copy and paste the following text into 
each entry field shown below: C:\InRoads Data\1234567\ 
 

• Report Directory: - C:\InRoads Data\1234567\  
• Projects (*.rwk): - C:\InRoads Data\1234567\  
• Surfaces(*.dtm): - C:\InRoads Data\1234567\  
• Geometry Projects: (*.alg): - C:\InRoads Data\1234567\  
• Template Libraries:(*.itl): - C:\InRoads Data\1234567\  
• Roadway Design: (*.ird): - C:\InRoads Data\1234567\  
• Survey Data: (*.fwd): - C:\InRoads Data\1234567\  
• Drainage: (*.sdb): - C:\InRoads Data\1234567\  
• Quantity Manager: (*.mdb): - C:\InRoads Data\1234567\  
• Site Modeler Projects (*.gsf): - C:\InRoads Data\1234567\  

 
6. Under the Default Directory Paths Section - Click in the Style Sheet (*.xsl): field and 

then click the Browse button to navigate to the folder:  
C:\InRoads Data\Style Sheets\GDOT\.  Next - click Open 
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                                          Figure 1-6   Project Defaults 
 

7. The Project Defaults should look similar to the screen capture depicted in Figure 1-6 
(as shown above).  Click Apply and then click Close.  

 
 
 
 
 
 
 
 
 
 
 

Ensure that the 
“Preferred Preference” 
is set to “Design Default”. 
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1.7 Design Default Preferences 
The Design Default Preferences must be loaded in InRoads in order to conform to standards for 
the processing of Design Projects.  This is a very important step to ensure that standards are 
followed for all Design data that will be processed. The Design Default Preference loads the 
Precision Settings, Tolerances, Units and Formats, Default Point and Alignment Numbering 
scheme(s), etc.  Once the Design Default Preference is loaded – the project will retain these 
settings each time the project is accessed.   
 
Following are the steps to set the Design Default Preferences: 
 

1. Click File Project Options from the InRoads pull-down menu to access the Project 
Options dialog box.   
 

2. In the Project Options dialog box - click on the General Tab and the General Tab 
dialog box will appear.   

 

 
 
 
 

3. In the General Tab dialog box, click the command button named Preferences… 
(Located at the bottom of the dialog box) and the Preferences dialog box will open. 

 

                       
 
 
 
 
 
 
 
 
 

4. In the Preferences dialog box – select Design Default.  Then click Load and then 
click Close.  
 

5. The Design Default Preference should now correspond to the screen capture depicted 
in Figure 1-7 (as shown below). 

 

General Tab 
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  Figure 1-7   Design Default Settings 

6. Click Apply and then click Close.  
 
The Design Default Preference is now loaded. This Preference loads the appropriate data for 
ALL of the tabs in the Options dialog box. The individual tabs (Tolerances, Geometry, Units 
and Format, etc.) will automatically be configured for use in Design calculations. The Point and 
Alignment Numbering scheme(s) are also automatically configured for the standard Design 
conventions in the Design Default Preference.  These individual tab options will NOT need to 
change. Once the Design Default Preference is loaded – the project will retain these settings 
each time the project is accessed on this computer. These settings are specific to this computer 
Profile/XIN file. If the Project is accessed on another computer – these settings may need to be 
re-applied in order to load the correct Design Default Preference.    
 
 
 
 
 
 

Ensure that the “Refresh 
Command Settings on 
Preference Change” is 
checked: 
  
                                                  
 
 



Project Initialization Standards    InRoads Design Guidelines SS2 
 

1-20 
 

1.8 InRoads “Locks” 
InRoads contains several “Locks” which are used by many InRoads commands to control 
different aspects of the selection and viewing of data as well as the reporting of data.  There are 
basically two types of “Locks” – On/Off “Locks” and Switch “Locks”. (Switch “Locks” contain 
different modes but one mode is always active and the user can switch between modes). Both 
types of “Locks” can be changed by the user as the situation dictates during the course of the 
database generation.  These locks affect many commands – so it is very important that the user 
understand the use of these locks.  If an InRoads command does not function as expected when 
utilizing the Surface Viewing or Reporting commands -- a “Lock” may have been inadvertently 
turned on/off. 

 
The following section contains a brief overview of some of the InRoads “Locks”.  Only the 
“Locks” pertaining to the Design aspect will be reviewed.  As mentioned previously the 
“Locks” may be changed as situations dictate – but the settings depicted in the following section 
are applicable for most Design Projects.   It is a very important step to ensure that the “Locks” 
are set accordingly. (See Table 1.7)   
 
Following are the steps to access the InRoads “Locks”: 
 
Click ToolsLocks from the InRoads pull-down menu.  Each time a “Lock” is changed – the 
pull-down menu will close and the user must click on ToolsLocks again to access the Locks 
pull-down. 
 
 
 

Table 1.7 
InRoads Locks Settings 

 
Feature Filter Unchecked 
Feature Highlight Unchecked 
Style Unchecked 
Pencil/Pen         Set to Pencil 
Delete Ink    Unchecked 
Locate Set to Features 
Point Snap Checked 
Element Snap         Unchecked 
Station Unchecked 
Report Checked 
Cogo Audit Trail Unchecked 
Toolbar Checked 
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Following is a brief overview of the InRoads “Locks”:  
(See Table 1.8) 
 
 

Table 1.8 
InRoads Locks Overview 

 
Feature Filter   
displays or obscures Surface Features based on a filter (also controls Survey Style Filter) 
 
Feature Highlight 
 highlights the feature in plan view when selected from a list 
 
Style 
 determines if a dialog box is displayed for a surface command or cross sections 
 
Pencil/Pen   
controls the redisplaying of Graphics 
 
Delete Ink  
allows redisplayed graphics to replace graphics in pen mode 
 
Locate    
controls if Locate Buttons snap to Graphics or Features 
 
Point Snap   
 controls the ability to snap to points in a Geometry Project 
 
Element Snap 
controls the ability to snap to elements in a Geometry Project 
 
Station   
controls the Stationing as it pertains to Cross Sections 
 
Report  
controls if Report is displayed or not displayed in a dialog box                          
 
Cogo Audit Trail  
controls the reporting of coordinate geometry results to a text file 
 
Toolbar 
displays or turns off the Locks Toolbar 
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1.9 Application and Variable Manager Add-Ins 
InRoads contains several Application and Variable Manager “Add-Ins” which must be selected 
and added to the InRoads Program in order to access the standard GDOT customized menu 
applications/translators for Design.  Once the Application and Variable Manager Add-Ins are 
selected – the settings are written to registry keys in the user’s profile.  This ensures that each 
time InRoads is accessed in the user profile -- these settings will already be available. These 
add-ins will only need to be added once and will then be accessible in all of the InRoads 
Modules and InRoads Projects.   

 
The “Application and Variable Manager Add-Ins” must be set accordingly in order to access the 
required GDOT Survey/Design commands and translators.    
 

 This section details the following processes: 
  

● Steps to select the Application Add-Ins 
● Steps to select the Variable Manager Add-Ins 

1.9.1 Steps to select the Application Add-Ins:  
 

1. Click ToolsApplication Add-Ins from the InRoads pull-down menu and the 
following dialog box will appear:   
 

              
 

2. Select the following Application Add-Ins by clicking an         by the appropriate Add-
In: 

 
 
 
 
 
 
 
 
 
 
 

3. Click OK to accept the settings and to close out of the dialog box. 
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1.9.2 Steps to select the Variable Manager Add-Ins:  
 

1. Click ToolsVariable Manager from the InRoads pull-down menu and the following 
dialog box will appear:   
 
 

                    
 
 

2. Select the following Variable Manager Add-Ins by clicking an             by the appropriate 
Variable:  

 

                           
 
 

3. Click Apply to accept the settings and then click Close to close out of the dialog box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

   

    2  
Standard Conventions  
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2. Standard Conventions 

This section provides an overview of the GDOT standard Project, File and Geometry Object 
naming conventions utilized for Design.  A Design Feature Styles Table is provided which lists the 
applicable Feature Styles available for use in Design, the GDOT Preference File (.XIN) is 
reviewed and the Standard Preferences are discussed. The Photogrammetry/Survey Feature Code 
Tables are also provided as Reference Information so that the Designer can refer to these Feature 
Codes/Styles when working with Existing Survey/Mapping Data.  
 
This section covers the following topics: 
 
● Standard Project Names and File Names 
● Standard Geometry Object Names and Feature Styles 
● Standard Design Feature Styles 
● Standard File Information 
● Standard Preference File (XIN) and GDOT Preferences 
● GDOT Standard InRoads Photogrammetry Feature Codes 
● GDOT Standard InRoads Field Survey Feature Codes 
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2.1 Project and File Naming Conventions 
As mentioned previously in Section One - in order to ensure Project and File Naming 
consistency and uniformity – standard Project and File Naming conventions have been 
established.  The Designer must follow these naming procedures in order to conform to GDOT 
standards and policies. 
 

 This section details the following Standard Naming Conventions: 
  

● Standard Project Naming Conventions 
● Standard File Naming Conventions 
 

2.1.1 Standard Project Naming Conventions 
The standard File Structure for InRoads is a Project Folder named for the PI Number of the 
project.  The InRoads Design Files will be located directly under this PI Number. This is 
the folder location where the core Design File data is located. When submitting project 
deliverables to Construction (District Earthwork Coordinators) – submit the entire Project 
Folder (Example: the PI Number Folder and the associated files). This will ensure that all 
of the applicable files are submitted to the end-user. (See Table 2.1)  

 
 

Table 2.1 
Standard Project Naming Conventions 

 
InRoads Project Structure C:\InRoads Data\PI Number 

 

InRoads Project Structure 
(Example) 

C:\InRoads Data\1234567 
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2.1.2 Standard File Naming Conventions 
 InRoads contains several different file types but the Design data will usually consist of file 

types pertaining to the .ALG (Geometry File), the .DTM (Digital Terrain Models), the .IRD 
(Roadway Design Files), the .ITL (InRoads Template File) and the associated .DGN 
(MicroStation Design File) deliverables.  Following are the applicable file naming 
conventions (See Table 2.2). 

  
Table 2.2 

Standard File Naming Conventions 
 

 File Type File Name Example Name(s) 

•  3D or 2D “Working”  DGN file 
The 3D or 2D “Working” DGN File is 
used as the standard DGN file for 
producing graphics in InRoads. 

GDOT 3D Working 
File.dgn  or 
GDOT 2D Working 
File.dgn 

GDOT 3D Working File.dgn 
GDOT 2D Working File.dgn 
  

•  ALG - Geometry File 
The Design ALG file contains the 
Existing Survey Geometry Data and the 
Proposed Design Geometry Data. 

PI#_ Design.alg 
 
 

1234567_Design.alg 

•  DTM - Existing DTM  File 
The Existing DTM file contains the 
Original Mapping and/or Field Survey 
DTM data.   

PI#_ Exist.dtm 
 
 

1234567_Exist.dtm 

•  DTM - Proposed DTM File(s) 
The Proposed DTM’(s) naming 
convention is PI#_Corridor Name.dtm. 
There can be several Proposed DTM 
Files including the Mainline and each 
associated Side Road. 

PI#_Corridor 
Name.dtm 

 
 
 

1234567_SR100 SPUR.dtm 
1234567_SR22.dtm 

•  ITL – InRoads Template Library 
File 
A standard GDOT ITL File named 
GDOT_StandardV8i.itl is provided. 
The Designer will copy this file to the 
Project Directory and rename it to 
PI#.itl.  

PI#.itl 
 
  
  

1234567.itl 
 

•  IRD – InRoads Roadway Design File 
The IRD File is named PI#.ird and 
contains the Proposed Corridors and 
the Roadway Design for Cross 
Sections.  

PI#.ird 
 
  
 

1234567.ird 
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2.2    Standard Geometry Object Names and Feature Styles 
The following section details the Standard Design and Survey Geometry Object Naming 
Conventions.  

 
The SDE provides the existing survey data in the Geometry Project (.ALG).   This survey data 
consists of Property data, Existing Right of Way, Alignment data, etc.  Basically it is survey 
which is “Geometry related” and which is used in the creation of the property, alignment and 
COGO database.  This Geometry data will not be represented in the DTM. All other Survey 
Data will be imported into the Surface Project (.DTM) and will be represented as Surface 
Features. (The Designer may review this process by reading the Introduction to InRoads for 
Survey Data Processing Training Guide which depicts the process to filter data to import into 
the Geometry Project (.ALG).  
 
The Designer will store all of the proposed Geometry Data (Cogo Points, Alignment Points, 
Horizontal Alignments and Vertical Alignments) in the Design ALG File.  
 
NOTE: Please note that the term Horizontal Alignments represents not only Centerline 
Alignments but also Right of Way Alignments, Easement Alignments, Edge of Pavement 
Alignments, Ditch Alignments, etc.  
 
NOTE: Please note that Curves are not separate objects in InRoads - but are actually part of 
the Horizontal Alignment. The Curves have no name assigned to them in the Alignment.  
When generating curve tables for plan sheets – the Designer will manually name the Curve 
Table(s) Curve Numbers. This is described in more detail in the Design Training Lab 5.   
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2.2.1 Standard Design and Survey Object Naming Conventions 
 InRoads contains several different object types such as Cogo Points, Alignment Points, 

Horizontal Alignments and Vertical Alignments. Following are the applicable object 
naming conventions (See Tables 2.3 – 2.5). The Designer shall follow the guidelines below 
when storing design geometry objects in InRoads. These guidelines must be followed in 
order to conform to current GDOT standards and policies. Use only one prefix (DE) for 
points in InRoads and begin point numbering at 10000 (i.e. DE10000). This eliminates the 
possibility of duplicate points going back to the Data Collector for staking of survey data. 

 
 

A. Design Object Names and Point/Alignment Ranges: 
The Design Geometry Objects consist of Cogo Points, Alignment Points, 
Horizontal Alignments and Vertical Alignments. The Designer will store Proposed 
Construction Centerlines, Required R/W Alignments, Easement Alignments, Edge 
of Pavement Alignments, etc. The following Naming Conventions will be used. 

 
Table 2.3 

Standard Design Geometry Object Names 
 

Object Type Prefix Starting Number 
*Design Cogo Points  DE 10000 (Max. = 99999) 

*Design Horizontal Alignment Points DE 10000 (Max. = 99999) 

**Design Horizontal Alignments DE 1 

***Design Vertical Alignments DE 1 

 
• * All Design Cogo Points and Design Horizontal Alignment Points must be named with a 

prefix of DE and begin with the number 10000 (e.g., first design point = DE10000). 
 

• **All Design Horizontal Alignments must be named with a prefix of DE and begin with the 
number 1, (e.g., DE1). 

 
• ***It is suggested that the Design Vertical Alignment (which corresponds with the 

Horizontal Alignment) be named the same as the associated Horizontal Alignment. 
 

Table 2.4 
Design Point  & Alignment Ranges to Use 

 

Cogo/Alignment Points Range – 10,000 to 99,999 

Horizontal/Vertical Alignments Range – 1  to no Limitations for Alignments -- but must have 
the DE Prefix 
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B. Survey Object Names and Point/Alignment Ranges: 
The SDE stores any computed and/or existing survey points with No prefixes. Any 
computed Alignments will be stored with an SV prefix to represent a Survey stored 
Alignment. The reason that Survey (field collected and computed points) do not 
contain pre-pended prefixes is to reduce the possibility of duplicate points going 
back to the data collector and to ensure that duplicate points are not submitted to the 
Designer when additional enhancements are added during the life of the project. 
Another reason is to prevent the Designer’s Points and Alignments from being 
overwritten when additional enhancements are added to the Designer’s Geometry 
Project Database. *Please note that it is a requirement for the SDE to pre-pend the 
SV Prefix to all computed Alignments. This includes Parcel Alignments, Existing 
Centerline Alignments, Existing R/W Alignments, etc. 

 
 

Table 2.5 
Standard Survey Geometry Object Names 

 

Object Type Prefix Starting Number 
Survey Cogo Points  Survey (SDE) = No Prefix   1 

Survey Horizontal Alignment Points Survey (SDE) = No Prefix   1 

Survey  Horizontal Alignments SV 1 

 
Point Numbers 1 – 9999 are reserved for survey collecting and survey data 
processing. Point numbering should be done consecutively and if more points are 
required the numbering should continue consecutively as needed. When additional 
survey data is gathered in the field, the point numbers should begin with the lowest 
number that has not already been submitted to design. Designer’s Point numbering 
range begins at 10,000.  Points 10,000 and above are reserved for Design.  If the 
total number of survey points has reached the 9,999 point limit, the Survey Data 
Engineer should contact the Designer and obtain the next starting point number.  

 A gap in point numbering should only exist where the location survey points total 
less than 9,999. All other numbering gaps should be minimized.   

 
Table 2.6 

Survey Point  & Alignment Ranges to Use 
 

Cogo/Alignment Points Range – 1 to 9,999 

Horizontal/Vertical Alignments Range – 1  to no Limitations for Alignments -- but must have 
the SV Prefix 
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2.2.2 Standard Geometry Survey and Design Feature Style Conventions 
 The following Section details the Feature Styles used for Survey and Design Objects. 

When storing Survey and Design Geometry Objects – the applicable Feature Styles must 
be utilized in order to view the correct symbology, cells, etc.  for each of the elements. This 
ensures that the data conforms to the correct Level and Symbology as depicted by the 
Electronic Data Guidelines and for use in Plans Production utilities. 

 
The following existing Property codes/styles (which are composed of data which is used for 
the generation of Property and Alignment information) is processed by the SDE and 
submitted to the Designer in the ALG File.  All Codes which are not listed in the table 
below – will be imported into the Surface Project (.DTM File).  The Survey Control Codes 
are imported into both the .ALG and the .DTM Files. 
 

 
Property and Alignment Codes Survey Style Filter 

PROP_E_RWM Right-of-Way Marker Found TOPO_E_SNGSCM NGS Control Mon. 
PROP_E_RWC Right-of-Way Point Computed TOPO_E_SLCM Loc. Cont. Mon. 
PROP_E_RWU Right-of-Way Utility Company TOPO_E_SLCD Loc. Cont. Delta 
PROP_E_RWE Right-of-Way Prescription Pt TOPO_E_SDCD Dist. Cont. Delta 
PROP_E_POEL Point on Easement Line TOPO_E_SCCHK Cont. Re-shot 
PROP_E_PCF Property Corner Found TOPO_E_SBNCHMK Benchmark 
PROP_E_PPOL Property Point on Line   
PROP_E_PPC Property Point Computed   
PROP_E_APOT Point in Tangent, Existing   
PROP_E_APC Point of Curvature, Existing   
PROP_E_APOC Point on Curve, Existing   
PROP_E_APT Point of Tangency, Existing   
PROP_E_API Point of Intersection   
PROP_E_ACL Alignment Centerline   
PROP_E_BCOL County Line   
PROP_E_BCTL City Limit Line   
PROP_E_BLDL Land District Line   
PROP_E_BLLL Land Lot Line   
PROP_E_BSL State Line   
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A. Survey Feature Styles for Points and Alignments 
The Standard Feature Styles the SDE uses when storing Points and Alignments for the 
Existing Centerline Alignments, Existing R/W, Property, etc. are named according to 
the type of Point or Alignment which is to be stored. The following Table lists the 
applicable Feature Style(s) the SDE (Survey Data Engineer) utilizes when storing the 
Existing Point and Alignment data:  (See Table 2.7) 

 
 

Table 2.7 
Feature Styles For Geometry Survey Points and Alignments 

Existing/Computed Points    

PROP_E_ACL                       
PROP_E_ACL-PC-PT 
PROP_E_APC 
PROP_E_API 
PROP_E_APOC 
PROP_E_APOT 
PROP_E_APT 
PROP_E_PCF 

PROP_E_POEL 
PROP_E_PPC 
PROP_E_PPOL 
PROP_E_RWC 
PROP_E_RWE 
PROP_E_RWM 
PROP_E_RWRR 
PROP_E_RWU 

   Existing Centerline Alignment    PROP_E_ACL 

Existing R/W Alignment PROP_E_RWE 

Existing Property (Parcel) Alignment PROP_E_PAR 
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B. Design Feature Styles for Points and Alignments 
The Standard Feature Styles to use when storing Design Points and Alignments for 
the Proposed Centerline Alignments, Proposed R/W and Easements, etc. will be 
named according to the type of Point or Alignment which is to be stored. The 
following Table lists the applicable Feature Style(s) the Designer utilizes when 
storing Design Points and Alignment data:  (See Table 2.8) 

 
Table 2.8 

Feature Styles For Geometry Design Points and Alignments 

  Feature Style 

DRNG_P_Ditch 
MAIN_P_CONSTCL 
MAIN_P_EOP 
MAIN_P_EPSHLDR 
MAIN_P_SHLDR 
MAIN_P_SIDECL 

REQD_P_DWESMT 
REQD_P_PESMT 
REQD_P_REQD 
REQD_P_RWRM 
REQD_P_TESMT 
STE_P_DETCL 

   Proposed Centerline Alignments  
Feature Style 

Mainline Centerline MAIN_P_CONSTCL        Ex: C/L  HWY 100 

Sideroad Centerline MAIN_P_SIDECL             Ex: C/L PEQUANOC DR. 

Detour Centerline STE_P_DETCL                  Ex: C/L US 78 
Proposed Right of Way  
Feature Style 

R/W Monument REQD_P_RWRM               N/A 

Reqd. R/W REQD_P_REQD                Ex: REQD R/W – PAR 33/SV29 

Perm. Const. Esmt. REQD_P_PESMT              Ex: PESMT – PAR 44/SV67 

Temp. Const. Esmt. REQD_P_TESMT              Ex: TESMT – PAR 23/SV88 

Driveway Esmt. REQD_P_DWESMT**     Ex: DWESMT – PAR 14/SV30 
Miscellaneous  
Feature Style 

Edge of Pavement MAIN_P_EOP                   Ex: EOP – HWY 100 

Edge of Paved Shoulder MAIN_P_EPSHLDR        Ex: EPSHLDR – PEQUANOC DR. 

Edge of Shoulder MAIN_P_SHLDR             Ex: SHLDR – US 78 

Ditch Centerline DRNG_P_Ditch                 Ex: Ditch – HWY 100 

Other (User-Defined)                   User Defined 
 

** The Feature Style of REQD_P_DWESMT will be used for all other types of 
easements (that are not listed above) and be noted as such on plans by the Engineer. 

Proposed Design Points    

 Descriptions    
(C/L Roadway Name) 

Descriptions    
(Feature Style – Parcel #/Parcel Align) 

Descriptions    
(Feature Style – Roadway Name)  
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2.3    Standard Design Feature Styles 
The following section details the Standard Design Feature Styles which are available in the 
GDOT_Standard V8i_SS2.xin file. These Feature Styles conform to the Electronic Data 
Guidelines and represent the InRoads Named Symbology and the associated MicroStation 
ByLevel Symbology. These Feature Styles must be utilized to conform to GDOT Standard 
Conventions and for use in Plans Productions Utilities. If a Feature Style is used which is not 
available in the GDOT XIN File – an InRoads Default Symbology with a color of White will 
appear. It is very important to use the GDOT standard Feature Styles to ensure that the InRoads 
Data is generated correctly for use in InRoads, MicroStation and Plans Production Utilities. 
 
These Feature Styles are used in Geometry Objects, Components, Component Points and 
Proposed DTM’s. The following Table contains the applicable Design Feature Styles to use for 
Design.  
 
NOTE: There are also Feature Styles available for use in Survey and Photogrammetry. Please 
refer to the InRoads Survey Data Processing Guidelines and the Photogrammetry 
Guidelines for Tables listing these Feature Styles.  
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Table 2.9 
Feature Styles -- GDOT Geometry Design Points and Alignments 

 

Feature Style Description         

BRDG_E_Hydraulics Bridge Hydraulics 

DRNG_P_Ditch Ditch-Drainage 

MAIN_P_Barrier-Median-Side Proposed median or side barrier 

MAIN_P_Barrier-Retain-Wall Proposed retaining wall 

MAIN_P_Barrier-Sound-Wall Proposed sound wall 

MAIN_P_CONSTCL Proposed Construction centerline 

MAIN_P_CROWN Crown Point 

MAIN_P_Curb Proposed Curb 

MAIN_P_Driveway Driveway 

MAIN_P_EEOP Exist Pavement Edge 

MAIN_P_EOP Proposed Road Edge of Pavement 

MAIN_P_EPSHLDR Proposed edge of paved shoulder 

MAIN_P_Guardrail Proposed guardrail 

MAIN_P_Misc-Const-Feat Proposed misc. construction feature 

MAIN_P_SHLDR Proposed Shoulder lines 

MAIN_P_SIDECL Proposed Side or Cross road centerline 

MAIN_P_Sidewalk Proposed Sidewalk 

MAIN_P_Slope-break Proposed Slope Break Location 

REQD_P_DWESMT Required Driveway Easement 

REQD_P_PESMT Required Permanent Easement 

REQD_P_REQD Required R/W 

REQD_P_RWRM Required Right of Way Marker 

REQD_P_TESMT Required Temporary Easement 

STE_P_DETCL Proposed Detour centerline 
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Table 2.10 

Feature Styles – GDOT Design Components and Component Points 
 

Feature Style Description 

DRNG_P_Ditch Ditch - Drainage 
DRNG_P_Cross Drain and Culvert Cross Drain and Culvert 
DRNG_P_Storm Drain Pipe Storm Drain Pipe 
LIMT_P_CUT Cut Limits (Assign to End Condition Components) 
LIMT_P_CUT_Const-Limit Cut Limits (Assign to LAST Point in the End Condition) 
LIMT_P_FILL Fill Limits (Assign to End Condition Components) 
LIMT_P_FILL_Const-Limit Fill Limits (Assign to LAST Point in the End Condition) 
MAIN_P_Barrier-Median-Side Proposed median or side barrier 
MAIN_P_Barrier-Retain-Wall Proposed retaining wall 
MAIN_P_Barrier-Sound-Wall Propose sound wall 
MAIN_P_Barrier_PAY_4940_TP20 4940 TP20 CONCRETE BARRIER 
MAIN_P_Barrier_PAY_4940_TP21 4940TP21 CONCRETE BARRIER 
MAIN_P_Barrier_PAY_4940_TP22 4940 TP22 CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S1 TP S1 SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S2 TP S2 SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S3 TP S3 SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S3A TP S3A SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S3B TP S3B SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-S TP 2-S SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-SA TP 2-SA SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-SB TP 2-SB SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-SC TP 2-SC SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-S TP 6-S SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-SA TP 6-SA SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-SB TP 6-SB SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-SC TP 6-SC SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_7-CS TP 7-CS or 7-RS SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_7-WS TP 7-WS SIDE CONCRETE BARRIER 
MAIN_P_CONSTCL Proposed Construction centerline 
MAIN_P_CROWN Crown Point 
MAIN_P_Curb Proposed Curb 
MAIN_P_Curb_PAY_9032B Dowel TP2 9032B TP2 CONC DOWELED INTEGRAL CURBS 6" THK 
MAIN_P_Curb_PAY_9032B Dowel TP3 9032B TP3 CONC DOWELED INTEGRAL CURBS 8" THK 
MAIN_P_Curb_PAY_9032B Dowel TP7 9032B TP7 CONC DOWELED INTEGRAL CURBS 6" THK 
MAIN_P_Curb_PAY_9032B HeaderTP1 9032B TP1 4"HEADER CURB 
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Feature Style Description 

MAIN_P_Curb_PAY_9032B HeaderTP2 9032B TP2 6"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP3 9032B TP3 8"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP4 9032B TP4 10"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP6 9032B TP6 6"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP7 9032B TP6 7"HEADER CURB 
MAIN_P_Curb_PAY_9032B REdge 6" 9032B 6" RAISED EDGE WITH CONCRETE GUTTER 
MAIN_P_Curb_PAY_9032B REdge 8" 9032B 8" RAISED EDGE WITH CONCRETE GUTTER 
MAIN_P_Curb_PAY_9032B TP1 6" 9032B TP1 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP1 8" 9032B TP1 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP2 6" 9032B TP2 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP2 8" 9032B TP2 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP3 6" 9032B TP3 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP3 8" 9032B TP3 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP4 6" 9032B TP4 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP4 8" 9032B TP4 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP7 6" 9032B TP7 CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP7 8" 9032B TP7 CURB & GUTTER 8"THK 
MAIN_P_Driveway Driveway 
MAIN_P_EEOP Exist Pavement Edge 
MAIN_P_EOP Proposed Road Edge of Pavement 
MAIN_P_EPSHLDR Proposed edge of paved shoulder 
MAIN_P_Exterior Boundary Exterior Boundary 
MAIN_P_GoreMainIdeal Vertical Gore Design Tool - GoreMainIdeal 
MAIN_P_GoreMax Vertical Gore Design Tool - GoreMax 
MAIN_P_GoreMin Vertical Gore Design Tool - GoreMin 
MAIN_P_GoreRampIdeal Vertical Gore Design Tool - GoreRampIdeal 
MAIN_P_Guardrail Proposed guardrail 
MAIN_P_Median_PAY_9032B_4"THK 9032B CONCRETE MEDIAN 4"THK PAY ITEM 
MAIN_P_Misc-Const-Feat Proposed misc. construction feature 
MAIN_P_SHLDR Proposed Shoulder lines 
MAIN_P_SIDECL Proposed Side or Cross road centerline 
MAIN_P_Sidewalk Proposed Sidewalk 
MAIN_P_Slope-break Slope break point 
REQD_P_DWESMT Required Driveway Easement 
REQD_P_PESMT Required Permanent Easement 
REQD_P_REQD Required R/W   
REQD_P_RWRM Required Right of Way Marker 
REQD_P_TESMT Required Temporary Easement 
STE_P_DETCL Proposed Detour centerline 
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2.4 Standard File Information 
Following is a brief overview of the most common InRoads file types the Designer will utilize: 
(See Table 2.11)   
 

Table 2.11 
Standard File Information Overview 

 
GDOT 3D Working File.dgn  
This DGN file is created from the GDOT 3D “seed” file (GDOT_V8_3D.dgn) and is used to display the 
temporary and or/permanent graphics in InRoads. 
 
.FWD  
(SDE File Only!  This File is not provided to Design.) 
The .FWD file contains the imported Field Survey Data (.CSV File Data). Basically this file is an Electronic 
Field Book in which the .CSV File data is imported so that the survey data can be exported to the .DTM 
(Surface) and .ALG (Geometry) files. 
 
.DTM 
The .DTM file contains all of the Surface Features imported from the 3D Photogrammetric DGN File and/or 
CSV File(s).  The appropriate Surface Features are triangulated in order to form an Existing Ground Surface 
(TIN Model) for use in Survey and Design. The Designer will create a Proposed DTM File(s) which will contain 
the Proposed Ground Surface data. 
 
.ALG 
The .ALG (Geometry File) contains all of the “Geometry” related data such as Property, Existing R/W, Existing 
Centerline Alignments, Proposed Horizontal/Vertical Alignments and R/W and Easement Alignments for use in 
Design. 
 
.ITL 
The .ITL is the InRoads Template File which contains all of the Templates and Components for cross sections. 
This file is specific to each individual InRoads Project and should be submitted as a deliverable during project 
submission to the Earthwork Coordinator during Construction. 
 
.IRD 
The .IRD is the InRoads Roadway Design File which contains the Design Surface Data (the corridors and the 
associated cross sections which are generated to a Design Surface).    
 
.RWK 
The .RWK (InRoads Project File) contains project data for InRoads files in ASCII format. The .RWK file is a 
text file which can be edited to reflect the path of the Project Files so that all of the Files will be opened when the 
InRoads Project File (.RWK) is opened. 
 
.SDB 
The .SDB (InRoads Drainage File) contains the InRoads Storm and Sanitary data. 
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2.5 Standard Preference File (XIN) and GDOT Preferences 
The following section details the GDOT Standard Preference File GDOT_Standard 
V8i_SS2.xin and the various InRoads Preferences that have been established for use in the 
Design Process.    
 

2.5.1 Standard Preference File (XIN) Configuration 
InRoads Standards for Design have been set up in a “Preference” file (also known as an 
XIN file). This preference file contains the Georgia Department of Transportation’s 
standards for Feature Codes, Feature Styles, Feature Filters, Dialog Box Settings, 
Linestyles, Lineweights, colors, and numerous other settings. The XIN file is basically a 
compilation of INI Files (Initialization files) which controls the standardization of the 
InRoads settings and display options. This preference file is critical for use in the InRoads 
Design Process and for accurate Digital Terrain Model/ Geometry Objects creation. The 
XIN file is used in conjunction with MicroStation V8i’s ByLevel settings and configuration 
files to assist in the viewing of project data and in the generation of plan file deliverables.  

The standard GDOT XIN file is named GDOT_Standard V8i_SS2.xin and is included in 
the InRoadsALL.exe download.    

After downloading and executing the InRoadsALLexe – a Standards folder is created 
directly under the C:\InRoads Data folder. The Designer will copy this Standards folder to 
the Project Folder: (See Example in Table 2.12) 

 

Table 2.12 
Name and Location of the GDOT Standard XIN File 

 
GDOT Standard XIN File C:\InRoadsData\1234567\Standards\GDOT_Standard V8i_SS2.xin  

 

NOTE: The XIN file contains Named Symbology and Feature Styles which correspond 
with the ByLevel Settings in MicroStation. Please note that if any modifications or 
additional Feature Styles/Named Symbology are added by the user to the XIN – the 
MicroStation Levels may not view with the correct Symbology for those modified Feature 
Styles. It is advisable to NOT add additional Named Symbology or Styles in order for the 
XIN file to be consistent with the current MicroStation ByLevel settings so that utilities for 
Plans Productions will function correctly. 
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2.5.2 Standard Preference File (XIN) Details 
The XIN File contains the GDOT configuration settings for use in Design/Survey. These 
settings contain the current GDOT standards for plan development and processing of 
Design/Survey Data. Following are some of the Configuration Settings contained in the 
XIN: 
 

• Named Symbology – This controls how elements such as points, lines, text, etc. 
appear in plan, cross section and profile views in MicroStation. The GDOT named 
symbology is also set to ByLevel which references the Level Settings for 
Symbology in the MicroStation DGNLIB. ByLevel controls the Symbology 
(weight, color, linestyle) and the Named Level on which the elements are located. 
The Named Symbology can also be set in the InRoads Named Symbology Manager 
by selecting each symbology (color, weight, linestyle, etc.) separately but GDOT 
uses the ByLevel Symbology to correspond with the DGNLIB Levels.  (The 
Named Symbology determines “How” an element is viewed”).  

 
• Feature Styles – InRoads contains Features which represent elements such as 

points, lines, arcs, spirals, etc. The Feature Style for each Geometry, Survey, DTM 
and Component element is used to determine how the elements view. The elements 
can be set to view in plan view, profile, cross section, DTM, etc. The Feature Style 
references the associated Named Symbology to view the element with the 
appropriate corresponding Symbology.  The Feature Style determines “Where” the 
element is viewed. 

  
•  Preferences – When using commands in the InRoads dialog boxes – it is useful to 

set Preferences which can be loaded later without having to re-enter information 
into the dialog boxes. Preferences are basically entries in dialog boxes which can be 
saved and then selected to automatically configure the settings of a dialog box 
without manual re-entry. 

 
• Filters – Filters are commands in dialog boxes which can be used to “filter” 

selections of data based on set criteria. This can include selection of Points, 
Alignments, Features or other entities by using a filter based on the entities’ Style, 
Name, etc.   
 

These are some of the GDOT standards that have been configured for use in the XIN file. 
These settings are used to assist in the Design process to ensure that standards are 
consistent for development of GDOT project plans. 
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2.5.3 GDOT Preferences 
As mentioned previously - Preferences are entries in dialog boxes which can be saved and then selected later to automatically 
configure the settings of a dialog box without manual re-entry.  The following Table lists the GDOT Preferences available in the 
GDOT XIN file. These Preferences will be discussed in more detail in each of the applicable Sections of the Survey and Design 
Guidelines.  
 

Preference Name Dialog 
Name Dialog Location Description 

10 Scale Work Sec 1x Vert  Exg 
(Ensure the “Create Cross Section 
Folder”  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

X-Section Grid (10 Scale) for Earthwork and End-Area reports.  For 
use on projects with small footprints.  Most situations will require 
using the ‘50 Scale Work Sec 2x Vert Exg’ Preference. 

100h_10v Profile 
 

Annotate 
Profile 

Evaluation  Profile 
 Annotate Profile  
Preferences 

Sets settings for 100’ Scale Horizontal and 10’ Scale Vertical viewing 
of existing and proposed Profile elevations on the Profile plan 
sheets. Use when annotating Profiles for Profile sheets using the ‘50 
Scale Single Profile’ Preference in the Plan and Profile Generator. 

100h_10v_SHEETS Create 
Profile 
 
 
 
Annotate 
Profile 
 
 

Evaluation  Profile 
 Create Profile  
Preferences 
 
 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 100’ Horizontal Scale and 10’ Vertical Scale.  This 
Preference is also referenced in the Plan & Profile Generator when 
generating 50 Scale Single Profile Sheets. 
 
This same preference name is now also used in the Annotate Profile 
dialog box.  It was copied from and is identical to the 100h_10v 
Profile preference.  This is so the ‘Profile Preference’ under the 
‘Profile Controls’ tab of the ‘Plan and Profile Generate’ dialog will 
not display Superelevation diagrams on the profile sheets. 

100h_10v_WORKING Create 
Profile 

Evaluation  Profile 
 Create Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 100’ Horizontal Scale and 10’ Vertical Scale.  
Same as 100h_10v_SHEETS except grid is not drawn.  For use during 
temporary viewing of Profile during vertical alignment design. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
20 Scale Survey 

Options 
Survey ► Fieldbook 
Data ► Survey 
Options  
Preferences 

Sets Cell Scale, Text Scale, and Line Scale for viewing survey 
planimetrics for 20 Scale projects. 

20 Scale Double Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 20 Scale Double Profile Sheets. 
 
 
 

20 Scale Plan  Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

To be developed. 

20 Scale Plan & Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 20 Scale Plan & Profile Sheets. 

20 Scale Single Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 20 Scale Single Profile Sheets.  
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
20h_5v Profile   Annotate 

Profile 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Sets settings for 20’ Scale Horizontal and 5’ Scale Vertical viewing of 
existing and proposed Profile elevations on the Profile plan sheets.  
Use when annotating Profile for Profile sheets using the ‘20 Scale 
Single Profile’, ’20 Scale Double Profile, and ’20 Scale Plan & Profile’ 
Preferences in the Plan and Profile Generator. 

20h_5v_SHEETS Create 
Profile 
 
 
 
 
Annotate 
Profile 
 
 

Evaluation  Profile 
 Create Profile  
Preferences 
 
 
 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 20’ Horizontal Scale and 5’ Vertical Scale.  This 
Preference is also referenced in the Plan & Profile Generator when 
generating 20 Scale Single Profile Sheets, 20 Scale Double Profile 
Sheets and 20 Scale Plan and Profile Sheets. 
 
This same preference name is now also used in the Annotate Profile 
dialog box.  It was copied from and is identical to the 20h_5v Profile 
preference.  This is so the ‘Profile Preference’ under the ‘Profile 
Controls’ tab of the ‘Plan and Profile Generate’ dialog will not display 
Superelevation diagrams on the profile sheets. 

20h_5v_WORKING Create 
Profile 

Evaluation  Profile 
 Create Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 20’ Horizontal Scale and 5’ Vertical Scale.  Same 
as the 20h_5v_SHEETS Preference except the grid is not drawn.  For 
use during temporary viewing of Profile during vertical alignment 
design. 

50 Scale Survey 
Options 

Survey ► Fieldbook 
Data ►Survey 
Options 
►Preferences 

Sets Cell Scale, Text Scale, and Line Scale for viewing survey 
planimetrics for 50 Scale projects. 
 
 

50 Scale Double Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 
 

Used for generating 50 Scale Double Profile Sheets. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
50 Scale Plan  Plan and 

Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

To be developed. 

50 Scale Plan & Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 50 Scale Plan & Profile Sheets. 

50 Scale Single Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 50 Scale Single Profile Sheets.   

50 Scale Work Sec 2x Vert Exg Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

X-Section Grid (50 Scale) for Earthwork and End-Area reports.  Most 
situations will require using this Preference. 

50h_10v Profile Annotate 
Profile 

Evaluation  Profile 
 Annotate Profile  
Preferences 

Sets settings for 50’ Scale Horizontal and 10’ Scale Vertical viewing of 
existing and proposed Profile elevations on the Profile plan sheets.  
Use when annotating Profile for Profile sheets using the ’50 Scale 
Double Profile’, and ’50 Scale Plan & Profile’ Preferences in the Plan 
and Profile Generator. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
50h_10v_SHEETS Create 

Profile 
 
 
 
 
Annotate 
Profile 
 

Evaluation  Profile 
 Create Profile  
Preferences 
 
 
 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 50’ Horizontal Scale and 10’ Vertical Scale.  This 
Preference is also referenced in the Plan & Profile Generator when 
generating 50 Scale Double Profile Sheets and 50 Scale Plan and 
Profile Sheets. 
 
This same preference name is now also used in the Annotate Profile 
dialog box.  It was copied from and is identical to the 20h_5v Profile 
preference.  This is so the ‘Profile Preference’ under the ‘Profile 
Controls’ tab of the ‘Plan and Profile Generate’ dialog will not display 
Superelevation diagrams on the profile sheets. 

50h_10v_WORKING Create 
Profile 

Evaluation  Profile 
 Create Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 50’ Horizontal Scale and 10’ Vertical Scale.  Same 
as the 50h_10v_SHEETS Preference except the grid is not drawn.  For 
use during temporary viewing of Profile during vertical alignment 
design. 
 

ACL View 
Stationing  
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing  
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation  
Preferences 

Loads settings for viewing Horizontal Alignment Stationing and Curve 
Data. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
ACL Cogo Point Feature Styles Geometry 

Selection 
Filter 

Geometry  View 
Geometry  
Horizontal Annotation 
► Filter ► 
Preferences 

For use by the Survey Data Engineer (SDE) when creating the ACL 
centerline alignment.  The Preference is used in the Geometry 
Selection Filter when only points with the following Feature Styles 
are desired to be viewed.   
 
PROP_E_API,PROP_E_APT,PROP_E_APC,PROP_E_APOT,PROP
_E_APOC 
 

BEARING & DISTANCE View 
Horizontal 
Annotation 

Geometry  View 
Geometry  
Horizontal Annotation 
 Preferences 

Loads settings into the View Horizontal Annotation dialog to label 
the bearing when viewing Roadway alignments with the feature 
styles MAIN_P_CONSTCL, MAIN_P_SIDECL, and PROP_E_ACL.  
Although DISTANCE is part of the Preference name the distance is no 
longer set up to be labeled.  
 
 

BOGUS SURFACE View 
Triangles /  
 
 
Surface 
Properties 

Surface  View 
Surface  Triangles  
Preferences. 
 
Surface ► Surface 
Properties ►  
Advanced 

Used for viewing surface triangles of ‘Bogus’ Surfaces (surfaces 
created by the designer for the temporary filling of obscured areas).  
The Bogus Surface Preference loads settings to view the surface as 
pink, easily distinguishing it as a Bogus Surface.  The Bogus Surface 
Preference is used in both the View Triangles dialog and the Surface 
Properties dialog.  The Surface Properties dialog ensures the pink 
surface is displayed when viewing existing ground Profiles and Cross 
Sections. 
 

Bridge Hydraulics Annotate 
Feature 

Surface  View 
Surface   Annotate 
Feature Preferences 

Loads settings into the Annotate Feature dialog to annotate selected 
Bridge Features in the Surface for use in Bridge Hydraulics. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
CONSTCL View 

Stationing/ 
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing ► 
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation► 
Preferences 

50 Scale settings for viewing Stationing and Curve Set Annotation for 
Mainline Construction Centerline Alignments. 

CONSTCL 20 SCALE View 
Stationing 
 
 

Geometry  View 
Geometry  
Stationing ► 
Preferences 

20 Scale settings for viewing Stationing of Mainline Construction 
Centerline Alignments. 

Default  Default Preference Original Equipment Manufacturers default settings. 
 
 

Design Default Project 
Options 

File ► Project Options 
► Preferences 

For use by Design.  Loads proper point numbering and prefixes, 
precision, abbreviations, sight distance settings, factors, tolerances 
Units and formats for GDOT projects. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
DETCL View 

Stationing/ 
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing ► 
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation ► 
Preferences 

50 Scale settings for viewing Stationing and Curve Set Annotation for 
Detour Centerline Alignments. 

DETCL 20 Scale View 
Stationing 
 
 

Geometry  View 
Geometry  
Stationing ► 
Preferences 

20 Scale settings for viewing Stationing for Detour Centerline 
Alignments. 
 
 
 

Ditch Flow Arrows Annotate 
Feature 

Surface  View 
Surface   Annotate 
Feature Preferences 

Loads settings into the Annotate Feature dialog to place the ‘Ditch 
Flow Arrow’ cell on user selected features.  The settings ensure the 
‘Ditch Flow Arrow’ cell point in the direction of flow. 

ENHANCEMENTS View 
Triangles 

Surface  View 
Surface  Triangles  
Preferences 

For use by the SDE when viewing enhancements to obscured areas 
for inclusion into the Existing DTM. 

EXISTING View 
Triangles/ 
 
 
View 
Contours 

Surface  View 
Surface  Triangles  
Preferences 
 
Surface  View 
Surface  Contours  
Preferences 

For use when viewing the Existing DTM. 

Existing Majors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 
Preferences  

For use in labeling individual Major Contour Elevations of Existing 
ground surfaces. 



 Standard Conventions    InRoads Design Guidelines SS2 

2-26 
 

Preference Name Dialog 
Name Dialog Location 

 
Description 

 
Existing Minors Label 

Contours 
Surface ► View 
Surface ► Label 
Contours ► 
Preferences 

For use in labeling individual Minor Contour elevations of Existing 
ground surfaces. 

FINISH View 
Triangles/ 
 
 
View 
Contours 

Surface  View 
Surface  Triangles  
Preferences 
 
Surface  View 
Surface  Contours  
Preferences 

For use when viewing Final DTM Surfaces. 

Finished Majors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 
Preferences 

For use in labeling individual Major Contour Elevations of Finished 
Design Surfaces. 

Finished Minors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 
Preferences 

For use in labeling individual Minor Contour Elevations of Finished 
Design Surfaces. 

GDOT Display 
Template 

Modeler ► Create 
Template ►Right 
mouse click over the 
Template to Display 
and select Display ► 
Preferences 

Loads settings for viewing a component or template in MicroStation. 

GDOT Earthwork Volumes 
(Ensure the “End-Area Volumes” 
folder  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Loads settings for generating the GDOT Earthwork Volumes Report. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
GDOT Profiles   View 

Vertical 
Annotation 

Geometry ► View 
Geometry ► Vertical 
Annotation 

Settings for proper viewing of vertical curve data on the Profile Plan 
Sheets.  

Narrow 10h 10v 
(Ensure the “Create Cross Section” 
folder  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Loads settings for creating Narrow Cross Section Sheets at a 10 
Horizontal to 10 Vertical Scale.  The Global Scale Factor must be set 
separately to 10.0000 for proper viewing. 

NO BEARING & DISTANCE View 
Horizontal 
Annotation 

Geometry  View 
Geometry  
Horizontal Annotation 
 Preferences 

Loads settings into the View Horizontal Annotation dialog to turn off 
labeling the bearing and distance when viewing alignments. 

OEM_Default  Surface  View 
Surface  Triangles  
Preferences 

Original Equipment Manufacturers default settings. 
 
 
 
 

PAR NAMES View 
Closed 
Areas 

GeometryView 
GeometryClosed 
Areas Preferences 

Loads settings for viewing the Alignment Names of closed Alignments 
in the MicroStation DGN. 

Prop.dgn Alignments Geometry 
Selection 
Filter 

Geometry  View 
Geometry  
Horizontal Annotation 
 Filter ►Preferences 

For use by the SDE when creating the PI#_PROP.dgn file for delivery 
to the Design Office.  The Preference filters the Feature Styles to the 
13 Features Styles listed here:   
 
PROP_E_ACL,PROP_E_BCOL,PROP_E_BCTL,PROP_E_BGMD, 
PROP_E_BLDL,PROP_E_BLLL,PROP_E_BMISC,PROP_E_BSL, 
PROP_E_PAR,PROP_E_POEL,PROP_E_RWE,PROP_E_RWRR, 
PROP_E_RWU 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
Prop.dgn Points Geometry 

Selection 
Filter 

Geometry  View 
Geometry   
Horizontal Annotation 
 Filter ►Preferences 

For use by the SDE when creating the PI#_PROP.dgn file for delivery 
to the Design Office.  The Preference filters the Feature Styles to the 
22 Features Styles listed here:   
 
PROP_E_APC,PROP_E_API,PROP_E_APOC,PROP_E_APOT, 
PROP_E_APT,PROP_E_BCOL,PROP_E_BCTL,PROP_E_BGMD,
PROP_E_BLDL,PROP_E_BLLL,PROP_E_BMISC,PROP_E_BSL, 
PROP_E_PAR,PROP_E_PCF,PROP_E_POEL,PROP_E_PPC, 
PROP_E_PPOL,PROP_E_RWC,PROP_E_RWE,PROP_E_RWM, 
PROP_E_RWRR,PROP_E_RWU 
 

REQD.dgn Alignments Geometry 
Selection 
Filter 

Geometry  View 
Geometry   
Horizontal Annotation 
 Filter ►Preferences 

For use in creating the PI#REQD.dgn file.  The Preference filters the 
Feature Styles to the 4 Features Styles listed here:   
 
REQD_P_DWESMT,REQD_P_PESMT,REQD_P_REQD,REQD_P_
TESMT 
 

REQD.dgn Points Geometry 
Selection 
Filter 

Geometry  View 
Geometry   
Horizontal Annotation 
 Filter ►Preferences 

For use in creating the PI#REQD.dgn file.  The Preference filters the 
Feature Styles to the 5 Features Styles listed here:   
 
REQD_P_DWESMT,REQD_P_PESMT,REQD_P_REQD,REQD_P_
TESMT,REQD_P_RWRM 
 

SE LEFT Display 
Super-
elevation 
in Plan 

Drafting► Display 
Superelevation in 
Plan►Preferences 

For use in displaying the Transition Stations and Superelevation Rate 
for a developed Corridor and Superelevation Control Line. SE Left 
displays information to the left of the Pivot Line defined in the 
command. 

SE RIGHT Display 
Super-
elevation 
in Plan 

Drafting► Display 
Superelevation in 
Plan►Preferences 

For use in displaying the Transition Stations and Superelevation Rate 
for a developed Corridor and Superelevation Control Line. SE Right 
displays information to the right of the Pivot Line defined in the 
command. 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
SIDECL View 

Stationing/ 
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing ► 
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation ► 
Preferences 

50 Scale settings for viewing Stationing and Curve Set Annotation for 
Side Road Construction Centerline Alignments. 

SIDECL 20 SCALE View 
Stationing 

Geometry  View 
Geometry  
Stationing ► 
Preferences 

20 Scale settings for viewing Stationing for Side Road Construction 
Centerline Alignments. 

Stakeout Survey Data Geometry 
Selection 
Filter 

Tools ► XML Reports 
► Point Validation ► 
Filter ► Preferences 

Used to create the Stakeout Report.  The Preference filters the 
Feature Styles to the following 20 Feature Styles. 
 
PROP_E_PAR,PROP_E_RWE,PROP_E_RWM,PROP_E_RWC, 
PROP_E_RWU,PROP_E_POEL,PROP_E_PPC,PROP_E_PCF, 
TOPO_E_SNGSCM,TOPO_E_SLCM,TOPO_E_SLCD, 
TOPO_E_SDCD,TOPO_E_SBNCHMK,REQD_P_*, 
MAIN_P_CONSTCL,MAIN_P_SIDECL 
 

Surface Check MPCKGRD Geometry 
Selection 
Filter 

Tools ► XML Reports 
► Surface Check ► 
Filter ► Preferences 

Used by the District Survey Party Chiefs and the Consultant 
Compliance Supervisor in the Office of Design Policy and 
Support/Location Bureau to generate a GDOT Surface Check Report.   
The Surface Check MPCKGRD Preference is used to filter the Feature 
Styles for the First Check Points - Include: field to include only the 
Feature Style: 
 
TOPO_E_MPCKGRD 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
Surface Check MPCKPAV Geometry 

Selection 
Filter 

Tools ► XML Reports 
► Surface Check ► 
Filter ► Preferences 

Used by the District Survey Party Chiefs and the Consultant 
Compliance Supervisor in the Office of Design Policy and 
Support/Location Bureau and Support to generate a GDOT Surface 
Check Report.   The Surface Check MPCKPAV Preference is used to 
filter Feature Styles for the Second Check Points - Include: field to 
include only the Feature Style: 
 
TOPO_E_MPCKPAV 

Survey Default Project 
Options 

File ► Project Options 
► Preferences 

For use by Photogrammetry and Survey.  Loads proper point 
numbering and prefixes, precision, abbreviations, sight distance 
settings, factors, tolerances Units and formats for GDOT projects. 

SUE Annotate 
Feature in 
Profile 

Evaluation ► Profile 
► Annotate Feature 
In Profile ► 
Preferences 

Used for the profile annotation of SUE QL-A Test Hole data. 

Vertical Gore Design Tool Vertical 
Gore Tool 

Modeler► Roadway 
Designer ► Tools ► 
Vertical Gore Tool► 
Preferences 

Loads the ‘Gore’ Feature Styles into the proper fields for use in the 
Roadway Designer Vertical Gore Design Tool. 

Wide 10h 10v 
(Ensure the “Create Cross Section” 
folder  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Loads settings for creating Wide Cross Section sheets at a 10 
Horizontal to 10 Vertical Scale.  The Global Scale Factor must be set 
separately to 10.0000 for proper viewing. 

XSEC TEXT – CL. EL. GROUND 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for annotating the existing ground elevation on the Cross 
Sections at the centerline alignment. 

XSEC TEXT – EL.  DIAGONAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of proposed elevations in which the text must 
be viewed diagonally. (i.e. Roadway Profile.) 
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Preference Name Dialog 
Name Dialog Location 

 
Description 

 
XSEC TEXT – EL. HORIZONTAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of proposed elevations in which the text must 
be viewed horizontally.  (i.e. Roadway Ditches.) 
 
 

XSEC TEXT – EL. VERTICAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences  
 

Used for the annotation of proposed elevations in which the text must 
be viewed vertically. 
 

XSEC TEXT – OFFSET 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

User for the annotation of offset distances as measured from the 
centerline.  (i.e. Slopestakes/Construction Limits.) 
 
 
 

XSEC TEXT – OFFSET/EL. VERTICAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of offset distances as measured from the 
centerline.  The elevation at the offset is also placed.  This form of 
annotation is not required on the final Cross Section plans.  It is 
provided to be used ‘as desired’ during the design process. 

XSEC TEXT – SLOPES % 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of slopes that require a percentage be used 
rather than a ratio (i.e. Pavement Cross Slopes). 
 

XSEC TEXT – SLOPES x:y 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of slopes that require a ratio be used rather 
than a percentage (i.e. Ditch Slopes, Front Slopes, Back Slopes, etc.). 
 

XSEC TEXT – SUE 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the cross section annotation of SUE QL-A Test Hole data. 
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2.6 GDOT Standard InRoads Photogrammetric Feature Codes 
The following table contains the standard Photogrammetry Codes and the associated 
InRoads Alpha Codes for use in Photogrammetry.  

 
GDOT STANDARD PHOTOGRAMMETRY CODES 

K 
 Code Description          InRoads 

Alpha Code            
Triangulate 

(Yes/No)             

K5 EDGE OF ASPHALT PAVEMENT TEAP Y 
K5 EDGE OF ASPHALT DRIVE TEAD Y 
K6 EDGE OF ASPHALT SHOULDER TEAS Y 
K7 EDGE OF TRAVEL LANE TETL  Y 
K8 WHITE LINE STRIPING TSTP Y 
K9 EDGE OF DIRT ROAD TEDR Y 
K9A EDGE OF DIRT DRIVE TEDD Y 
K17 SIDEWALK, CENTER TSW  N 
K19A FOUNDATION FNDN N 
K19B RUINS RUIN  Y    
K28 DAM, TOP DDT Y   
K36 EDGE OF CONCRETE DRIVE TECD  Y 
K41 SWIMMING POOL POOL  Y   
K43 DITCH FLOW LINE MDITCHFL Y 
K44 EDGE OF RIVER TRIVER  Y 
K45 EDGE OF LAKE TLAKE Y 
K63 PAVE DITCH DPD  Y 
K150 JOB LIMIT LINE MJLL  N               
K152 EMERGENCY LANE TEL  Y                
K154 CURB & GUTTER, TOP TCGT  Y                
K155 CURB & GUTTER, F/L TCGF Y                
K156 CROWN OF ROAD TCOR Y                
K157 MAP SEW LINE MSEWLINE N                
K158 RANDOM TERRAIN POINT TRP Y                
K159 MAP OBSCURE AREA MOBSC Y                
K161 RAILROAD, TOP OF RAIL TRCRE Y                
K163 WALL FACE, TOP TWFT Y                
K164 WALL FACE, BOTTOM TWFB Y                
K165 TERRAIN POINT ON BREAK LINE TPBL Y                
K166 CONSTRUCTION BOUNDARY, ACTV TCBA Y                
K167 DAM, TOE DADB Y                
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2.7 GDOT Standard InRoads Field Survey Feature Codes 
The following spreadsheet is for informational use only so that the Designer will have a reference for the Field Survey Feature Codes 
if needed. The spreadsheet contains the standard Numeric SMI Codes and the associated InRoads Alpha Codes for use in Field 
Survey. The InRoads Feature Style is depicted for use by Survey Data Engineers and Designers. The Point Type and Chain Type 
Triangulate (Yes/No) column(s) are for informational use only. This column denotes the status of the Alpha Code and lists whether 
it is triangulated or not triangulated in the DTM Surface and whether it is a Point Type or a Chain Type.    

 

 
 

 
SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

 
Ground Elevations          

1 TERRAIN POINT ON BREAK LINE TPBL TOPO_E_TPBL 
 

Y 4 
2 RANDOM TERRAIN POINT TRP TOPO_E_TRP Y 

 
2 

  Property and Right-of-Way    
   3 RIGHT-OF-WAY MARKER FOUND RWM PROP_E_RWM N 

 
1 

4 RIGHT-OF-WAY POINT COMPUTED RWC PROP_E_RWC N 
 

1 
5 RIGHT-OF-WAY UTILITY COMPANY RWU PROP_E_RWU N 

 
1 

6 RIGHT-OF-WAY PRESCRIPTION PT RWE PROP_E_RWE 
 

N 3 
7 POINT ON EASEMENT LINE POEL PROP_E_POEL N 

 
1 

8 PROPERTY CORNER FOUND PCF PROP_E_PCF N 
 

1 
9 PROPERTY POINT ON LINE PPOL PROP_E_PPOL N 

 
1 

10 PROPERTY POINT COMPUTED PPC PROP_E_PPC N 
 

1 
  Alignment    

   15 POINT ON TANGENT, EXISTING APOT PROP_E_APOT N 
 

1 
16 POINT OF CURVATURE, EXISTING APC PROP_E_APC N 

 
1 

17 POINT ON CURVE, EXISTING APOC PROP_E_APOC N 
 

1 
18 POINT OF TANGENCY, EXISTING APT PROP_E_APT N 

 
1 

19 POINT OF INTERSECTION API PROP_E_API N 
 

1 
20 ALIGNMENT CENTERLINE ACL  PROP_E_ACL 

 
N 3 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  Roadways          
24 EDGE OF DIRT ROAD TEDR TOPO_E_TEDR 

 
Y 4 

25 EDGE OF ASPHALT DRIVE TEAD TOPO_E_TEAD 
 

Y 4 
26 EDGE OF CONCRETE DRIVE TECD TOPO_E_TECD 

 
Y 4 

27 EDGE OF ASPHALT PAVEMENT TEAP TOPO_E_TEAP 
 

Y 4 
28 EDGE OF ASPHALT SHOULDER TEAS TOPO_E_TEAS 

 
Y 4 

29 EDGE OF CONCRETE PAVEMENT TECP TOPO_E_TECP 
 

Y 4 
30 EDGE SURFACE TREATMENT ROAD TEST TOPO_E_TEST 

 
Y 4 

31 CURB, ASPHALT TAC TOPO_E_TAC 
 

Y 4 
32 CURB, HEADER THC TOPO_E_THC 

 
Y 4 

33 CURB & GUTTER, TOP TCGT TOPO_E_TCGT 
 

Y 4 
34 CURB & GUTTER, F/L TCGF TOPO_E_TCGF 

 
Y 4 

35 V-GUTTER TVG TOPO_E_TVG 
 

Y 4 
36 BRIDGE APPROACH SLAB, EDGE TBAS TOPO_E_TBAS 

 
Y 4 

37 BRIDGE END, CENTER TBRDGCEN TOPO_E_TBRDGCEN 
 

N 4 
38 BRIDGE END, CORNER TBRDGCOR TOPO_E_TBRDGCOR 

 
N 4 

39 BRIDGE COLUMN, CENTER TCOLC TOPO_E_TCOLC N 
 

1 
40 BRIDGE COLUMN, EDGE TCOLE TOPO_E_TCOLE N 

 
1 

41 BRIDGE GUTTER LINE TBGL TOPO_E_TBGL 
 

N 4 
42 BRIDGE CENTERLINE TBCL TOPO_E_TBCL 

 
N 4 

43 ENDROLL TENDROLL TOPO_E_TENDROLL 
 

Y 4 
44 BRIDGE CAP TBCAP TOPO_E_TBCAP N 

 
2 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  Drainage          
45 SINGLE CATCH BASIN, Gutr F/L DCB TOPO_E_DCB N 

 
2 

47 DOUBLE CATCH BASIN, Gutr F/L DDCB TOPO_E_DDCB N 
 

2 
49 DROP INLET, TOP DDI TOPO_E_DDI N 

 
2 

50 SPUR DIKE DSPURDK TOPO_E_DSPURDK 
 

Y 4 
51 TOP OF WATER ELEVATION DWE TOPO_E_DWE N 

 
2 

52 STREAM CENTER, F/L DSC TOPO_E_DSC 
 

Y 4 
53 STREAM EDGE DSE TOPO_E_DSE 

 
Y 4 

54 STREAM BANK TOP DSB TOPO_E_DSB 
 

Y 4 
55 DAM, TOP DDT TOPO_E_DDT 

 
Y 4 

56 DAM, TOE DADB TOPO_E_DADB 
 

Y 4 
57 OBSCURED AREA DOBSC TOPO_E_DOBSC 

 
Y  4 

59 HEAD WALL, END DHWE TOPO_E_DHWE 
 

N 3 
60 CULVERT, WINGWALL END DCWE TOPO_E_DCWE 

 
N 3 

61 EDGE OF WATER DEW TOPO_E_DEW 
 

N 3 
62 SWAMP EDGE DSWE TOPO_E_DSWE 

 
N 3 

63 WETLAND BOUNDARY DWB TOPO_E_DWB 
 

N 3 
**NA DRAINAGE BOTTOM OF DITCH DBOD TOPO_E_DBOD  Y 4 
**NA DRAINAGE TOP OF DITCH DTOD TOPO_E_DTOD  Y 4 
**NA STREAM BANK-FULL SBF TOPO_E_SBF N  2 
**NA STREAM X-SECTION SXS TOPO_E_SXS N  2 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  Utilities          
68 STRAIN POLE UUSTRPOL TOPO_E_UUSTRPOL N 

 
1 

69 ELECTRICAL BOX UUELBOX TOPO_E_UUELBOX 
 

N 3 
70 OVERHEAD ELECTRICAL LINE UUOEL TOPO_E_UUOEL 

 
N 3 

71 OVERHEAD TELEPHONE LINE UUOTL TOPO_E_UUOTL 
 

N 3 
72 POWER POLE, CENTER UUPP TOPO_E_UUPP N 

 
1 

73 LIGHT POLE, CENTER UULP TOPO_E_UULP N 
 

1 
74 TELEPHONE POLE, CENTER UUTP TOPO_E_UUTP N 

 
1 

75 TELEPHONE PEDESTAL, CENTER UUTPD TOPO_E_UUTPD N 
 

1 
76 GUY POLE, CENTER UUGP TOPO_E_UUGP N 

 
1 

77 POLE ANCHOR UUPGA TOPO_E_UUPGA N 
 

1 
78 YARD LIGHT, ELECTRICAL UUYLE TOPO_E_UUYLE N 

 
1 

79 YARD LIGHT, GAS UUYLG TOPO_E_UUYLG N 
 

1 
80 WATER METER, CENTER UUWM TOPO_E_UUWM N 

 
1 

81 WATER VALVE UUWV TOPO_E_UUWV N 
 

1 
82 FIRE HYDRANT, CENTER UUFH TOPO_E_UUFH N 

 
1 

83 MANHOLE STORM SEWER, TOP UUMHST TOPO_E_UUMHST N 
 

2 
84 MANHOLE STORM SEWER, F/L UUMHSTF TOPO_E_UUMHSTF N 

 
2 

85 MANHOLE, TELEPHONE, TOP UUMHT TOPO_E_UUMHT N 
 

2 
86 MANHOLE, ELECTRICAL, TOP UUMHE TOPO_E_UUMHE N 

 
2 

87 MANHOLE, SANITARY SEWER, TOP UUMHSS TOPO_E_UUMHSS N 
 

2 
88 MANHOLE, SANITARY SEWER, F/L UUMHSSF TOPO_E_UUMHSSF N 

 
2 

89 SANITARY SEWER LINE, CENTER UUSSL TOPO_E_UUSSL N 
 

1 
90 GAS METER, CENTER UUGM TOPO_E_UUGM N 

 
1 

91 GAS VALVE, CENTER UUNGV TOPO_E_UUNGV N 
 

1 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  Utilities          
92 GAS VENT PIPE UUNGVP TOPO_E_UUNGVP N 

 
1 

93 GAS LINE MARKER UUNGLM TOPO_E_UUNGLM N 
 

1 
**NA PEDESTRIAN CROSS LIGHT UUPCL UTLE_E_UUPCL                                           N                     1 

**NA TRAFFIC SIGNAL BOX UUTSB UTLE_E_UUTSB                                            N               3 

**NA UNDERGROUND FIBER MARKER UUFM UTLE_E_UUFM                                          N                     1 

  Subsurface Utilities          
**NA SUBSURFACE UTILITY - BOTTOM SUEBOT UTLE_E_SUEBOT                                          N                     2 

**NA SUBSURFACE UTILITY - TOP SUETOP UTLE_E_SUETOP                                          N                     2 

  General Topo          
95 WALL FACE TWF TOPO_E_TWF 

 
N 3 

96 WALL FACE, TOP TWFT TOPO_E_TWFT 
 

Y 4 
97 WALL FACE, BOTTOM TWFB TOPO_E_TWFB 

 
Y 4 

98 IRRIGATION PIVOT POINT TIRRPVTP TOPO_E_TIRRPVTP N 
 

1 
99 IRRIGATION LIMITS TIRRLMT TOPO_E_TIRRLMT N 

 
1 

100 SIGN, CENTER TSC TOPO_E_TSC N 
 

1 
101 GASOLINE MONITORING WELL TGMW TOPO_E_TGMW N 

 
1 

102 GASOLINE FILLER VALVE TGFV TOPO_E_TGFV N 
 

1 
103 GASOLINE VENT PIPE TGVP TOPO_E_TGVP N 

 
1 

104 GASOLINE PUMP TGP TOPO_E_TGP N 
 

1 
105 GASOLINE STORAGE TANK, END TGST TOPO_E_TGST 

 
N 3 

106 GASOLINE PUMP ISLAND TGPI TOPO_E_TGPI 
 

N 3 
107 CANPOY TCAN TOPO_E_TCAN 

 
N 3 

108 BUILDING CORNER TBLD TOPO_E_TBLD 
 

N 3 
109 BUILDING ROOF LINE CORNER TBLDRL TOPO_E_TBLDRL 

 
N 3 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

110 HOUSE CORNER THCR TOPO_E_THCR 
 

N 3 
111 HOUSE ROOF LINE CORNER THRL TOPO_E_THRL 

 
N 3 

112 MOBILE HOME CORNER TMHCR TOPO_E_TMHCR 
 

N 3 
113 MOBILE HOME ROOF LINE CORNER TMHRL TOPO_E_TMHRL 

 
N 3 

115 WOODS LINE TWL TOPO_E_TWL 
 

N 3 
116 CULTIVATION LINE TCUL TOPO_E_TCUL 

 
N 3 

117 FENCE, FIELD WIRE TFFW TOPO_E_TFFW 
 

N 3 
118 FENCE, BARB WIRE TFBW TOPO_E_TFBW 

 
N 3 

119 FENCE, WOOD TFW TOPO_E_TFW 
 

N 3 
120 RAILROAD, TOP OF RAIL UTRCR UTLE_E_UTRCR 

 
N 4 

121 RAILROAD, CENTERLINE UTRCL UTLE_E_UTRCL 
 

N 3 
122 CEMETERY LINE TCEM TOPO_E_TCEM 

 
N 3 

123 GRAVE TGRV TOPO_E_TGRV 
 

N 3 
124 GUARDRAIL TGR TOPO_E_TGR 

 
N 3 

125 SIGN, END TSE TOPO_E_TSE 
 

N 3 
126 SATELLITE DISH UTSATDSH UTLE_E_UTSATDSH N 

 
1 

127 LIMIT LINE TLIML TOPO_E_TLIML 
 

Y 4 
128 CONSTRUCTION BOUNDARY, ACTV TCBA TOPO_E_TCBA 

 
Y 4 

129 CONSTRUCTION BOUNDARY, FIND TCBF TOPO_E_TCBF 
 

Y 4 
  Boundaries          
130 COUNTY LINE BCOL PROP_E_BCOL 

 
N 3 

131 CITY LIMIT LINE BCTL PROP_E_BCTL 
 

N 3 
132 LAND DISTRICT LINE BLDL PROP_E_BLDL 

 
N 3 

133 LAND LOT LINE BLLL PROP_E_BLLL 
 

N 3 
134 STATE LINE BSL PROP_E_BSL 

 
N 3 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  New Codes        
  **152 HIGH WATER MARK  DHWM            TOPO_E_DHWM            N 

 
2 

**153 FLOOR ELEVATION  TFE TOPO_E_TFE N   
 

2 
**154 EDGE OF DIRT DRIVE TEDD TOPO_E_TEDD 

 
Y 4 

**156 GATE  TG TOPO_E_TG 
 

N  3 
**158 UNCOVERED DECK TUD TOPO_E_TUD 

 
N  3 

160 MAP CHECK GROUND MPCKGRD TOPO_E_MPCKGRD N  2 
161 MAP CHECK PAVEMENT MPCKPAV TOPO_E_MPCKPAV N  2 
**162 VINYL (PVC) FENCE  TVF TOPO_E_TVF 

 
N  3 

**163 FUEL TANK        TFT TOPO_E_TFT 
 

N  3 
**164 PAVE DITCH  DPD TOPO_E_DPD 

 
Y  4 

**165 BRICK COLUMN TBC TOPO_E_TBC 
 

N  3 
**166 SEPTIC TANK CENTER DSTC                             TOPO_E_DSTC                             N   1 
**167 STEPS                                                                                                   TS  TOPO_E_TS  

 
N  3 

**168 HISTORICAL MONUMENT                          THM TOPO_E_THM 
 

N  3 
**169 FLAG POLE  TFP TOPO_E_TFP N              1 
**170 DRAIN LINES  DDL TOPO_E_DDL 

 
N             3 

**NA EDGE OF TRAVEL LANE  TETL TOPO_E_TETL  Y             4 

  Surveyor Defined  
                    

171 Surveyor Defined Value XXA TOPO_E_XXA 
 

Y 4 
172 Surveyor Defined Value XXB TOPO_E_XXB 

 
Y 4 

173 Surveyor Defined Value XXC TOPO_E_XXC 
 

Y 4 
174 Surveyor Defined Value XXD TOPO_E_XXD 

 
Y 4 

175 Surveyor Defined Value XXE TOPO_E_XXE 
 

Y 4 
176 Surveyor Defined Value XXF TOPO_E_XXF 

 
Y 4 

177 Surveyor Defined Value XXG TOPO_E_XXG 
 

Y 4 
178 Surveyor Defined Value XXH TOPO_E_XXH 

 
N 3 



 Standard Conventions    InRoads Design Guidelines SS2 

2-40 
 

 

 
 

 
SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  Surveyor Defined  
                    

179 Surveyor Defined Value XXI TOPO_E_XXI 
 

N 3 
180 Surveyor Defined Value XXJ TOPO_E_XXJ 

 
N 3 

181 Surveyor Defined Value XXK TOPO_E_XXK 
 

N 3 
182 Surveyor Defined Value XXL TOPO_E_XXL 

 
N 3 

183 Surveyor Defined Value XXM TOPO_E_XXM 
 

N 3 
184 Surveyor Defined Value XXN TOPO_E_XXN 

 
N 3 

185 Surveyor Defined Value XXO TOPO_E_XXO Y 
 

2 
186 Surveyor Defined Value XXP TOPO_E_XXP Y 

 
2 

187 Surveyor Defined Value XXQ TOPO_E_XXQ Y 
 

2 
188 Surveyor Defined Value XXR TOPO_E_XXR Y 

 
2 

189 Surveyor Defined Value XXS TOPO_E_XXS Y 
 

2 
190 Surveyor Defined Value XXT TOPO_E_XXT Y 

 
2 

191 Surveyor Defined Value XXU TOPO_E_XXU Y 
 

2 
192 Surveyor Defined Value XXV TOPO_E_XXV N 

 
1 

193 Surveyor Defined Value XXW TOPO_E_XXW N 
 

1 
194 Surveyor Defined Value XXX TOPO_E_XXX N 

 
1 

195 Surveyor Defined Value XXY TOPO_E_XXY N 
 

1 
196 Surveyor Defined Value XXZ TOPO_E_XXZ N 

 
1 

197 Surveyor Defined Value XXZA TOPO_E_XXZA N 
 

1 
198 Surveyor Defined Value XXZB TOPO_E_XXZB N 

 
1 

199 Surveyor Defined Value XXZC TOPO_E_XXZC N 
 

1 
**NA Surveyor Defined Value (Utility) UXXA UTLE_E_UXXA                                           N                     1 
**NA Surveyor Defined Value (Utility) UXXB UTLE_E_UXXB                                           

 
      N                             3 
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SMI 

Code Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 
Group 
Code 

  Dimension Codes: (Drainage)  
        

200 DRAINAGE PIPE, F/L, C DPC TOPO_E_DPC 
 

N 4 
201 DRAINAGE PIPE, F/L, M DPM TOPO_E_DPM 

 
N 4 

202 DRAINAGE PIPE, F/L, P DPP TOPO_E_DPP 
 

N 4 
**203 CULVERT END, F/L DCEF TOPO_E_DCEF 

 
N 4 

  Dimension Codes (General Topo)  
        

210 SIDEWALK, CENTER TSW TOPO_E_TSW 
 

N 3 
211 FENCE, CHAIN LINK TFCL TOPO_E_TFCL 

 
N 3 

212 TREE, CENTER TTRE TOPO_E_TTRE N 
 

1 
213 WELL TWELL TOPO_E_TWELL N 

 
1 

  Dimension Codes (Roadway)  
        

225 DIRT ROAD, C/L TDR TOPO_E_TDR 
 

N 3 
227 DIRT DRIVE, C/L TDD TOPO_E_TDD 

 
N 3 

235 MILE POST, RAILROAD UTMPR UTLE_E_UTMPR N 
 

1 
236 KM POST, HIGHWAY TKMP TOPO_E_TKMP N 

 
1 

237 MILE POST, HIGHWAY TMPH TOPO_E_TMPH N 
 

1 

  Survey control  
        

240 NGS CONTROL MONUMENT SNGSCM TOPO_E_SNGSCM N 
 

2 
241 LOCATION CONTROL MONUMENT SLCM TOPO_E_SLCM N 

 
2 

242 LOCATION CONTROL DELTA SLCD TOPO_E_SLCD N 
 

2 
243 DISTRICT CONTROL DELTA SDCD TOPO_E_SDCD N 

 
2 

244 CONTROL RE-SHOT FOR CHECK SCCHK TOPO_E_SCCHK N 
 

2 
245 BENCHMARK SBNCHMK TOPO_E_SBNCHMK N 

 
2 

250 ***MISCELLANEOUS MISC TOPO_E_MISC N 
 

2 
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***SMI Code 250 Miscellaneous MISC TOPO_E_MISC 
(Not to be used by field survey personnel.  Reserved for use by the GDOT Location Bureau for such items as Control work for 
mappers, property line disputes, consultant rechecks, etc.  Field survey personnel should only use the surveyor defined codes 171 to 
199 for miscellaneous undefined items). 



 

 

 
 

    3  
Horizontal Alignments   
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3. Horizontal Alignments 

This section provides a brief overview of the requirements for Horizontal Alignments, Horizontal 
Alignment Points and COGO Points. For detailed Horizontal Alignment information please refer 
to Lab 3 in the Design Training Labs.   

This section covers the following topics: 
 
● Horizontal Alignment Overview 
● Horizontal Alignment and COGO Point Names/Feature Styles  
● COGO Points and Alignment Points 
● View Horizontal Annotation Preferences 
● View Horizontal Annotation Filters 
● Reviewing Horizontal Alignments 
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3.1 Horizontal Alignment Overview 
In InRoads the term Horizontal Alignment refers to all linear elements, open or closed, such 
as centerlines, right of way parcels, edge of pavements, etc. Horizontal Alignments consist of 
COGO points, linear elements and curves. Curves are not independent entities but are 
considered part of the Alignment. In order to generate Horizontal Alignments to GDOT 
standard conventions – the following information should be adhered and followed. 
 

 
a)  All Centerline Horizontal Alignments must have a Feature Style assigned of  

                    MAIN_P_CONSTCL, MAIN_P_SIDECL or STE_P_DETCL for the   
                         correct Symbology and Stationing to view correctly.  

 
b) All Right of Way and Easement Alignments must have a Feature Style assigned 

of REQD_P_DWESMT, REQD_P_PESMT, REQD_P_REQD or 
REQD_P_TESMT for the Right of Way Tables to generate correctly. 

 
c) Any additional Horizontal Alignments such as Ditch Centerlines, Edge of 

Pavements, etc. must be assigned the appropriate Feature Style for the 
Symbology and Levels to view correctly in MicroStation. 

 
d) All Horizontal Alignment Names and COGO Point Names must begin with a 

DE Prefix.  All Points must begin numbering at DE10000. Horizontal 
Alignment numbering may begin at DE1. 

 
e)  All Horizontal Alignment Points must be converted to COGO Points. 

 
f) Designers should not use the Existing Centerline Alignment provided by 

Survey as the Design Alignment but should create a new Design Alignment 
either by copying and renaming the Existing Centerline Alignment and 
assigning an appropriate Feature Style or by creating a new Design Centerline 
Alignment from scratch. 
 

g) When working on a Horizontal Alignment – ensure that it is set as the Active 
Alignment. 
 

h) When storing curve data in Horizontal Alignments – ensure that all the curves 
are tangent and points are equated at the PC and PT of all curves. 

 
i) Make sure to save the ALG file periodically when changes are made. InRoads 

does not save data on the fly - data is saved in temporary memory. The ALG 
file must be manually saved in order to retain Design modifications. 
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3.2 Horizontal Alignment and COGO Point Names/Feature Styles  
Horizontal Alignments and COGO Points must be stored with a DE Prefix and must be 
stored in a certain Point/Horizontal Alignment Number range along with the appropriate 
Feature Style. See the following Tables (Tables 3.1, 3.2 and 3.3) for a list of the required 
naming conventions. 

 
 

Table 3.1 
Standard Design Geometry Object Names 

 

Object Type Prefix Starting Number 
*Design Cogo Points  DE 10000 (Max. = 99,999) 

*Design Horizontal Alignment Points DE 10000 (Max. = 99,999) 

**Design Horizontal Alignments DE 1 

***Design Vertical Alignments DE 1 

 
* All Design Cogo Points and Design Horizontal Alignment Points must be named with a 

prefix of DE and begin with the number 10000 (e.g., first design point = DE10000). 
 

**All Design Horizontal Alignments must be named with a prefix of DE and begin with the 
number 1, (e.g., DE1). 

 
***It is suggested that the Design Vertical Alignment (which corresponds with the Horizontal 

Alignment) be named the same as the associated Horizontal Alignment. 
 

Table 3.2 
Design Point  & Alignment Ranges to Use 

 

Cogo/Alignment Points Range – 10,000 to 99,999 

Horizontal/Vertical Alignments Range – 1  to no Limitations for Alignments -- but must have 
the DE Prefix 
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Table 3.3 
Feature Styles For Geometry Design Points and Alignments 

  Feature Style 

DRNG_P_Ditch 
MAIN_P_CONSTCL 
MAIN_P_EOP 
MAIN_P_EPSHLDR 
MAIN_P_SHLDR 
MAIN_P_SIDECL 

REQD_P_DWESMT 
REQD_P_PESMT 
REQD_P_REQD 
REQD_P_RWRM 
REQD_P_TESMT 
STE_P_DETCL 

   Proposed Centerline Alignments  
Feature Style 

Mainline Centerline MAIN_P_CONSTCL        Ex: C/L  HWY 100 

Sideroad Centerline MAIN_P_SIDECL             Ex: C/L PEQUANOC DR. 

Detour Centerline STE_P_DETCL                  Ex: C/L US 78 
Proposed Right of Way  
Feature Style 

R/W Monument REQD_P_RWRM               N/A 

Reqd. R/W REQD_P_REQD                Ex: REQD R/W – PAR 33/SV29 

Perm. Const. Esmt. REQD_P_PESMT              Ex: PESMT – PAR 44/SV67 

Temp. Const. Esmt. REQD_P_TESMT              Ex: TESMT – PAR 23/SV88 

Driveway Esmt. REQD_P_DWESMT**     Ex: DWESMT – PAR 14/SV30 

Miscellaneous  
Feature Style 

Edge of Pavement MAIN_P_EOP                   Ex: EOP – HWY 100 

Edge of Paved Shoulder MAIN_P_EPSHLDR        Ex: EPSHLDR – PEQUANOC DR. 

Edge of Shoulder MAIN_P_SHLDR             Ex: SHLDR – US 78 

Ditch Centerline DRNG_P_Ditch                 Ex: Ditch – HWY 100 

Other (User-Defined)                   User Defined 
 

** Note: All other Types of Miscellaneous Easements should use the REQD_P_DWESMT 
Feature Style. 

 
 
 
 
 
 
 

Proposed Design Points    

 Descriptions    
(C/L Roadway Name) 

Descriptions    
(Feature Style – Parcel #/Parcel Align) 

Descriptions    
(Feature Style – Roadway Name)  
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3.3 COGO Points and Alignment Points 
InRoads has the capability to store both COGO Points (which are northing and easting 
coordinates) and the ability to store Alignments Points (which are just coordinates with an 
assigned name – not independent Points).  It is a required GDOT standard that all Points 
must be stored as COGO Points. If Alignment Points are stored – it is the Designer’s 
responsibility to convert these Points to COGO Points. In order to view the correct Point 
Cells and Symbology – COGO Points must be stored instead of Alignment Points in order 
to generate the correct Symbology, Level, etc. for plans productions. Following is a brief 
overview of COGO Points versus Alignment Points. 
 

***IMPORTANT DISCUSSION*** 
It is very important to discuss some differences between InRoads and what you are familiar 
with in CAiCE.  InRoads has different kinds of points.  Alignment points and COGO points 
are two types of points to be aware of.  Alignment points are nothing more than names 
assigned to coordinates in an alignment and do not exist in the COGO points buffer.  In 
order to satisfy GDOT plan presentation requirements, prepare R/W tables and properly 
add enhanced survey data to your project. -- Surveyors and Designers alike must ensure 
that all alignments have a corresponding COGO point stored.  At some point this may 
cause you problems as you branch out and experiment with other InRoads commands 
because not all InRoads commands store COGO points.  Some only assign Alignment Point 
names and must be converted to COGO points. Some don’t assign Alignment Point names 
or store COGO points and must be assigned Alignment Point names and then be converted 
to COGO points. As such we recommend that you adhere closely to the methods presented 
in the tutorials concerning centerlines, R/W and property.  We bring this up because it is 
possible to view points at the same time as viewing Alignments without having to populate 
the Cogo Points in the View Horizontal Annotation command.  Viewing points in this 
manner would not apply the correct attributes to the points -- therefore you must view the 
Cogo points separately. 
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3.4 View Horizontal Annotation Preferences 
In order to view Horizontal Alignments to GDOT Standards – there are several Preferences 
which must be set. These Preferences set the viewing of Alignments (Bearing & Distance or 
No Bearing & Distance) options, the Stationing/Tic Marks and the Curve Data Tables. The 
following Tables depict the available Preferences, Locations and Descriptions to set the 
Preferences. 
 
 

Table 3.4 
Preference – View Horizontal Annotation   

Location: Geometry View Geometry  Horizontal Annotation (Preferences Button) 

Preference Name Description 

BEARING & DISTANCE Loads settings into the View Horizontal Annotation dialog to label the bearing 
when viewing Roadway alignments with the feature styles MAIN_P_CONSTCL, 
MAIN_P_SIDECL, and PROP_E_ACL.  Although DISTANCE is part of the Preference 
name the distance is no longer set up to be labeled.  
 

NO BEARING & DISTANCE Displays NO Bearing & Distance information for all Horizontal Alignments. 
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Table 3.5 
Preference – View Stationing   

Location: Geometry View Geometry  Stationing (Preferences Button) 

Preference Name Description 

ACL   
Displays the Stationing, Tics and Curve Data at a 50 Scale for PROP_E_ACL 
Horizontal Alignments. 

CONSTCL   
Displays the Stationing, Tics and Curve Data at a 50 Scale for MAIN_P_CONSTCL 
Horizontal Alignments. 

CONSTCL 20 SCALE    
Displays the Stationing, Tics and Curve Data at a 20 Scale for MAIN_P_CONSTCL 
Horizontal Alignments. 

DETCL   
Displays the Stationing, Tics and Curve Data at a 50 Scale for STE_P_DETCL  
Horizontal Alignments. 

DETCL 20 SCALE   
Displays the Stationing, Tics and Curve Data at a 20 Scale for STE_P_DETCL  
Horizontal Alignments. 

SIDECL   
Displays the Stationing, Tics and Curve Data at a 50 Scale for MAIN_P_SIDECL  
Horizontal Alignments. 

SIDECL 20 SCALE  
Displays the Stationing, Tics and Curve Data at a 20 Scale for MAIN_P_SIDECL  
Horizontal Alignments. 

 
 

Table 3.6 
Preference – Curve Set Annotation   

Location: Geometry View Geometry  Curve Set Annotation (Preferences Button) 

Preference Name Description 

ACL Displays the Curve Data Table for PROP_E_ACL to GDOT Standards. 
CONSTCL Displays the Curve Data Table for MAIN_P_CONSTCL to GDOT Standards. 
DETCL Displays the Curve Data Table for STE_P_DETCL to GDOT Standards. 
SIDECL Displays the Curve Data Table for MAIN_P_SIDECL to GDOT Standards. 
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3.5 View Horizontal Annotation Filters 
Geometry Selection Filters can be used to select specific Alignments and COGO Points. 
Once selected and filtered – the Alignments and/or COGO Points will view and/or can be 
used for the generation of specific Style Sheets based on the criteria selected. The following 
Tables depict the available Filters, Locations and Descriptions to set the Filters. 
 
 

Table 3.7 
Geometry Selection Filter Preferences for Horizontal Alignments and COGO Points 

 
Location: Geometry View Geometry  Horizontal Annotation (Filter Button) 

Then in the Geometry Selection Filter – select the Preferences Button.  

Filter Name Description 

ACL Cogo Point Feature Styles Loads the Filter to select and view the Feature Style Points for the 
generation of the ACL Existing Centerline. (Used by the SDE) 

Prop.dgn Alignments Loads the Filter to select and view the Feature Style Alignments for the 
production of the PROP DGN File. (Used by the SDE) 

Prop.dgn Points Loads the Filter to select and view the Feature Style Points for the 
production of the PROP DGN File. (Used by the SDE) 

REQD.dgn Alignments Loads the Filter to select and view the Feature Style Alignments for the 
production of the REQD DGN File. 

REQD.dgn Points Loads the Filter to select and view the Feature Style Points for the 
production of the REQD DGN File. 

Stakeout Survey Data Loads the Filter to select the Feature Style Points for use in the GDOT 
Stakeout Report Style Sheet. 

Surface Check MPCKGRD Loads the Filter to select the TOPO_E_MPCKGRD Feature Style Points for use 
in the GDOT Surface Check Style Sheet. 

Surface Check MPCKPAV Loads the Filter to select the TOPO_E_MPCKPAV Feature Style Points for use 
in the GDOT Surface Check Style Sheet.  
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3.6 Reviewing Horizontal Alignments 
The Horizontal Alignments description can be reviewed and printed by using the 
Geometry Review Horizontal command. 
 
Following is the process for reviewing/describing Horizontal Alignments: 
 

• Ensure that the Horizontal Alignment you want to describe is the Active Horizontal 
Alignment. 

• In InRoads, Select Geometry ► Review Horizontal…and the Review Horizontal 
Alignment description appears. 

• The user may also print the description by using the Print button on the Review 
Horizontal Alignment dialog. (See Figure 3-1).   
 

 

 
 

Figure 3-1   Review Horizontal Alignment 
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4. Vertical Alignments 

This section provides a brief overview of the requirements for generating Existing Ground Profiles 
(Terrain Profiles) and Design Vertical Alignments. For detailed Vertical Alignment information 
please refer to Lab 4 in the Design Training Labs.   

This section covers the following topics: 
 
● Vertical Alignment Overview 
● Vertical Alignment Names and Feature Styles  
● Vertical Alignment Preferences 
● Vertical Alignment Annotation Preferences 
● Reviewing Vertical Alignments 
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4.1 Vertical Alignment Overview 
In InRoads the term Vertical Alignment refers to the Proposed Design Profile. A Vertical 
Alignment is created for each associated Horizontal Alignment.  A proposed Horizontal 
Alignment and an Existing DTM must be available before creating an Existing Profile and a 
Proposed Vertical Alignment.   In order to generate Vertical Alignments to GDOT standard 
conventions – the following information should be adhered and followed. 
 

        
a) All Vertical Alignments should be named the same as the associated Horizontal 

Alignment. Example: Horizontal Alignment = DE7 then the Vertical Alignment 
should be named DE7.  
 

b) A parent/child relationship exists in InRoads between the Horizontal and Vertical 
Alignments.  A Vertical Alignment is a child of the Horizontal Alignment.  
Multiple Vertical Alignments may exist for a single Horizontal Alignment -- 
therefore it is important to have the correct Vertical Alignment active along with 
the active Horizontal Alignment before doing any work. 

 
c) Before PVI’s can be added to the Vertical Alignment, a Profile Window must be 

created.  This is also how the Terrain Profile is created.  In InRoads, the Terrain 
Profile is not stored as a permanent object as in CAiCE.  The Terrain Profile is 
created ‘on the fly’ from the DTM and must be recreated each time you want to 
view it.  

 
d) The 100h_10v_WORKING, 20h_5v_WORKING and 50h_10v_WORKING 

Preferences views all the same information as the 100h_10v_ SHEETS, 20h_5v_ 
SHEETS and 50h_10v_SHEETS Preferences -- yet adds a grid to assist in the 
Vertical Alignment design.  This is for the temporary viewing of the profile during 
the design of the project.  

 
e)  Permanent viewing of the Profile and Vertical Alignment for plan generation and 

plotting is covered in Chapter 6 which depicts the use of the Profile Generator in 
InRoads. 

 
f) Adding PVI’s to a Vertical Alignment requires that you have an active Horizontal 

Alignment, Vertical Alignment and a Profile window in the MicroStation drawing 
file. 

 
g) Make sure to save the ALG file which contains the Vertical Alignment(s) 

periodically when changes are made. InRoads does not save data on the fly - data 
is saved in temporary memory. The ALG file must be manually saved in order to 
retain Design modifications. 
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4.2 Vertical Alignment Names and Feature Styles  
Vertical Alignments must be stored with a DE Prefix and should be named the same as the 
associated Horizontal Alignment.  Example: Horizontal Alignment = DE7 then the Vertical 
Alignment should be named DE7. The appropriate Feature Style should be used which 
corresponds with the Horizontal Alignment Feature Style. (See Tables 4.1 and 4.2).  

 
 

Table 4.1 
Standard Vertical Alignment Names 

 

Object Type Prefix Starting Number 
Vertical Alignment  DE 1 

 
  
 

Table 4.2 
Feature Styles For Geometry Vertical Alignments 

   Proposed Vertical Alignment 
Feature Style 

Mainline Centerline MAIN_P_CONSTCL        Ex: C/L  HWY 100 

Sideroad Centerline MAIN_P_SIDECL             Ex: C/L PEQUANOC DR. 

Detour Centerline STE_P_DETCL                  Ex: C/L US 78 
Miscellaneous  
Feature Style 

Edge of Pavement MAIN_P_EOP                   Ex: EOP – HWY 100 

Edge of Paved Shoulder MAIN_P_EPSHLDR        Ex: EPSHLDR – PEQUANOC DR. 

Edge of Shoulder MAIN_P_SHLDR             Ex: SHLDR – US 78 

Ditch Centerline DRNG_P_Ditch                 Ex: Ditch – HWY 100 

Other (User-Defined)                   User Defined 
 
 
 
 
 
 
 
 
 
 

 Descriptions    
(C/L Roadway Name) 

Descriptions    
(Feature Style – Roadway Name)  
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4.3 Vertical Alignment Preferences  
In order to generate/view Vertical Alignments to GDOT Standards – Preferences must be set. 
These Preferences set the viewing/creation of Vertical Alignments when using the Evaluation 
 Profile  Create Profile dialog. (See Table 4.3). 

  
 

Table 4.3 
Preference – Create Profile 

 
Location: Evaluation Profile  Create Profile (Preferences Button) 

 

Preference Name Description 

100h_10v_SHEETS Used for Vertical Alignment Sheet generation.  This Preference should be 
used for Plans Production only. Preference loads setting for a 100 Scale 
Horizontal and 10 Scale Vertical (100h_10v_SHEET) plans production Sheet 
generation. 

100h_10v_WORKING Used for Vertical Alignment Design and depicts a grid to assist in Profile 
Design. Preference loads setting for a 100 Scale Horizontal and 10 Scale 
Vertical  (100h_10v_WORKING) “working”  grid. 

20h_5v_SHEETS Used for Vertical Alignment Sheet generation.  This Preference should be 
used for Plans Production only. Preference loads setting for a 20 Scale 
Horizontal and 5 Scale Vertical (20h_5v_SHEET) plans production Sheet 
generation. 

20h_5v_WORKING Used for Vertical Alignment Design and depicts a grid to assist in Profile 
Design. Preference loads setting for a 20 Scale Horizontal and 5 Scale Vertical 
(20h_5v_WORKING) “working” grid. 

50h_10v_SHEETS Used for Vertical Alignment Sheet generation.  This Preference should be 
used for Plans Production only. Preference loads setting for a 50 Scale 
Horizontal and 10 Scale Vertical (50h_10v_SHEET) plans production Sheet 
generation. 

50h_10v_WORKING Used for Vertical Alignment Design and depicts a grid to assist in Profile 
Design. Preference loads setting for a 50 Scale Horizontal and 10 Scale 
Vertical (50h_10v_WORKING) “working” grid. 
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4.4 Vertical Alignment Annotation Preferences 
In order to annotate Vertical Alignments to GDOT Standards – Two different sets of 
Preferences must be set. One set of Preferences annotates the Terrain Profile and Vertical 
Alignment Elevations (Existing and Proposed Profiles). The other set of Preferences annotates 
the Vertical Alignment Curve Data.  (See Tables 4.4 and 4.5). 

  
 

Table 4.4 
Preference – Annotate Profile (Existing and Proposed Elevations) 

 
Location: Evaluation Profile  Annotate Profile (Preferences Button) 

SUE PREFERENCE ONLY: Location: Evaluation Profile Annotate Feature In Profile (Preferences Button) 

Preference Name Description 

100h_10v_Profile Used for Annotation of Existing and Proposed Profile Elevations for a 100 
Scale Horizontal and 10 Scale Vertical Profile (100h_10v_Profile). 

100h_10v_SHEETS This same preference name is now also used in the Annotate Profile dialog 
box.  It was copied from and is identical to the 100h_10v Profile preference.  
This is so the ‘Profile Preference’ under the ‘Profile Controls’ tab of the ‘Plan 
and Profile Generate’ dialog will not display Superelevation diagrams on the 
profile sheets. 

20h_5v_Profile Used for Annotation of Existing and Proposed Profile Elevations for a 20 
Scale Horizontal and 10 Scale Vertical Profile (20h_10v_Profile). 

20h_5v_SHEETS This same preference name is now also used in the Annotate Profile dialog 
box.  It was copied from and is identical to the 20h_5v Profile preference.  
This is so the ‘Profile Preference’ under the ‘Profile Controls’ tab of the ‘Plan 
and Profile Generate’ dialog will not display Superelevation diagrams on the 
profile sheets. 

50h_10v_Profile Used for Annotation of Existing and Proposed Profile Elevations for a 50 
Scale Horizontal and 10 Scale Vertical Profile (50h_10v_Profile). 

50h_10v_SHEETS This same preference name is now also used in the Annotate Profile dialog 
box.  It was copied from and is identical to the 50h_10v Profile preference.  
This is so the ‘Profile Preference’ under the ‘Profile Controls’ tab of the ‘Plan 
and Profile Generate’ dialog will not display Superelevation diagrams on the 
profile sheets. 

SUE Used for the profile annotation of SUE QL-A Test Hole data. 
 

Table 4.5 
Preference – Annotate Profile (Proposed Curve Data) 

 
Location: Geometry View Geometry  Vertical Annotation (Preferences Button) 

 

Preference Name Description 

GDOT Profiles Used for Annotation of Proposed Vertical Curve Data for all Scales. 
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4.5 Reviewing Vertical Alignments 
The Vertical Alignments description can be reviewed and printed by using the Geometry 
Review Vertical command. 
 
Following is the process for reviewing/describing Vertical Alignments: 
 

• Ensure that the Vertical Alignment you want to describe is the Active Vertical 
Alignment. 

• In InRoads, Select Geometry ► Review Vertical…and the Review Vertical 
Alignment description appears. 

• The user may also print the description by using the Print button on the Review 
Vertical Alignment dialog. (See Figure 4-1).   

 
 

 
 

Figure 4-1   Review Vertical Alignment 
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5. Import Graphics and Place Curve Tables 

This section provides a brief overview of the process to Import Graphics from MicroStation and the 
process to Place Curve Table Information in MicroStation.  For detailed Import Graphics and Place 
Curve Table information please refer to Lab 5 in the Design Training Labs.   

This section covers the following topics: 
 
● Import Graphics Overview 
● Import Graphics - Names/Feature Styles 
● Curve Table Overview 
● Curve Table Preferences 
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5.1 Import Graphics Overview 
The following section depicts an overview of the Import Graphics process and Naming/Feature 
Style conventions utilized to add Graphics from MicroStation into InRoads.  

There may be situations where Geometry graphics will need to be imported from a 
MicroStation DGN file into the InRoads ALG file. Examples are edge of pavement 
alignments or centerline alignments. In order to generate/ import Graphics to GDOT 
standard conventions – the following information should be adhered and followed. 
 

 
a) All Centerline Graphics should be imported and assigned a Feature Style of 

MAIN_P_CONSTCL, MAIN_P_SIDECL or STE_P_DETCL.   
 

b) Any additional Horizontal Alignments such as Ditch Centerlines, Edge of 
Pavements, etc. must be assigned the appropriate Feature Style for the Symbology 
and Levels to view correctly in MicroStation. 

 
c) All imported Horizontal Alignment Names and Alignment Point Names must 

begin with a DE Prefix.  All Points must begin numbering at DE10000. Horizontal 
Alignment numbering may begin at DE1. 

 
d)  All Horizontal Alignment Points must be converted to COGO Points. 

 
e) When importing Graphics using the Import Geometry dialog, Join Elements 

and All Selected Elements Added to Single Alignment should be checked. 
 

f) Names must be assigned to the Coordinates in the Alignment to create Alignment 
Points. 
 

g) All Alignment Points must then be converted to COGO Points. 
 

h) Make sure to save the ALG file periodically when changes are made. InRoads 
does not save data on the fly - data is saved in temporary memory. The ALG file 
must be manually saved in order to retain Design modifications. 
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5.2 Import Graphics - Names/Feature Styles 
When importing graphics from MicroStation, all Alignments must be stored with a DE Prefix 
and Numbering may begin at DE1 or the next available number.  The appropriate Feature Style 
should be used which corresponds with the Horizontal Alignment Feature Style. (See Tables 5.1 
and 5.2).  

 
Table 5.1 

Import Graphics - Standard Design Geometry Object Names 
 

Object Type Prefix Starting Number 
Design Cogo Points  DE 10000 (Max. = 99,999) 

Design Horizontal Alignment Points DE 10000 (Max. = 99,999) 

Design Horizontal Alignments DE 1 or next available number 

Design Vertical Alignments DE 1 or next available number 

 
 

Table 5.2 
Import Graphics - Feature Styles For Geometry Horizontal Alignments 

   Proposed Vertical Alignment 
Feature Style 

Mainline Centerline MAIN_P_CONSTCL        Ex: C/L  HWY 100 

Sideroad Centerline MAIN_P_SIDECL             Ex: C/L PEQUANOC DR. 

Detour Centerline STE_P_DETCL                  Ex: C/L US 78 
Miscellaneous  
Feature Style 

Edge of Pavement MAIN_P_EOP                   Ex: EOP – HWY 100 

Edge of Paved Shoulder MAIN_P_EPSHLDR        Ex: EPSHLDR – PEQUANOC DR. 

Edge of Shoulder MAIN_P_SHLDR             Ex: SHLDR – US 78 

Ditch Centerline DRNG_P_Ditch                 Ex: Ditch – HWY 100 

Other (User-Defined)                   User Defined 
 

 
 
 
 
 
 

 Descriptions    
(C/L Roadway Name) 

Descriptions    
(Feature Style – Roadway Name)  
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5.3 Curve Table Overview 
In order to correspond with the GDOT Plan Presentation Guide, Curve Tables are required 
for each Horizontal Alignment. The Curve Tables depict the Curve Data for each curve of 
the Alignment(s).  In order to generate/ import Graphics to GDOT standard conventions – 
the following information should be adhered and followed. 

   
  Following is the Curve information which is required in the Curve Data Tables: 
 

 
 
 

a) Curve Data Table Required Information 
o CURVE Number 
o P.I. Station 
o P.I. Coordinates 
o  or “DELTA” (Deflection angle) 
o D   (Degree of Curve) 
o T   (Tangent Length) 
o L   (Length of Curve) 
o R   (Radius) 
o E   (External distance) 
o e   (Superelevation in percent) 

 
 

b) The Symbology and Level of the Curve Tables are based on the Feature Style of 
the Horizontal Alignment.  

 
c) If there is more than one curve in an Alignment – the Curve Table assigns each 

curve a name of Curve 1, Curve 2, etc. When viewing more than one Alignment – 
the second alignment will also name the curve in it Curve 1, Curve 2, etc.  It is the 
Designer’s responsibility to manually modify each curve table in MicroStation to 
assign the Curve another Number. For Example: If Alignment DE7 contains three 
curves (and associated curve tables) – all of the curve tables will be given the 
curve number of Curve 1, Curve 2 and Curve 3. When viewing Alignment DE31, 
these Curves will also be named Curve 1, Curve 2 and Curve 3.  The Designer will 
need to edit the Curve Table number in MicroStation in order to rename each 
successive curve (per alignment) as Curve 1, Curve 2, Curve 3, etc. so that there 
will not be duplicate Curve Table Numbers/Names on a plan sheet. 

 
d) The Preferences for the Curve Tables are the Feature Styles of (ACL) 

PROP_E_ACL, (CONSTCL) MAIN_P_CONSTCL, (DETCL) STE_P_DETCL 
and (SIDECL) MAIN_P_SIDECL. 
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5.4 Curve Table Preferences 
In order to view Horizontal Curves to GDOT Standards – Preferences must be set. These 
Preferences set the viewing of the Curve Data Table based on the Feature Style of the 
Alignments and Curve Data. The following Table depicts the available Preferences for Curve 
Data Tables. (See Table 5.3 below). 

 
 

Table 5.3 
Preference – Curve Set Annotation   

 
Location: Geometry View Geometry Curve Set Annotation (Preferences Button) 

 

Preference Name Description 

ACL Loads the Curve Table Preference for the Feature Style of PROP_E_ACL. 
CONSTCL Loads the Curve Table Preference for the Feature Style of MAIN_P_CONSTCL. 
DETCL Loads the Curve Table Preference for the Feature Style of STE_P_DETCL. 
SIDECEL Loads the Curve Table Preference for the Feature Style of MAIN_P_SIDECL. 
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6. Profile Sheets 

This section provides a brief overview of the requirements for generating Profile Sheets. For 
detailed Profile Sheet information please refer to Lab 6 in the Design Training Labs.   

This section covers the following topics: 
 
● Profile Sheets Overview 
● Plan and Profile Generator Information 
● Vertical Alignment Preferences 
● Vertical Alignment Annotation Preferences 
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6.1 Profile Sheets Overview 
The following section depicts an overview of the methods used to generate Profile Sheets in 
InRoads in order to correspond to the Plan Presentation Guide and the Electronic Data 
Guidelines. The Plan and Profile Generator is used in InRoads to produce cut Profile Sheets. 
In order to generate Profile Sheets to GDOT standard conventions – the following 
information should be adhered and followed. 

 
 

a) An Existing Terrain DTM must exist and a Proposed Vertical Alignment must 
exist in the ALG file in order to use the Plan and Profile Generator to create 
Profile Sheets. 

 
b) The Plan and Profile Generator depicts the Terrain Profile, Vertical Alignment, 

Annotation and Profile Grid and generates cut Profile Sheets based on the 
selection of the applicable Scale Preference. 

 
c)  The Create Profile Preferences of 100h_10v_ SHEETS, 20h_5v_ SHEETS 

and 50h_10v_SHEETS are used for the generation of Profile Sheets. 
 

d) The Plan and Profile Generator Preferences for creation of Profile Sheets 
consists of 20 and 50 Scale Double Profile and Single Profile Options. 

 
e) The Plan and Profile Generator Preferences set the options in the dialog box for 

creation of the Profile Sheets but there are certain situations where the Designer 
will need to change the settings in the dialog box to ensure that the Profile data 
and annotation fits on the Profile Sheets. Not all situations for set-up of Profile 
Sheets can be automated without some modifications to spacing and Profile 
elevation shifts. The Plan and Profile Generator references the Create Profile 
dialog to draw the Profile in MicroStation. The user may also need to go to the 
Preferences on the Create Profile dialog and modify the window clearance in 
order for the Plan and Profile Generator to center the profile on the Profile 
Sheet. 

 
f) The Plan and Profile Generator utilizes three DGN files to create the cut Profile 

Sheets. The DGN’s are the “Master” DGN File, the “Host File” and the ‘Seed 
Host File”. 
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6.2 Plan and Profile Generator Information  
The generation of Profile Sheets is accomplished by using the Plan and Profile Generator 
command in InRoads. This command uses DGN and Host files to generate the cut Profile 
Sheets.  In order to understand the process -- the following information regarding the creation 
of Profile Sheets is discussed. 

 
 

• “Master” DGN File - a new MicroStation DGN file that is created which will contain 
the actual Terrain Profile, Vertical Alignment and Annotation.   
 

o The recommended File Naming Structure is PI#PR##.dgn.  
o (PI# = the Project Number, PR## = the Profile Alignment Name). 

 
• “Host File” – a MicroStation DGN file which is used to create the Profile Sheet. This file 

contains the grid cell and the clipping elements. It is the actual Profile Sheet which uses 
the “Master” DGN file as a Reference File.   

 
o The recommended File Naming Structure is PI#_Section Number.dgn. The 

Section Number is depicted in the Electronic Data Guidelines (EDG). The Section 
for Mainline Roadway Profile is 15. The Section for Crossroad Profile is 16.  

o (PI# = the Project Number, Separator = _, Section Name = 15 or 16). 
 

• “Seed Host File” – a MicroStation DGN file which is used as the seed file to create the 
“Host File”. This is the GDOT_V8_3D.dgn file which contains the standard GDOT 
DGN Library, cell libraries, etc.   

o (Note: In this table the “Seed Host File” is named GDOT 3D Working File.dgn). 
 

 
Table 6.1 

Plan and Profile Generator DGN Files - Standard DGN File Names 

DGN Type DGN File Name Example 
“Master” DGN File PI#PR##.dgn PI# = the Project Number, PR## = the Profile 

Alignment Name 
“Host File” PI#_Section 

Number.dgn 
PI# = the Project Number, Separator = _, Section 
Name = 15 or 16 

“Seed Host File” GDOT_V8_3D.dgn GDOT 3D Working File.dgn. 
 
RECAP: 
 

o PI#PR##.dgn = DGN File which contains the Terrain Profile, Vertical Alignment and 
Annotation 

o PI#_Section Number.dgn = DGN File which contains the Profile Sheets. 
o GDOT 3D Working File.dgn = DGN File which is the standard GDOT Seed File. 
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6.3 Vertical Alignment Preferences 
In order to generate/view Vertical Alignments to GDOT Standards – Preferences must be 
set. These Preferences set the viewing/creation of Vertical Alignments when using the 
Evaluation  Profile  Create Profile dialog. (See Table 6.2). 

  
 

Table 6.2 
Preference – Create Profile 

 
Location: Evaluation Profile  Create Profile (Preferences Button) 

 

Preference Name Description 

100h_10v_SHEETS Used for Vertical Alignment Sheet generation.  This Preference should be 
used for Plans Production only. Preference loads setting for a 100 Scale 
Horizontal and 10 Scale Vertical (100h_10v_SHEET) plans production Sheet 
generation. 

100h_10v_WORKING Used for Vertical Alignment Design and depicts a grid to assist in Profile 
Design. Preference loads setting for a 100 Scale Horizontal and 10 Scale 
Vertical  (100h_10v_WORKING) “working”  grid. 

20h_5v_SHEETS Used for Vertical Alignment Sheet generation.  This Preference should be 
used for Plans Production only. Preference loads setting for a 20 Scale 
Horizontal and 5 Scale Vertical (20h_5v_SHEET) plans production Sheet 
generation. 

20h_5v_WORKING Used for Vertical Alignment Design and depicts a grid to assist in Profile 
Design. Preference loads setting for a 20 Scale Horizontal and 5 Scale Vertical 
(20h_5v_WORKING) “working” grid. 

50h_10v_SHEETS Used for Vertical Alignment Sheet generation.  This Preference should be 
used for Plans Production only. Preference loads setting for a 50 Scale 
Horizontal and 10 Scale Vertical (50h_10v_SHEET) plans production Sheet 
generation. 

50h_10v_WORKING Used for Vertical Alignment Design and depicts a grid to assist in Profile 
Design. Preference loads setting for a 50 Scale Horizontal and 10 Scale 
Vertical (50h_10v_WORKING) “working” grid. 
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6.4 Vertical Alignment Annotation Preferences 
In order to annotate Vertical Alignments to GDOT Standards – Two different sets of 
Preferences must be set. One set of Preferences annotates the Terrain Profile and Vertical 
Alignment Elevations (Existing and Proposed Profiles). The other set of Preferences 
annotates the Vertical Alignment Curve Data.  (See Tables 6.3 and 6.4). 

 
Table 6.3 

Preference – Annotate Profile (Existing and Proposed Elevations) 
 

Location: Evaluation Profile  Annotate Profile (Preferences Button) 
SUE PREFERENCE ONLY: Location: Evaluation Profile Annotate Feature In Profile (Preferences Button) 

Preference Name Description 

100h_10v_Profile Used for Annotation of Existing and Proposed Profile Elevations for a 100 
Scale Horizontal and 10 Scale Vertical Profile (100h_10v_Profile). 

100h_10v_SHEETS This same preference name is now also used in the Annotate Profile dialog 
box.  It was copied from and is identical to the 100h_10v Profile preference.  
This is so the ‘Profile Preference’ under the ‘Profile Controls’ tab of the ‘Plan 
and Profile Generate’ dialog will not display Superelevation diagrams on the 
profile sheets. 

20h_5v_Profile Used for Annotation of Existing and Proposed Profile Elevations for a 20 
Scale Horizontal and 10 Scale Vertical Profile (20h_10v_Profile). 

20h_5v_SHEETS This same preference name is now also used in the Annotate Profile dialog 
box.  It was copied from and is identical to the 20h_5v Profile preference.  
This is so the ‘Profile Preference’ under the ‘Profile Controls’ tab of the ‘Plan 
and Profile Generate’ dialog will not display Superelevation diagrams on the 
profile sheets. 

50h_10v_Profile Used for Annotation of Existing and Proposed Profile Elevations for a 50 
Scale Horizontal and 10 Scale Vertical Profile (50h_10v_Profile). 

50h_10v_SHEETS This same preference name is now also used in the Annotate Profile dialog 
box.  It was copied from and is identical to the 50h_10v Profile preference.  
This is so the ‘Profile Preference’ under the ‘Profile Controls’ tab of the ‘Plan 
and Profile Generate’ dialog will not display Superelevation diagrams on the 
profile sheets. 

SUE Used for the profile annotation of SUE QL-A Test Hole data. 
 

Table 6.4 
Preference – Annotate Profile (Proposed Curve Data) 

 
Location: Geometry View Geometry  Vertical Annotation (Preferences Button) 

 

Preference Name Description 

GDOT Profiles Used for Annotation of Proposed Vertical Curve Data for all Scales. 
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7. Component and Template Creation 

This section provides a brief overview of the requirements for creating Components and 
Templates. For detailed Component and Template information please refer to Lab 7 in the Design 
Training Labs.   

 

This section covers the following topics: 
 
● Component and Template Creation Overview 
● ITL Template Library and Naming Conventions 
● GDOT Standard Components 
● GDOT Standard Point Names 
● GDOT Standard Feature Styles 
● GDOT Component Help Files 
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7.1 Component and Template Creation Overview 
The following section depicts an overview of the components and templates used to 
generate cross sections in InRoads. In order to create and utilize GDOT Components and 
Templates to GDOT standard conventions – the following information should be adhered 
and followed. 

 
 

a) The InRoads Template Library (.ITL) is where the Designer creates all the 
Components necessary to generate a complete Template such as shoulders, 
travel lanes, barriers, medians and end conditions.   
 

b) The InRoads Template Library is included in the InRoadsALL.exe file 
download. The Designer will copy the Template Library (GDOT_Standard 
V8i_SS2.itl) to the Project Directory and rename the file to PI#.itl (Ex. 
1234567.itl). 

 
c) Once the Designer modifies the PI#.itl file and creates the components and 

templates – this ITL file is always submitted as a deliverable with the project so 
that anyone who works on the project will have the Template Library that 
contains the associated project components and templates. 

 
d) There are six types of Components which can be created: Simple, Constrained, 

Unconstrained, Null Point, End Condition and Overlay/Stripping. 
 

e) The GDOT Standard ITL file contains the following Component Categories: 
Barriers, Curb and Gutter, End Conditions, Medians, Shoulders and Travel 
Lanes. 

 
f) The Designer is provided a Point Name List and Feature Styles to utilize in the 

development and/or modifications to the Components. It is important to use the 
standard GDOT Feature Styles so that Cross Section Annotation will generate 
correctly. 
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7.2 ITL Template Library and Naming Conventions 
The InRoads Template Library is included in the InRoadsALL.exe file download. The 
Designer will copy the Template Library (GDOT_Standard V8i_SS2.itl) to the Project 
Directory and rename the file to the following:  (See Table 7.1). 

 

Table 7.1 
ITL Naming Convention 

GDOT Standard ITL Rename To Example 
GDOT_Standard V8i_SS2.itl PI#.itl 1234567.itl 

 

The PI#.itl file will be project specific and will be submitted to the Earthwork Coordinator 
when the project is let to construction. It is very important for anyone who works on (or 
inherits the project) to receive the associated ITL file so that they will have access to the 
same Components and Point Names used to create the original Templates. 

 

The Designer will need to add additional Components, Templates and Point Names to the 
ITL file during the course of Project design to cover design situations that are not 
represented in the Standard GDOT Template Library. It is very important that the Designer 
use the same Feature Styles as those provided in the ITL. Component and Point Names 
may need to be added but always use one of the provided Feature Styles contained in the 
XIN file. 
 
Following is a list of the six types of components that are provided in InRoads:  

1. Simple: A Simple Component is a simple prefabricated closed rectangular shape.  This is 
useful for the quick setup of rectangular shapes like a travel lane.   

2. Constrained: A Constrained Component is placed one point at a time and can be either a 
closed or open shape. It is useful for making objects of differing shapes such as curb and 
gutter.  The points in Constrained Components can be set to behave in a particular 
manner by selection of the differing constraint options.  The default constraint is set to be 
Horizontal and Vertical to the previous point placed.  

3. Unconstrained: An Unconstrained Component is placed one point at a time, the same as 
a Constrained Component, but is placed with no constraint defaults applied.  The 
constraints of points composing both Constrained and Unconstrained Components can be 
edited after placement to apply whatever constraints the user desires. 

4. Null Point:  Null Point Components are placed unconstrained to other components and 
are typically edited to control the behavior of other points.  Null Points can be edited to 
behave as ‘Display Switches’ in order to display different components under differing 
conditions such as Type S Barrier switching between the S1, S2 or S3 variations. 

5. End Condition: End Condition Components are used to tie to a surface - typically the 
existing surface.  Cut/Fill slopes are the typical type components created with End 
Condition Components.  End Condition Components can be designed with ditches 
incorporated and that widen for guardrail when certain conditions are met. 

6. Overlay/Stripping: Components used for milling/stripping and overlay operations. 
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7.3 GDOT Standard Components 
GDOT supplies a standard Template Library (ITL) named GDOT_Standard V8i_SS2.itl. 
This Library contains the Component Categories: Barriers, Curb and Gutter, End Conditions, 
Medians, Shoulders and Travel Lanes.  The following Table lists the Categories and 
individual components provided in the GDOT_Standard V8i_SS2.itl file. (See Table 7.2). 

. 
 

Table 7.2 
GDOT Standard Components 

 
Location: GDOT_Standard V8i_SS2.itl 

 

Category Component   

Barriers 
 

• TP 7 WS, CS & RS Barrier 
• TP P1, P2 & P3 Parapet Retaining Wall(s) w/2:1/3:1/4:1 & 6:1 Back Slope 
• TP S1, S2 & S3 Median Barrier 
• TP T Guardrail – 31” w/plastic block & TP T Guardrail – 31” w/steel block 
• TP W Guardrail – 27” 
• TP W Guardrail – 31” 
• Type 2S with 2:1 Fill & Type 2S with 4:1 Fill 
• Type 6S 

Curb and Gutter 
 

• 5’ Sidewalk 
• 9032B TP 2 CURB & GUTTER 
• 9032B TP 2 DOWELED INTEGRAL CURB 
• 9032B TP 2 HEADER CURB 
• 9032B TP 7 CURB & GUTTER 
• 9032B TP 7 DOWELED INTEGRAL CURB 
• 9032B TP 7 HEADER CURB 

 
End Conditions 
 • GACUTFIL 

Medians 
 

 
• 9032B Concrete Median 4” thk MBCL 
• MedianFBD-Low 

 
Shoulders 
 

• Inside Shoulder 
• Outside Shoulder – Full Depth 
• Outside Shoulder – Partial Depth 
• Paving Under Guardrail 

 
Travel Lanes 
 

• Asphalt 
o Asphalt Lane PGL to LANE 

• Concrete 
o Concrete Lane – Inside 
o Concrete Lane – Outside Edge 
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7.4 GDOT Standard Point Names 
The GDOT_Standard V8i_SS2.itl Library contains the Component Categories: Barriers, 
Curb and Gutter, End Conditions, Medians, Shoulders and Travel Lanes.  Each of the 
Components listed in the previous Table 7.2 contain individual Component Points. The 
following Table lists the Component Points which compose each of these Components.  (See 
Table 7.3). 

. 
Table 7.3 

GDOT Component Points 
 
(Category:  Barriers) 

Point Name Point Name Description 

  GR Guardrail 
GRL Guardrail Location Insertion Point 
GS_SWITCH Glare Screen Switch Point 
IMBB Inside Median Barrier Bottom 
IMBT Inside Median Barrier Top 
LIPS Left Inside Paved Shoulder 
LMBF Left Median Barrier Face 
LMBFB Left Median Barrier Face Bottom 
LMBFT Left Median Barrier Face Top 
LMBGSB Left Median Barrier Glare Screen Bottom 
LMBGST Left Median Barrier Glare Screen Top 
LMBT Left Median Barrier Top 
LMBX Left Median Barrier "X" Point 
OMBB Outside Median Barrier Bottom 
OMBT Outside Median Barrier Top 
OPS Outside Paved Shoulder 
RIPS Right Inside Paved Shoulder 
RMBF Right Median Barrier Face 
RMBFB Right Median Barrier Face Bottom 
RMBFT Right Median Barrier Face Top 
RMBGSB Right Median Barrier Glare Screen Bottom 
RMBGST Right Median Barrier Glare Screen Top 
RMBT Right Median Barrier Top 
RMBX Right Median Barrier "X" Point 
S1 Type S1 Median Barrier 
S2 Type S2 Median Barrier 
SB6B Side Barrier Type 6 Bottom 
SB6T Side Barrier Type 6 Top 
SBB Side Barrier Back 
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SBBB Side Barrier Back Bottom 
SBBLB Side Barrier Base Left Bottom 
SBBLT Side Barrier Base Left Top 
SBBRB Side Barrier Base Right Bottom 
SBBRT Side Barrier Base Right Top 
SBFB Side Barrier Face Bottom 
SBFT Side Barrier Face Top 
SBKLB Side Barrier Key Left Bottom 
SBKLT Side Barrier Key Left Top 
SBKRB Side Barrier Key Right Bottom 
SBKRT Side Barrier Key Right Top 
SBT Side Barrier Top 
SBX Side Barrier "X" Point 

  
  
(Category:  Curb and Gutter) 

Point Name Point Name Description 

  
BSW Back of Sidewalk 
BSWB Back of Sidewalk Bottom 
FSW Front of Sidewalk 
FSWB Front of Sidewalk Bottom 
OBC Outside Back of Curb 
OBCB Outside Back of Curb Bottom 
OCFC Outside Chamfer Face of Curb 
OEP Outside Edge of Pavement 
OFC Outside Face of Curb 
OFCB Outside Face of Curb Bottom 
OGFL Outside Gutter Flow Line 

  
(Category:  End Conditions) 

Point Name Point Name Description 

  
CUT Limit of Cut 
FILL Limit of Fill 
GRL Guardrail Location Insertion Point 
IDT Inside Ditch Bottom 
ODT Outside Ditch Bottom 
OPS Outside Paved Shoulder 
OS Outside Shoulder 
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(Category:  Medians) 

Point Name Point Name Description 

  
DTCTR Ditch Center 
LMDBS Left Median Ditch Back Slope 
LMDFS Left Median Ditch Fore Slope 
LMEB Left Median Edge Bottom 
LMET Left Median Edge Top 
MBCL Median Barrier Center Line 
MBCLB Median Barrier Center Line Bottom 
RMDBS Right Median Ditch Back Slope 
RMDFS Right Median Ditch Fore Slope 
RMEB Right Median Edge Bottom 
RMET Right Median Edge Top 

  
  
(Category:  Shoulders) 

Point Name Point Name Description 

  
EIS Edge of Inside Shoulder 
EISB Edge of Inside Shoulder Bottom 
EISB Edge of Inside Shoulder Bottom 
EISBB Edge of Inside Shoulder Base Bottom 
EISGAB Edge of Inside Shoulder Graded Aggregate Base (bottom) 
EISIB Edge of Inside Shoulder Intermediate Bottom 
EOS Edge of Outside Shoulder 
IEP Inside Edge of Pavement 
IEPB Inside Edge of Pavement Bottom 
IEPBB Inside Edge of Pavement Base Bottom 
IEPGAB Inside Edge of Pavement Graded Aggregate Base (bottom) 
IEPIB Inside Edge of Pavement Intermediate Bottom 
IS Inside Shoulder 
OEP Outside Edge of Pavement 
OEPB Outside Edge of Pavement Bottom 
OEPBB Outside Edge of Pavement Base Bottom 
OEPGAB Outside Edge of Pavement Graded Aggregate Base (bottom) 
OEPIB Outside Edge of Pavement Intermediate Bottom 
OPS Outside Paved Shoulder 
OPSB Outside Paved Shoulder Bottom 
OPSBB Outside Paved Shoulder Base Bottom 
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OPSGAB Outside Paved Shoulder Graded Aggregate Base (bottom) 
OPSIB Outside Paved Shoulder Intermediate Bottom 
OS Outside Shoulder 
OSB Outside Shoulder Bottom 
OSIB Outside Shoulder Intermediate Bottom 

  
  
(Category:  Travel Lanes) 

Point Name Point Name Description 

  
IEP Inside Edge of Pavement 
IEPB Inside Edge of Pavement Bottom 
IEPGAB Inside Edge of Pavement Graded Aggregate Base (bottom) 
IEPIB Inside Edge of Pavement Intermediate Bottom 
LANE Lane 
LANEB Lane Bottom 
LANEBB Lane Base Bottom 
LANEGAB Lane Graded Aggregate Base (bottom) 
LANEIB Lane Intermediate Bottom 
OEP Outside Edge of Pavement 
OEPB Outside Edge of Pavement Bottom 
OEPGAB Outside Edge of Pavement Graded Aggregate Base (bottom) 
OEPI Outside Edge of Pavement Intermediate 
OEPIB Outside Edge of Pavement Intermediate Bottom 
PGL Profile Grade Line 
PGLB Profile Grade Line Bottom 
PGLBB Profile Grade Line Base Bottom 
PGLGAB Profile Grade Line Aggregate Base (bottom) 
PGLIB Profile Grade Line Intermediate Bottom 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



Component and Template Creation  InRoads Design Guidelines SS2 

7-10 
 

7.5 GDOT Standard Feature Styles 
The GDOT_Standard V8i_SS2.itl Library references the GDOT XIN file in order to apply 
the Feature Styles for the Components and the Component Points. It is very important that 
the Designer use the same Feature Styles as that provided in the ITL. Component and Point 
Names may need to be added but always use the provided Feature Styles contained in the 
XIN file in order to annotate cross-sections to GDOT Standards. The following Table lists 
the Feature Styles which compose each of these Components and Component Points.  (See 
Table 7.4). 
 

Table 7.4 
GDOT Feature Styles for Components and Component Points 

  Feature Style Name Feature Style Description 
DRNG_P_Ditch Ditch - Drainage 
LIMT_P_CUT Cut Limits (Assign to End Condition Components) 
LIMT_P_CUT_Const-Limit Cut Limits (Assign to LAST Point in the End Condition) 
LIMT_P_FILL Fill Limits (Assign to End Condition Components) 
LIMT_P_FILL_Const-Limit Fill Limits (Assign to LAST Point in the End Condition) 
MAIN_P_Barrier-Median-Side Proposed median or side barrier 
MAIN_P_Barrier-Noise-Wall Proposed noise barrier wall 
MAIN_P_Barrier-Retain-Wall Propose retaining wall 
MAIN_P_Barrier_PAY_4940_TP20 4940 TP20 CONCRETE BARRIER 
MAIN_P_Barrier_PAY_4940_TP21 4940TP21 CONCRETE BARRIER 
MAIN_P_Barrier_PAY_4940_TP22 4940 TP22 CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S1 TP S1 SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S2 TP S2 SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S3 TP S3 SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S3A TP S3A SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_PAY_TP_S3B TP S3B SPECIAL DESIGN CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-S TP 2-S SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-SA TP 2-SA SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-SB TP 2-SB SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_2-SC TP 2-SC SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-S TP 6-S SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-SA TP 6-SA SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-SB TP 6-SB SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_6-SC TP 6-SC SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_7-CS TP 7-CS or 7-RS SIDE CONCRETE BARRIER 
MAIN_P_Barrier_Side_PAY_TP_7-WS TP 7-WS SIDE CONCRETE BARRIER 
MAIN_P_CONSTCL Proposed Construction centerline 
MAIN_P_CROWN Crown Point 
MAIN_P_Curb Proposed Curb 
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MAIN_P_Curb_PAY_9032B Dowel TP2 9032B TP2 CONC DOWELED INTEGRAL CURBS 6" THK 
MAIN_P_Curb_PAY_9032B Dowel TP3 9032B TP3 CONC DOWELED INTEGRAL CURBS 8" THK 
MAIN_P_Curb_PAY_9032B Dowel TP7 9032B TP7 CONC DOWELED INTEGRAL CURBS 6" THK 
MAIN_P_Curb_PAY_9032B HeaderTP1 9032B TP1 4"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP2 9032B TP2 6"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP3 9032B TP3 8"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP4 9032B TP4 10"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP6 9032B TP6 6"HEADER CURB 
MAIN_P_Curb_PAY_9032B HeaderTP7 9032B TP6 7"HEADER CURB 
MAIN_P_Curb_PAY_9032B REdge 6" 9032B 6" RAISED EDGE WITH CONCRETE GUTTER 
MAIN_P_Curb_PAY_9032B REdge 8" 9032B 8" RAISED EDGE WITH CONCRETE GUTTER 
MAIN_P_Curb_PAY_9032B TP1 6" 9032B TP1 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP1 8" 9032B TP1 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP2 6" 9032B TP2 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP2 8" 9032B TP2 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP3 6" 9032B TP3 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP3 8" 9032B TP3 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP4 6" 9032B TP4 30" CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP4 8" 9032B TP4 30" CURB & GUTTER 8"THK 
MAIN_P_Curb_PAY_9032B TP7 6" 9032B TP7 CURB & GUTTER 6"THK 
MAIN_P_Curb_PAY_9032B TP7 8" 9032B TP7 CURB & GUTTER 8"THK 
MAIN_P_Driveway Driveway 
MAIN_P_EEOP Exist Pavement Edge 
MAIN_P_EOP Proposed Road Edge of Pavement 
MAIN_P_EPSHLDR Proposed edge of paved shoulder 
MAIN_P_GoreMainIdeal Vertical Gore Design Tool - GoreMainIdeal 
MAIN_P_GoreMax Vertical Gore Design Tool - GoreMax 
MAIN_P_GoreMin Vertical Gore Design Tool - GoreMin 
MAIN_P_GoreRampIdeal Vertical Gore Design tool - GoreRampIdeal 
MAIN_P_Guardrail Proposed guardrail 
MAIN_P_Lane Lane Lines 
MAIN_P_Median_PAY_9032B_4"THK 9032b CONCRETE MEDIAN 4"THK PAY ITEM 
Main_P_Misc-Const-Feat Proposed misc. construction feature 
MAIN_P_SHLDR Proposed Shoulder lines 
MAIN_P_Sidewalk Proposed Sidewalk 
MAIN_P_Slope-break Slope break point 
REQD_P_DWESMT Required Driveway Easement 
REQD_REQD Required Right of Way   
REQD_P_RWRM Required Right of Way Marker 
REQD_P_TESMT Required Temporary Easement 
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7.6 GDOT Component Help Files 
Help Files have been created for each of the GDOT Components. These Help Files are 
included in the InRoadsALL.exe executable. When InRoadsALL.exe is downloaded and 
installed – Help Files are downloaded to the following location: 
 

C:\InRoads Data\Component Documentation 
 GDOT Component Description Help Documentation 

 
These Help Files provide detailed information regarding the composition of the Component, 
the Default Parameters, Graphic representation and the Component Points/Feature Styles 
which are utilized in the Component.  
 
When inserting the Components in the Create Template dialog, the user may access the 
Component Help Files to assist in the design of the templates. Following is information on 
how to access the Component Help Files from the Create Template dialog. 

 
 In the Create Template dialog - Right mouse click over the component ‘GACUTFIL’ 

and select Template Documentation Link… as shown here. 
 

                           
 
 In the Template Documentation Link dialog - click the Locate button.  

 

           
 
 Navigate to C:\InRoads Data\Component Documentation 
 Select a PDF Help File and click Open. 
 In the Template Documentation Link dialog - click Open Link. 
 Close the Component Description PDF File when finished. 
 Click Close to close the Template Documentation Link dialog. 
 
NOTE: Once a Component Description is opened from the Template Documentation Link 

dialog – its path is permanently stored in memory. 

Locate Button 



 

  
 
 

        8  
Roadway Designer  
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8. Roadway Designer 

This section provides a brief overview of the requirements for using the Roadway Designer to 
create an IRD (Roadway Design File), add Corridors, add Superelevation and create Final Design 
Surfaces in InRoads. For detailed Roadway Designer information please refer to Lab 8 in the 
Design Training Labs.   

 

This section covers the following topics: 
 
● Roadway Designer Overview 
● Roadway Designer Workflow 
● IRD (Roadway Design) Naming Conventions 
● Corridor Naming Conventions 
● Superelevation Process Workflow 
● Design Surface Naming Conventions/Preference 
● Bogus Surface Naming Conventions for Target Aliasing   
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8.1 Roadway Designer Overview 
The following section depicts an overview of the Roadway Designer processes used to 
generate cross sections in InRoads. In order to create an IRD, corridors and Final Design 
Surfaces to GDOT standard conventions – the following information should be adhered and 
followed.  

 
a) In order to generate cross sections – an IRD file, a Corridor and a Finished 

Design Surface must be created. The cross sections are then cut from the 
Finished Design Surface. 
 

b) The InRoads Roadway Design file (.IRD) should be named PI#.ird (Ex. 
1234567.ird). If there is a need for more IRD files (such as for alternate design 
situations) - the IRD file should be named PI#A.ird, PI#B.ird, etc. (Ex. 
1234567A.ird, 1234567B.ird). 
 

c) The Corridor will be named the Roadway Name or the Alignment Name. (Ex. 
SR100 SPUR or DE31) based on the Designer’s preference. 

 
d) Superelevation in InRoads is created by adding Vertical Point Controls. This is 

accomplished by utilizing the Superelevation Wizard. 
 

e) Superelevation tables (.SUP) are utilized to calculate the Super required and the 
% Total on Tangent utilized is 2/3 (67%). 

 
f) The Superelevation tables are located in the following path:  

C:\Program Files\Bentley\InRoads Group V8.11\data\AASHTO 2004\imperial 
 

g) The Finished Design Surface will be named the PI#_Corridor Name (Ex. 
1234567_SR100 SPUR or 1234567_DE31). 

 
h) The Preference used for the Finished Design Surface will be FINISH. 

 
i) If an end condition fails to solve because there is no Existing Ground Surface 

(an obscured area) to intersect – the Designer is instructed to contact the Office 
of Design Policy and Support/Location Bureau to request additional DTM 
Coverage in that area. 

 
j) In order to place a temporary Template so that the Station at the obscured area 

can close – Target Aliasing is utilized. Target Aliasing consists of creating a 
Bogus Surface in order to cut a Cross Section to form a closed area. 

 
k) The Naming Convention for the Bogus Surface used in Target Aliasing is 

PI#_Bogus1 (Ex. 1234567_Bogus1). 
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8.2 Roadway Designer Workflow 
The Roadway Designer is located under the InRoads Modeler menu and is where Roadway 
Design Files (.IRD’s), Corridors, Template Drops, Point Controls, End Condition 
Exceptions, Superelevation and Final Surfaces are performed, assigned, created, etc.  

 
            Following is the workflow and terminology of the Roadway Designer: 
 

Step 1. Create a Roadway Design File – The Roadway Design File (.IRD) is where 
Corridors are created, Templates are added to Corridors, Point 
Controls and End Condition Exceptions are added and Design 
Surfaces are created. 

Step 2. Create a Corridor – A Corridor is a strip of land defined by a horizontal and 
vertical alignment or alignments.  It can be considered the 
project’s footprint.  Cross section design is performed in the 
Corridor and the Final Surface is created from the corridor. 

Step 3. Add Template Drops – Template Drops are used to add Templates from the .ITL 
(InRoads Template Library) to specified station ranges in the 
Corridor. 

Step 4. Add Point Controls – Point Controls are used in cross section design to override 
a point’s normal constraint.  Example uses of Point Controls in a 
cross section design would be to have the point representing the 
outside edge of a travel lane, follow a horizontal alignment to 
widen for an auxiliary lane (such as a turn lane) or having a point 
follow a different vertical alignment for split grades. 

Step 5. Add End Condition Exceptions – End Condition Exceptions are applied to End 
Conditions during cross section design when the normal behavior 
of an End Condition is not sufficient for actual conditions and it is 
not desirable to create and place new templates.  Examples 
include steepening slopes to stay inside Right-of-Way and 
additional shoulder widening for guardrail anchorage. 

Step 6. Add Superelevation – Superelevation Control Lines are added to control the  
 Roadway cross slope in horizontal curve areas. InRoads utilizes   
 Superelevation Tables based on the AASHTO 2011 Green Book. 

Step 7. Create Final Surface –   The creation of a Final Surface DTM is necessary in 
InRoads.  The cross sections shown on the cross section sheets are 
generated from the Final Surface. The Construction Limits and 
the Roadway Ditches are also generated from the Final Surface. 
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8.3 IRD (Roadway Design) Naming Conventions 
The Roadway Design File (.IRD) is where Corridors are created, Templates are added to 
Corridors, Point Controls and End Condition Exceptions are added and Design Surfaces are 
created.  The IRD File (and any alternate design IRD File Names) will be named according 
to the PI Number.  (See Table 8.1). 
 

 
Table 8.1 

Standard IRD (Roadway Design) File Names 
 

IRD and Alternate Design IRD Name(s) Example 
PI#.ird 1234567.ird 

PI#A.ird 1234567A.ird (Alternate Design A) 

PI#B.ird 1234567B.ird (Alternate Design B) 
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8.4 Corridor Naming Conventions 
A Corridor is a strip of land defined by a horizontal and vertical alignment or alignments.  
It can be considered the project’s footprint.  Cross section design is performed in the 
Corridor and the Final Surface is created from the corridor. The Corridor will be named the 
Roadway Name or the Alignment Name based on the Designer’s preference. 
 (See Table 8.2). 

 
 

Table 8.2 
Standard Corridor Name 

(Roadway or Alignment Name) 
 

Roadway or Alignment Name Example:  SR100 Spur (or) DE31 
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8.5 Superelevation Process Workflow 
Superelevation Control Lines are added to control the Roadway cross slope in horizontal 
curve areas. InRoads utilizes Superelevation Tables based on the AASHTO 2004 Green 
Book. 
 
Superelevation in InRoads is created by the addition of Vertical Point Controls with a 
Superelevation control type.  The addition of Superelevation Point Controls is facilitated by 
the use of the Superelevation Wizard and is performed after a corridor is created and 
templates are dropped.  Once Superelevation has been added to the corridor by the 
Superelevation Wizard, the Superelevation Display is used to resolve Superelevation 
overlaps and to make any necessary edits to the Superelevation.  After the Superelevation 
Wizard is used to add Superelevation to the Corridor, the Superelevation Display is used to 
resolve Superelevation overlaps and to edit the Superelevation through an intersection.  
 
Following is the Superelevation Process Workflow: 
 

1. The Superelevation Table Wizard is used to select the Superelevation Table (Design 
Speed and Superelevation Rate), % Runoff on Tangent, Horizontal Curve Sets, etc. The 
Table Wizard is accessed through the following:  In InRoads select Modeler ► 
Roadway Designer ►Superelevation ► Create Superelevation Wizard ► Table. 
 

2. The Superelevation Sections Definitions window is where the Crown Point or rotational 
point of the Template and the Left and Right Range Points are added.  The Profile Grade 
Point (PGL) is commonly chosen as the crown point of the Template but does not have to 
be.  Range Points are points on the Template chosen to identify the extents to which the 
Superelevation is to be applied along the Template.  Range Points are almost always 
picked at the outside edge of the travel lanes whereas the shoulder points are controlled by 
Shoulder Rollover Locks.   The Superelevation Sections Definitions is accessed by 
clicking the Next > button in the Table Wizard dialog. 
 

3. If there are any Superelevation Overlaps – the Fix Superelevation Overlap dialog appears 
only when Superelevation Conflicts are detected in the Superelevation Calculations.  If 
overlaps occur – the Designer will need to resolve the overlaps before proceeding.   
 

4. A Superelevation Report can be generated using a Style Sheet named GDOT 
Superelevation Data Report.xsl.  The Style Sheet is accessed by selecting the following 
command:  Modeler   Roadway Designer   Superelevation  Superelevation 
Report. The Superelevation Data Report opens in the Bentley Civil Report Browser and 
can be saved as an HTML file. 
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8.6 Design Surface Naming Conventions/Preference 
The creation of a Final Design Surface DTM is necessary in InRoads.  The cross sections 
shown on the cross section sheets are generated from the Final Design Surface. The 
Construction Limits and the Roadway Ditches are also generated from the Final Design 
Surface. The Design Surface will be named the PI#_Corridor Name (which can be either 
the Roadway Name or the Alignment Name based on the Designer’s preference).  
(See Table 8.3 and 8.4). 

 
 

Table 8.3 
Standard Design Surface Name 
(Roadway or Alignment Name) 

 
PI#_Corridor Name Example:  1234567_SR100 SPUR (or) 1234567_DE31 

 
 
 

Table 8.4 
Preference – Final Design Surface Preference 

 
Location: Modeler Roadway Designer  Corridor  Create Surface (Preferences Button) 

 

Preference Name Description 

FINISH Displays the FINISH Surface to GDOT Standard Feature Styles/Symbology. 
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8.7 Bogus Surface Naming Conventions for Target Aliasing 
When a Template’s End Condition encounters an obscured area or extends beyond the 
available Existing Surface, the End Condition fails to solve and is not placed.  InRoads 
does not extend the existing ground in order to finish the placement of the Template as 
CAiCE users are accustomed to experiencing.  When these situations are encountered, the 
Designer is instructed to request additional DTM coverage from the Office of Design 
Policy and Support/Location Bureau.  The Location Bureau will provide a new DTM to the 
Designer with the additional coverage.  Often obscured areas cannot be accurately 
surveyed; such is the case with bodies of water or swampy areas. In order to place a 
Template through these types of areas and have it solve so that construction limits may be 
computed -- a ‘Bogus Surface’ must be created.   Target Aliasing may then be used with 
the ‘Bogus Surface’.   
 
The creation of a Bogus Design Surface DTM is necessary in InRoads if there are obscured 
areas in which cross-sections cannot form a closed area for earthwork calculations.  These 
cross sections shown on the cross section sheets are generated from the Final Design 
Surface and Bogus Surface.   The Naming Convention for the Bogus Surface used in 
Target Aliasing is PI#_Bogus1.dtm (Ex. 1234567_Bogus1.dtm).  (See Table 8.5). 

 
 

Table 8.5 
Standard Bogus Surface for Target Aliasing 

 

PI#_Bogus1.dtm Example:  1234567_Bogus1.dtm 
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9. Cross Section Sheets/Annotation Generation 

This section provides a brief overview of the requirements for generating and annotating Cross 
Section Sheets. For detailed Cross Section Sheet Generation and Annotation information please 
refer to Lab 9 in the Design Training Labs.   

This section covers the following topics: 
 
● Cross Section Sheets/Annotation Overview 
● Finished Design Surface (.DTM) Preference 
● Cross Section Sheet Scale Factor 
● Cross Section Sheet Preferences 
● Cross Section Sheet Annotation Preferences 
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9.1 Cross Section Sheets/Annotation Overview 
The following section depicts an overview of the processes to create Cross Section Sheets 
and annotation of the Cross Sections to GDOT standards in InRoads. In order to generate 
and annotate Cross Sections – the following information should be adhered and followed.  

 
a) In order to generate cross sections – a minimum of an Existing Ground Surface 

.DTM and a Final Design Surface .DTM must exist. The cross sections are 
then cut from the Finished Design Surface. 

 
b) The Cross Section sets are generated using InRoads but are saved and viewed in 

the MicroStation DGN file. The Cross Sections are not saved in InRoads as 
independent Cross Section sets which can be viewed after closing the 
MicroStation File. They must be regenerated from InRoads if changes or 
alterations are required in the cross-section design. New cross section sets must 
be cut and viewed as sheets in MicroStation. 
 

c) The Cross Section “Cut Sheets” use cells for the grids and border instead of 
DGN Reference Files. 

 
d) The Global Scale Factor in InRoads (for Text, Cell and Line Style) must be 

changed from 50 Scale to 10 Scale in order to generate the Cross Sections at the 
correct viewing Scale. 

 
e) The Set Name for Cross Sections defaults to the current Active Alignment 

name. 
 

f) There are four Preferences available for creating Cross Sections: 10 Scale Work 
Sec 1x Vert Exg, 50 Scale Work Sec 2x Vert Exg, Narrow 10h 10v and Wide 
10h 10v. 

 
g) The Annotation of Cross Sections is a multi-step process to annotate the Profile 

Grade Elevations, Ditch Elevations, Slopes, Station/Offsets, etc. 
 

h) Before annotating Cross Sections – the Lock for Pencil/Pen MUST be set to 
Pen in order to create permanent annotation of Cross Sections. 

 
i) Several Preferences have been set up to make the annotation process of Cross 

Sections easier. A multi-step process is required to annotate the Cross Sections 
to GDOT standards. 

 
j) It is very important that the standard GDOT Styles are used in the Roadway 

Design File (IRD). If the standard GDOT Styles are not used – the Cross 
Sections may not annotate correctly. 
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9.2 Finished Design Surface (.DTM) Preference 
In order to generate Cross Sections to GDOT Standards – a Finished Design Surface (.DTM) 
must first be created.  The Finished Design Surface Preference should be loaded before 
creating the DTM. This Preference sets the viewing/creation of the Finished Design Surface 
and ensures that the correct DTM Settings are initiated and that the symbology and levels are 
set before cutting the Cross Sections. The Preference of FINISH must be selected in order for 
the DTM to view and generate correctly.  (See Table 9.1). 
 

 
Table 9.1 

Preference – Create Surface 
 

Location: Modeler Roadway Designer  Corridor   Create Surface  (Preferences Button) 
 

Preference Name Description 

FINISH The Preference used for Finished DTM Surfaces. This Preference sets the 
options in the Create Surface dialog to generate Design Surfaces to GDOT 
Standards. The Preference creates the Surface on Level FCON_P_Surface 
Triangles-Line and Color 9 (Grey). 
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9.3 Cross Section Sheet Scale Factor 
The generation of Cross Section Sheets is accomplished by using the Create Cross Section 
command in InRoads. This command uses DGN Cross Section Cells (Narrow and Wide) to 
generate the cut Cross Section Sheet borders and grids. For detailed Cross Section Sheet 
Generation information please refer to Lab 9 in the Design Training Labs.  The following 
table lists the Global Scale Factors for generating Cross Sections. (See Table 9.2). 

 
In order to generate Cross Sections to GDOT Standards - the Global Scale Factors must be 
changed from a 50 Scale to a 10 Scale for Cross Sections to view on the Grids correctly and 
for the annotation text to view at the correct text size.    
 

 
Table 9.2 

Global Scale Factor Settings 
 

(Change Settings from 50 Scale/20 Scale to 10 Scale) 
 

                                             Location: Tools Global Scale Factors 
 

 

Global Scale Factor Type Scale Factor 
Text  10.0000 

Cell 10.0000 

Line Style 10.0000 
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9.4 Cross Section Sheet Preferences 
The generation of Cross Section Sheets is accomplished by using the Cross Section 
command in InRoads. This command contains Preferences which have been set up in order 
to create the cut Cross Section Sheets to GDOT Standards. In order to generate/view Cross 
Sections to GDOT Standards – Preferences must be set. These Preferences set the 
viewing/creation of Cross Sections when using the Evaluation  Cross Section   Cross 
Sections  Create Cross Section folder. (See Table 9.3). 

 
 

Table 9.3 
Preference – Create Cross Section 

 
Location: Evaluation Cross Section  Cross Sections Create Cross Section folder (Preferences Button) 

 

Preference Name Description 

10 Scale Work Sec 1x Vert Exg Used for Earthwork Volumes generation. This Preference uses the built in 
InRoads grid for viewing cross sections so that the entire cross section is 
drawn at each station for accurate earthwork volume calculations.  The 
Preference loads settings for a 10 Scale Horizontal with a 1X Vertical 
Exaggeration. 

50 Scale Work Sec 2x Vert Exg Used for Earthwork Volumes generation. This Preference uses the built in 
InRoads grid for viewing cross sections so that the entire cross section is 
drawn at each station for accurate earthwork volume calculations.  The 
Preference loads settings for a 50 Scale Horizontal with a 2X Vertical 
Exaggeration. 

Narrow 10h 10v Used for Plans Production of Cross Section “Narrow” Sheet generation.  This 
Preference loads the settings into the Cross Sections dialog to view Cross 
Sections in a Narrow format on the GDOT SUXSEN Cross Section plan sheet 
cell.  The Preference loads settings for a 10 Scale Horizontal and 10 Scale 
Vertical (Narrow 10h 10v). 

Wide 10h 10v Used for Plans Production of Cross Section “Wide” Sheet generation.  This 
Preference loads the settings into the Cross Sections dialog to view Cross 
Sections in a Wide format on the GDOT SUXSEW Cross Section plan sheet 
cell.  The Preference loads settings for a 10 Scale Horizontal and 10 Scale 
Vertical (Wide 10h 10v). 
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9.5 Cross Section Sheet Annotation Preferences 
The generation of Cross Section Sheets also consists of annotating the Cross Sections to 
include text for slopes, station/offset, ditch elevations, etc. This is accomplished by using the 
Annotate Cross Section command in InRoads. This command contains Preferences which 
have been set up in order to annotate Cross Section Sheets to GDOT Standards. These 
Preferences set the text annotation of Cross Sections when using the Evaluation  Cross 
Section   Cross Sections  Annotate Cross Section folder. (See Table 9.4). 

 
 

Table 9.4 
Preference – Annotate Cross Section 

 
Location: Evaluation Cross Section  Cross Sections  Annotate Cross Section folder (Preferences Button) 

 

Preference Name Description 

XSEC TEXT – CL EL. GROUND Used for annotating the existing ground elevation on the Cross Sections 
at the centerline alignment. 

XSEC TEXT – EL. DIAGONAL Used for the annotation of proposed elevations in which the text must be 
viewed diagonally. (i.e. Roadway Profile.) 

XSEC TEXT – EL. HORIZONTAL Used for the annotation of proposed elevations in which the text must be 
viewed horizontally.  (i.e. Roadway Ditches.) 

XSEC TEXT – EL. VERTICAL Used for the annotation of proposed elevations in which the text must be 
viewed vertically. 

XSEC TEXT - OFFSET Used for the annotation of offset distances as measured from the 
centerline.  (i.e. Slopestakes/Construction Limits.) 

XSEC TEXT – OFFSET/EL. VERTICAL Used for the annotation of offset distances as measured from the 
centerline.  The elevation at the offset is also placed.  This form of 
annotation is not required on the final cross section plans.  It is provided 
to be used ‘as desired’ during the design process. 

XSEC TEXT – SLOPES % Used for the annotation of slopes that require a percentage be used 
rather than a ratio (i.e. pavement cross slopes). 

XSEC TEXT – SLOPES x:y Used for the annotation of slopes that require a ratio be used rather than 
a percentage (i.e. ditch slopes, front slopes, back slopes, etc.). 

XSEC TEXT – SUE Used for the cross section annotation of SUE QL-A Test Hole data. 
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10. Construction Limits 

This section provides a brief overview of the requirements and processes for creating/viewing 
Construction Limits, Roadway Ditches and Ditch Flow Arrows. For detailed Construction Limits 
information please refer to Lab 10 in the Design Training Labs.   

This section covers the following topics: 
 
● Construction Limits, Ditches and Ditch Flow Arrows Overview 
● Construction Limits Feature Styles 
● Roadway Ditches Feature Style 
● Ditch Flow Arrow Preference 
● Ditch Flow Arrow Annotate Feature Style 
● Construction Limits DGN and Ditches/Ditch Flow Arrows DGN  
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10.1 Construction Limits, Ditches and Ditch Flow Arrows Overview 
The following section depicts an overview of the processes to create/view Construction 
Limits, Ditches and annotate Ditch Flow Arrows to GDOT standards in InRoads. In order to 
generate/annotate Construction Limits and Roadway Ditches – the following information 
should be adhered and followed.  

 
a) In order to generate/view Construction Limits – a Finished Design Surface must 

exist. The Final Surface is generated in the Roadway Designer from the 
Roadway Design File (.IRD). 
 

b) The Final Design Surface must be the Active Surface in order to depict the 
Construction Limits. 

 
c) The following Feature Styles representing Features from the Design Surface 

should be selected for viewing in order to create the Construction Limits:  
LIMT_P_FILL_Const-Limit and LIMT_P_CUT_Const-Limit. There may be 
several Features with these Feature Styles. 

 
d) The CUT Construction Limits will be depicted as  ByLevel Linestyle of Blue 

containing the “C” Cell Symbol.  The FILL Construction Limits will be 
depicted as ByLevel Linestyle of Yellow containing the “F” Cell Symbol.   

 
e) After viewing the Construction Limits – the DGN file will be saved as the 

PI#LIMT.dgn (Ex. 1234567LIMT.dgn). 
 

f) In order to generate/view Ditches and Ditch Flow Arrows – a Finished Design 
Surface must exist. The Final Surface is generated in the Roadway Designer 
from the Roadway Design File (.IRD). 

 
g) The Final Design Surface must be the Active Surface in order to depict the 

Ditches and Ditch Flow Arrows. 
 

h) The following Feature Style representing Features from the Design Surface 
should be selected for viewing in order to view the Roadway Ditches:  
DRNG_P_Ditch. There may be several Features with this Feature Style. 

 
i) In order to annotate the Ditch Flow Arrows – the Preference named Ditch Flow 

Arrows should be selected. 
 

j) The following Feature Style representing Features from the Design Surface 
should be selected for viewing in order to view the Ditch Flow Arrow Cell:  
DRNG_P_Ditch. There may be several Features with this Feature Style. 

 
k) After viewing the Ditches and Ditch Flow Arrow cells – the DGN file will be 

saved as the PI#DRNG.dgn (Ex. 1234567DRNG.dgn). 
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10.2 Construction Limits Feature Styles 
The Construction Limits consist of MicroStation ByLevel Symbology of Linestyle color 
Blue containing the “C” cell for Cut Limits and the ByLevel Symbology of Linestyle color 
Yellow containing the “F” cell for Fill Limits.  In order to generate Construction Limits to 
GDOT Standards – the Surface Features representing the Construction Limits must be 
selected and viewed.  The following table lists the Surface Feature Styles to select for the 
viewing of Construction Limits.  (See Table 10.1). 
 

 
Table 10.1 

Feature Styles – Construction Limits 
 

Note: There may be several Features which contain these Feature Styles. 
 

Location: Surface View Surface  Features  
 

Feature Style Description 

LIMT_P_FILL_Const-Limit 
 

The Feature Style used to represent the FILL Limits in the MicroStation DGN 
File.  The Feature Style is placed on ByLevel  LIMT_P_STKFIL_Const-Limit-Fill-
Line. 

LIMT_P_CUT_Const-Limit 
 

The Feature Style used to represent the CUT Limits in the MicroStation DGN 
File. The Feature Style is placed on ByLevel  LIMT_P_STKCUT_Const-Limit-
Cut-Line. 
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10.3 Roadway Ditches Feature Style 
The Roadway Ditches Feature Style in the Final Design Surface must be selected and viewed 
in order to depict the Roadway Ditches to GDOT Standards. The ByLevel setting for the 
Roadway Ditches are depicted with a Symbology of Yellow. The following table lists the 
Surface Feature Style to select for the viewing of Roadway Ditches.  (See Table 10.2). 

 
 

Table 10.2 
Feature Style – Roadway Ditches 

 
Note: There may be several Features which contain this Feature Style. 

 
Location: Surface View Surface  Features  

 

Feature Style Description 

DRNG_P_Ditch 
 

The Feature Style used to represent the Roadway Ditch – Drainage. The 
Feature Style is placed on ByLevel  DRNG_P_Ditch-and-Channel-Line. 
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10.4 Ditch Flow Arrow Preference 
In order to depict the Ditch Flow Arrows on the Roadway Ditches – a Preference is required 
which sets the viewing/creation of the Arrows. When the Preference is loaded - the 
MicroStation cell “Ditch Flow Arrow” is selected. The following table lists the Preference 
and Cell to select for the viewing of Roadway Ditches.  (See Table 10.3). 
 

 
Table 10.3 

Preference – Ditch Flow Arrow 
 

Location: Surface View Surface  Annotate Feature  (Preferences Button) 
 

Preference Name Description 

Ditch Flow Arrows Populates the selections in the Annotate Feature dialog so that that Ditch 
Flow Arrows are viewed to GDOT Standards. A Cell named Ditch Flow Arrow 
represents the direction and flow of the Roadway Ditch Drainage. 
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10.5 Ditch Flow Arrow Annotate Feature Style 
Even though the “Ditch Flow Arrows” Preference is loaded – the Feature Style of 
DRNG_P_Ditch must still be selected in order to annotate the Ditch Flow Arrow Cell to 
GDOT Standards. The following table lists the Surface Feature Style to select for the viewing 
of Ditch Flow Arrows.  (See Table 10.4). 

 
 

Table 10.4 
Feature Style – Ditch Flow Arrows 

 
Note: There may be several Features which contain this Feature Style. 

 
Location: Surface View Surface  Features  

 

Feature Style Description 

DRNG_P_Ditch 
 

The Feature Style used to represent the Ditch Flow Arrows annotation for 
Drainage Flow directions.   
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10.6 Construction Limits DGN and Ditches/Ditch Flow Arrows DGN 
After viewing the Construction Limits and the Ditches/Ditch Flow Arrows – MicroStation 
DGN files should be created to graphically represent the Features. For detailed instructions 
on how to create the applicable DGN Files – see Lab 10 in the Design Training Labs. The 
following table lists the standard naming conventions of the two DGN Files which are to be 
generated.  (See Table 10.5). 

 
 

Table 10.5 
DGN Files – Construction Limits and Roadway Ditches/Ditch Flow Arrows 

 
 

Location: In MicroStation – File Save As  
 

DGN File Name Example 

PI#LIMT.dgn 1234567LIMT.dgn   
PI#DRNG.dgn 1234567DRNG.dgn   
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11. Earthwork 

This section provides a brief overview of the requirements and processes for generating Earthwork 
Quantities and Earthwork Volume Reports. For detailed Earthwork information please refer to Lab 
11 in the Design Training Labs.   

This section covers the following topics: 
 
● Earthwork Overview 
● MicroStation – View Attributes Setting 
● Cross Section Preferences 
● GDOT Earthwork Volumes Preference 
● GDOT Earthwork Volume Report  
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11.1 Earthwork Overview 
The following section depicts an overview of the processes to generate Earthwork 
Quantities and Earthwork Volume Reports to GDOT Standards in InRoads. In order to 
generate these Quantities and Volume Reports – the following information should be 
adhered and followed.  

 
a) In order to generate Earthwork Quantities and Volume Reports – Cross Section 

Sets must be created. The Earthwork Volumes are actually generated from the 
Cross Sections drawn in MicroStation; therefore, a Cross Section Set must first 
be drawn in MicroStation in order to calculate quantities. 
 

a) In MicroStation – the View Attributes of “Fill” must be selected and turned on 
in order for the Volumes to view the Cut/Fill areas in the appropriate Fill or Cut 
shaded color. 

 
b) The Preference of 50 Scale Work Sec 2x Vert Exg or the 10 Scale Work Sec 1x 

Vert Exg uses the built in InRoads grid for viewing the Cross Sections rather 
than the GDOT Cross Section plan sheet cell. When viewing Cross Section Sets 
for Earthwork calculations and volumes – one of the above listed Preferences 
should be used. The other GDOT Cross Section Preferences should be used 
only for Plans Production generation. 

 
c) The Existing and the Proposed Surfaces should be selected when creating the 

Cross Section Sets in order to obtain a closed area for Volume calculations. 
 

d) The Preference of GDOT Earthwork Volumes should be selected (before the 
calculation of volumes) in order to generate an End-Area Volumes Report to 
GDOT Standards. 

 
e) In order to generate/view the Earthwork Volumes Report - a Style Sheet named 

GDOT Earthwork Volumes.xsl should be selected.  The Style Sheet is 
accessed by selecting the following command:  Evaluation  Cross Section  
Cross Sections  End-Area Volumes folder.  Click the Preferences button 
and load the GDOT Earthwork Volumes Preference. After clicking Apply – the 
Bentley Civil Report Browser opens. Select the Style Sheet named GDOT 
Earthwork Volumes.xsl.  The Style Sheet can be saved as an HTML file. 

 
f) Make sure that each Cross Section at each applicable Station forms a closed 

area. If the areas do not close – the volume calculations will be inaccurate. This 
is especially the case if there are obscured areas. The Designer is reminded to 
contact the Office of Design Policy and Support/Location Bureau for any 
additional survey required in the obscured areas.  If these areas are not resolved 
– inaccurate volume calculations will result.   
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11.2 MicroStation – View Attributes Setting 
After creating the Cross Section Sets- the Cut and Fill shaded areas should be viewed in 
MicroStation to ensure that each Station’s Cross Sections form a closed area. All Cut Areas 
should be filled as Green and all Fill Areas should be filled as Blue. This will help to ensure 
that Volumes are being calculated correctly. The following table lists the Location in 
MicroStation to turn on the Fill View Attribute Setting.  (See Table 11.1). 

 
Table 11.1 

MicroStation – Fill – View Attribute Setting 
 

MicroStation Location: Settings  View Attributes 
 

                                   The Fill Attribute should be highlighted in Orange as shown on the left. 
 

 

Volume Shaded Color 

CUT 
 

Shaded Green Fill 

FILL 
 

Shaded Blue Fill 
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11.3 Cross Section Preferences 
The generation of Cross Section Sheets is accomplished by using the Create Cross Section 
command in InRoads. This command contains Preferences which have been set up in order 
to create the cut Cross Section Sheets to GDOT Standards. In order to generate/view Cross 
Sections to GDOT Standards for Earthwork Volumes – Preferences must be set. Preferences 
set the viewing/creation of Cross Sections when using the Evaluation  Cross Section  
Cross Sections  Create Cross Section folder. Although there are additional Preferences 
available – only the first two Preferences listed in the following table should be used for 
Earthwork Volume Calculations. The other Preferences are used for Cross Section Plans 
Production only. (See Table 11.2). 

 
 

Table 11.2 
Preference – Create Cross Section 

 

Location: Evaluation Cross Section  Cross Sections Create Cross Section folder (Preferences Button)  

Preference Name Description 

10 Scale Work Sec 1x Vert Exg 
(Use for Earthwork Volumes) 

Used for Earthwork Volumes generation. This Preference uses the built in 
InRoads grid for viewing cross sections so that the entire cross section is 
drawn at each station for accurate earthwork volume calculations.  The 
Preference loads settings for a 10 Scale Horizontal with a 1X Vertical 
Exaggeration. 

50 Scale Work Sec 2x Vert Exg 
(Use for Earthwork Volumes) 

Used for Earthwork Volumes generation. This Preference uses the built in 
InRoads grid for viewing cross sections so that the entire cross section is 
drawn at each station for accurate earthwork volume calculations.  The 
Preference loads settings for a 50 Scale Horizontal with a 2X Vertical 
Exaggeration. 

Narrow 10h 10v 
(Use for Plans Production) 

Used for Plans Production of Cross Section “Narrow” Sheet generation.  This 
Preference loads the settings into the Create Cross Section dialog to view 
Cross Sections in a Narrow format on the GDOT SUXSEN Cross Section plan 
sheet cell.  The Preference loads settings for a 10 Scale Horizontal and 10 
Scale Vertical (Narrow 10h 10v). 

Wide 10h 10v 
(Use for Plans Production) 

Used for Plans Production of Cross Section “Wide” Sheet generation.  This 
Preference loads the settings into the Create Cross Section dialog to view 
Cross Sections in a Wide format on the GDOT SUXSEW Cross Section plan 
sheet cell.  The Preference loads settings for a 10 Scale Horizontal and 10 
Scale Vertical (Wide 10h 10v). 
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11.4 GDOT Earthwork Volumes Preference 
The generation of Earthwork Volumes is accomplished by using the End-Area Volumes 
command in InRoads. This command contains a Preference which has been set up to 
calculate Volumes to GDOT Standards. In order to generate the correct Volumes for GDOT– 
the “GDOT Earthwork Volumes” Preference must be set. The GDOT Earthwork Volumes 
Preference loads settings into the End-Area Volumes dialog to generate a Volumes Report. 
The Preference does not load settings to apply cut/fill adjustment factors. The Preference is 
accessed in the Evaluation Cross Section  Cross Sections  End-Area Volumes 
folder. The following table lists the GDOT Earthwork Volume Preference to select for the 
calculation of Earthwork Volumes.  (See Table 11.3). 

 
 

Table 11.3 
Preference – GDOT Earthwork Volumes 

 
Location: Evaluation  Cross Section  Cross Sections  End-Area Volumes folder. (Preferences Button) 

 

Preference Name Description 

GDOT Earthwork Volumes Used for Earthwork Volumes generation. This Preference loads the GDOT 
Standard Settings in the End-Area Volumes dialog for use in calculating 
Earthwork Volumes. The Preference does not load settings to apply cut/fill 
adjustment factors 
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11.5 GDOT Earthwork Volume Report 
The generation of the Earthwork Volume Report is accomplished by using the GDOT 
Earthwork Volumes.xsl Style Sheet. This Style Sheet is accessed by selecting the following 
command:  Evaluation  Cross Section  Cross Sections  End-Area Volumes folder.  
Click the Preferences button and load the GDOT Earthwork Volumes Preference. After 
clicking Apply – the Bentley Civil Report Browser opens. Select the Style Sheet named 
GDOT Earthwork Volumes.xsl.  The Style Sheet can be saved as an HTML file. For 
additional information regarding the Style Sheet – review the Style Sheet Help File which is 
included with the InRoadsALL standard files and is located in the following path: 
C:\InRoads Data\Style Sheet Documentation. (See Table 11.4). 
  

Table 11.4 
Style Sheet Report – GDOT Earthwork Volumes.xsl 

 
Location: Evaluation  Cross Section  Cross Sections  End-Area Volumes folder. (Preferences Button) 

 

Style Sheet Name Description 

GDOT Earthwork Volumes.xsl The GDOT Earthwork Volumes Report.xsl Style Sheet is utilized to supply 
Earthwork volume information.  It is used by the Designer and Earthwork 
Coordinator during the Design phase and Construction phase of a project. 
 
Please Refer to the GDOT Earthwork Volumes Report.xsl Style Sheet Help 
File for additional information. 
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12. Required Right of Way 

This section provides a brief overview of the requirements and processes for storing R/W Parcels 
and generating Right of Way Tables to GDOT Standards. For detailed Right of Way information 
please refer to Lab 12 in the Design Training Labs.   

This section covers the following topics: 
 
● Right of Way Overview 
● R/W Alignment and COGO Point Names/Feature Styles 
● R/W COGO Points and Alignment Points 
● R/W View Horizontal Annotation Preference 
● R/W View Horizontal Annotation Filters 
● Reviewing Horizontal R/W Alignments 
● R/W DGN File Generation 
● R/W and Easement Tables (Style Sheets) 
● R/W Deed (Style Sheets) 
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12.1 Right of Way Overview 
The following section depicts an overview of the processes to generate Required R/W and 
Easement Alignments, R/W DGN Files and R/W and Easement Tables to GDOT Standards 
in InRoads. Failure by the Designer to follow the correct Point and Alignment naming 
convention may cause problems with Survey Enhancements during the life of the project 
and with Stakeout Report generation.  In order to generate these Required R/W and 
Easements – the following information should be adhered and followed.  

 
a) All Right of Way and Easement Alignments must have a Feature Style assigned 

of REQD_P_DWESMT, REQD_P_PESMT, REQD_P_REQD or 
REQD_P_TESMT for the Right of Way Tables to generate correctly. 
 

b) In InRoads, the term Horizontal Alignment refers to all linear elements, open or 
closed, such as centerlines, right of way parcels, etc. Horizontal Alignments 
consist of COGO points, linear elements and curves. Curves are not 
independent entities but are considered part of the Alignment. 

 
c) All Right of Way Horizontal Alignment Names and COGO Point Names must 

begin with a DE Prefix.  All Points must begin numbering at DE10000 or the 
next available DE Point Number. Horizontal Alignment numbering may begin 
at DE1. 

 
d)  All Horizontal Alignment Points for Right of Way and Easements must be 

converted to COGO Points. 
 

e) When working on a Right of Way/Easement Alignment – ensure that it is set as 
the Active Alignment. 
 

f) When storing curve data in Right of Way and Easement Alignments – ensure 
that all the curves are tangent and points are equated at the PC and PT of all 
curves. 

 
g) Make sure to save the ALG file periodically when changes are made. InRoads 

does not save data on the fly - data is saved in temporary memory. The ALG 
file must be manually saved in order to retain Design modifications. 

 
h) Ensure that all Right of Way and Easement Alignments are stored in a clock-

wise direction for use in writing Deeds. 
 

i) In order to generate the R/W and Easement Tables and a Deed Description- 
Style Sheet(s) named GDOT RW Table.xsl and GDOT Deed.xsl should be 
selected.  The Style Sheet(s) are accessed by selecting the following command:  
In InRoads, select Tools ► XML Reports ► Hold down the CTRL key on 
your key board while Left clicking Legal Description.  The GaDOT Legal 
Description dialog opens. The Style Sheet(s) for both the R/W Tables and the 
R/W Deed can be saved as .txt file(s).  
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12.2 R/W Alignment and COGO Point Names/Feature Styles  
The Right of Way Horizontal Alignments and COGO Points must be stored with a DE Prefix 
and must be stored in a certain Point/Horizontal Alignment Number range along with the 
appropriate Feature Style. See the following Tables (Tables 12.1, 12.2 and 12.3) for a list of 
the required naming conventions). 

 
 

Table 12.1 
Standard R/W Design Geometry Object Names 

 

Object Type Prefix Starting Number 
*R/W Cogo Points  DE 10000 (Max. = 99,999) 

*R/W Horizontal Alignment Points DE 10000 (Max. = 99,999) 

**R/W Horizontal Alignments DE 1 

 
• * All Design Cogo Points and Design Horizontal Alignment Points must be named with a 

prefix of DE and begin with the number 10000 (e.g., first design point = DE10000). 
 

• **All Design Horizontal Alignments must be named with a prefix of DE and begin with the 
number 1, (e.g., DE1). 

 
 

Table 12.2 
R/W Design Point  & Alignment Ranges to Use 

 

Cogo/Alignment Points Range – 10,000 to 99,999 

Horizontal Alignments Range – 1  to no Limitations for Alignments -- but must have 
the DE Prefix 
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Table 12.3 
Feature Styles For R/W Design Points and Alignments 

  Feature Style 

REQD_P_DWESMT 
REQD_P_PESMT 
REQD_P_REQD 
REQD_P_RWRM 
REQD_P_TESMT 

 

   Proposed Right of Way  
Feature Style 
 
R/W Monument REQD_P_RWRM               N/A 

Reqd. R/W REQD_P_REQD                Ex: REQD R/W – PAR 33/SV29 

Perm. Const. Esmt. REQD_P_PESMT              Ex: PESMT – PAR 44/SV67 

Temp. Const. Esmt. REQD_P_TESMT              Ex: TESMT – PAR 23/SV88 

Driveway Esmt. REQD_P_DWESMT**     Ex: DWESMT – PAR 14/SV30 
 
 

** Note: All other Types of Miscellaneous Easements should use the REQD_P_DWESMT 
Feature Style. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Proposed Design Points    

 Descriptions    
(Feature Style – Parcel #/Parcel Align) 
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12.3 R/W COGO Points and Alignment Points 
As mentioned previously - InRoads has the capability to store both COGO Points (which 
are northing and easting coordinates) and the ability to store Alignments Points (which are 
just coordinates with an assigned name – not independent Points).  It is a required GDOT 
standard that all Points must be stored as COGO Points. If Alignment Points are stored – it 
is the Designer’s responsibility to convert these Points to COGO Points. In order to view 
the correct Point Cells and Symbology – COGO Points must be stored instead of 
Alignment Points in order to generate the correct Symbology, Level, etc. for plans 
productions. Following is a brief overview of COGO Points versus Alignment Points. 
 

***IMPORTANT DISCUSSION*** 
Alignment points and COGO points are two types of points to be aware of.  Alignment 
points are nothing more than names assigned to coordinates in an alignment and do not 
exist in the COGO points buffer.  In order to satisfy GDOT plan presentation requirements, 
prepare R/W tables and properly add enhanced survey data to your project. -- Surveyors 
and Designers alike must ensure that all alignments have a corresponding COGO point 
stored.  We recommend that you adhere closely to the methods presented in the tutorials 
concerning centerlines, R/W and property.  We bring this up because it is possible to view 
points at the same time as viewing Alignments without having to populate the Cogo Points 
in the View Horizontal Annotation command.  Viewing points in this manner would not 
apply the correct attributes to the points -- therefore you must view the Cogo points 
separately. 
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12.4 R/W View Horizontal Annotation Preference 
In order to view Right of Way and/or Easement Horizontal Alignments to GDOT Standards 
– the Preference named “NO BEARING & DISTANCE” should be selected. This Preference 
sets the viewing of Right of Way Alignments and Easement Alignments (No Bearing & 
Distance) options. The following Table depicts the available Preference, Location and 
Description to set the Preference. (See Table 12.4). 
 
 

Table 12.4 
Preference – R/W View Horizontal Annotation   

Location: Geometry View Geometry  Horizontal Annotation (Preferences Button) 

Preference Name Description 

NO BEARING & DISTANCE Displays NO Bearing & Distance information for all Horizontal Alignments. 
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12.5 R/W View Horizontal Annotation Filters 
Geometry Selection Filters can be used to select specific Alignments and COGO Points. 
Once selected and filtered – the Alignments and/or COGO Points will view and/or can be 
used for the generation of specific Style Sheets based on the criteria selected. A Filter can 
also be used to select the Points to utilize for Stakeout of R/W and Survey Data.  The 
following Tables depict the available Filters, Locations and Descriptions to set the Filters for 
R/W, Easements and Stakeout of R/W and Survey Data. (See Table 12.5). 
 
 

Table 12.5 
Geometry Selection Filter Preferences for R/W, Easements and Stakeout Data 

 
Location: Geometry View Geometry  Horizontal Annotation (Filter Button) 

Then in the Geometry Selection Filter – select the Preferences Button.  

Filter Name Description 

REQD.dgn Alignments Loads the Filter to select and view the Feature Style Alignments for the 
production of the REQD DGN File. 

REQD.dgn Points Loads the Filter to select and view the Feature Style Points for the 
production of the REQD DGN File. 

Stakeout Survey Data Loads the Filter to select the Feature Style Points for use in the GDOT 
Stakeout Report Style Sheet. 
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12.6 Reviewing Horizontal R/W Alignments 
The Horizontal Alignments for R/W and Easement descriptions can be reviewed and printed 
by using the Geometry Review Horizontal command. 
 
Following is the process for reviewing/describing Horizontal Alignments: 
 

• Ensure that the Horizontal Alignment (R/W or Easement Alignment) you want to 
describe is the active Horizontal Alignment. 

• In InRoads, Select Geometry ► Review Horizontal…and the Review Horizontal 
Alignment description appears. 

• The user may also print the description by using the Print button on the Review 
Horizontal Alignment dialog. (See Figure 12-1).   

 
 
 

 
 

Figure 12-1   Review Horizontal Alignment 
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12.7 R/W DGN File Generation 
After viewing the Required Right of Way and Easement Points, Cells, and Alignments – a 
MicroStation DGN file should be created to graphically represent these Geometry Objects. 
For detailed instructions on how to create the applicable DGN File – see Lab 12 in the 
Design Training Labs. The following table lists the standard naming convention of the DGN 
File which is to be generated.  (See Table 12.6). 

 
 

Table 12.6 
DGN File – Required Right of Way 

 
 

Location: In MicroStation – File Save As  
 

DGN File Name Example 

PI#REQD.dgn 1234567REQD.dgn   
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12.8 R/W and Easement Tables (Style Sheets) 
The generation of the R/W and Easement Tables is accomplished by using the GDOT RW 
Table.xsl Style Sheet. This Style Sheet is accessed by selecting the following command:  In 
InRoads, select Tools ► XML Reports ► Hold down the CTRL key on your key board 
while Left clicking Legal Description.  The GaDOT Legal Description dialog opens.   
Enter the appropriate Alignment and Reference Alignments and then click Apply. The 
Bentley Civil Report Browser opens. Select the Style Sheet named GDOT RW Table.xsl. 
The Style Sheet can be saved as a .txt file and then imported into MicroStation as a table. For 
additional information regarding the Style Sheet – review the Style Sheet Help File which is 
included with the InRoadsALL standard files and is located in the following path: 
C:\InRoads Data\Style Sheet Documentation. (See Table 12.7). 
  

Table 12.7 
Style Sheet Report (Table) – GDOT RW Table.xsl 

 
Tools ► XML Reports ► Hold down the CTRL key on your key board while Left clicking Legal Description. 

Style Sheet Name Description 

GDOT RW Table.xsl The GDOT RW Table.xsl Style Sheet is utilized to create Right-of-Way Table 
text files for placement in MicroStation with the GDOT Tools – Include Data 
Table placement Macro. 
 
Please Refer to the GDOT RW Table.xsl Style Sheet Help File for additional 
information. 
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12.9 R/W Deed (Style Sheets) 
The generation of the Right of Way Deed is accomplished by using the GDOT Deed.xsl 
Style Sheet. This Style Sheet is accessed by selecting the following command:  In InRoads, 
select Tools ► XML Reports ► Hold down the CTRL key on your key board while Left 
clicking Legal Description.  The GaDOT Legal Description dialog opens.   Enter the 
appropriate Alignment and Reference Alignments and then click Apply. The Bentley Civil 
Report Browser opens. Select the Style Sheet named GDOT Deed.xsl. The Style Sheet 
MUST BE saved as a .out file. This .out file is then used in the stand-alone Deed Writer 
Program to generate GDOT Deeds for purchase of Right of Way.  For additional information 
regarding the Style Sheet – review the Style Sheet Help File which is included with the 
InRoadsALL standard files and is located in the following path:  
C:\InRoads Data\Style Sheet Documentation. (See Table 12.8). 
  

Table 12.8 
Style Sheet Report (Table) – GDOT Deed.xsl 

 
Tools ► XML Reports ► Hold down the CTRL key on your key board while Left clicking Legal Description. 

Style Sheet Name Description 

GDOT Deed.xsl The GDOT Deed.xsl Style Sheet is utilized to supply a Deed.out file to the 
Right-of-Way office. The Right-of-Way office utilizes the Deed.out file to 
generate a Deed. 
 
Please Refer to the GDOT Deed.xsl Style Sheet Help File for additional 
information. 
 
Please Note: The Style Sheet must be saved as a .out file for use with the 
GDOT Deed Writer Program. 
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13. Survey Enhancements 

This section provides a brief overview of the processes to include Additional Survey 
Enhancements received from Photogrammetry/Survey during the Design Phase of a project. For 
detailed Survey Enhancement information please refer to Lab 13 in the Design Training Labs.   

This section covers the following topics: 
 
● Survey Enhancements Overview 
● Survey Enhancements to the DTM 
● Survey Enhancements to the ALG 
● Survey Enhancements to the DGN 
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13.1 Survey Enhancements Overview 
The following section depicts an overview of the processes to incorporate Survey 
Enhancements during the Design Phase of a project according to GDOT Standards.  In order 
to add the Survey Enhancement Data – the following information should be adhered and 
followed.  

 
a) During the life of a Design project – Additional Survey Enhancements may 

need to be incorporated into the project and the new survey data re-submitted to 
the Designer in order for the Designer to update the design database. 

 
b) All location survey data and all requests for additional survey data should be 

submitted to the Engineering Management Section of the Office of Design 
Policy and Support/Location Bureau. 

 
c) Depending on what type of enhancements are collected – the SDE will process 

the additional survey data and send the Designer the appropriate files as 
required. This could result in the SDE sending the Designer all of the updated 
files or just certain files depending on what data were collected.  
 

d) The Designer will receive a new PI#_SDE.dtm from the SDE when 
Enhancements are requested and incorporated for Surface Data.  After receiving 
the updated DTM – the Designer will delete their PI#_Exist.dtm and replace it 
with this new one.  The Designer will then rename the PI#_SDE.dtm both 
externally and internally to PI#_Exist.dtm (as previously described in the 
Design Training Lab 2).  The steps outlined in Design Training Lab 13 will 
instruct the user how to do this.    

 
e) When the Designer requests additional property or additional existing alignment 

enhancements that affect the InRoads ALG file, the SDE will add or change the 
data in the original PI#_SDE.alg file that is kept by the Survey Office.  When 
changes are complete, the Designer will be notified and provided with a copy of 
the revised PI#_SDE.alg file.  The Designer will delete out all Survey Data 
from the PI#_Design.alg file he is working in and will import all Survey Data 
from the revised PI#_SDE.alg to the PI#_Design.alg he is working in, using the 
LandXML Translator.  The steps outlined in Design Training Lab 13 will 
instruct the user how to do this.    

 
f) A new Enhanced DTM may not always be provided to the Designer if no 

changes were made to the DTM by the SDE.  The SDE will only provide an 
Enhanced DTM if new Features have been surveyed and incorporated into the 
DTM. If any topographical enhancements are collected – the SDE will send the 
Designer the new processed DTM file and the associated enhanced data in the 
PI#_TOPO.dgn file. 
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g) A new Enhanced Survey ALG file may not always be provided to the Designer 
if no changes were made to the Property or Existing Alignment data by the 
SDE.  The SDE will only provide an Enhanced ALG if new data has been 
surveyed and incorporated into the ALG.  If any property enhancements are 
collected – the SDE will send the Designer the new processed ALG file and the 
associated enhanced data in the PI#_PROP.dgn file. 

 
h) The InRoads LandXML utility is used to export the Enhanced Survey Data 

from the SDE’s ALG File and also to import the Enhanced Survey Data into the 
Designer’s ALG File. 

 
i) The Enhanced Existing DTM received from the SDE contains all of the Surface 

Points, Breaklines and Features along with the triangulated data. The Enhanced 
Property/Existing Alignment information in the ALG received from the SDE 
contains all of the SV Prefix Alignments and the Survey Cogo Points. 

 
j) If only property enhancements were collected, then the SDE would send the 

Designer the new processed PI#_SDE.alg file and the associated enhanced data 
in the PI#_PROP.dgn file.  

 
k) If only topographical enhancements were collected, then the SDE would send 

the Designer the new processed PI#_SDE.dtm file and the associated enhanced 
data in the PI#_TOPO.dgn file.  

 
l) In most cases the following files (or a combination) of these files will be 

submitted to the Designer for use as Additional Survey Enhancements: 
 

• PI#_SDE.dtm 
• PI#_SDE.alg  
• PI#_TOPO. dgn (if applicable) 
• PI#_PROP.dgn  (if applicable) 
• PI#_UTLE.dgn (if applicable) 
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Additional Survey Enhancement Process 
   (Red Dotted Line represents Additional Survey Enhancement Process Overview) 
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13.2 Survey Enhancements to the DTM 
The following section depicts information regarding the DTM file submitted to the Designer 
whenever Survey Enhancements have been incorporated by the SDE.  As mentioned 
previously, a new Enhanced DTM may not always be provided to the Designer if no 
changes were made to the DTM by the SDE.  The SDE will only provide an Enhanced 
DTM if new Features have been surveyed and incorporated into the DTM. If any 
topographical enhancements are collected – the SDE will send the Designer the new 
processed DTM file (PI#_SDE.dtm).   **For detailed Survey Enhancement information 
(procedures and processes) please refer to Lab 13 in the Design Training Labs.   

 

Brief Overview Process: 

• Step 1:  Copy the Enhanced PI#_SDE.dtm to the Project Folder. 

• Step 2.  Delete the PI#_Exist.dtm from the Project Folder. 

• Step 3:  Rename the External Name from PI#_SDE.dtm to PI#_Exist.dtm.  

• Step 4:  Rename the InRoads Internal Name from PI#_SDE.dtm to PI#_Exist.dtm.  
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13.3 Survey Enhancements to the ALG 
The following section depicts information regarding the ALG file submitted to the Designer 
whenever Survey Enhancements have been incorporated by the SDE.  As mentioned 
previously, a new Enhanced Survey ALG file may not always be provided to the Designer if 
no changes were made to the Property or Existing Alignment data by the SDE.  The SDE 
will only provide an Enhanced ALG if new data has been surveyed and incorporated into 
the ALG.  If any property enhancements are collected – the SDE will send the Designer an 
enhanced PI#_SDE.alg file. **For detailed Survey Enhancement information (procedures 
and processes) please refer to Lab 13 in the Design Training Labs.   
 

 

Brief Overview Process: 

• Step 1:  Copy the Enhanced PI#_SDE.alg to the Project Folder. 

• Step 2.  In the PI#_Design.alg – delete all Alignments with an SV Prefix.  

• Step 3:  In the PI#_Design.alg – delete all Points without a Prefix.  

• Step 4:  In the PI#_SDE.alg – export the Survey Data using LandXML Utility. 

• Step 5:  In the PI#_Design.alg – import the Survey Data using LandXML Utility. 
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13.4 Survey Enhancements to the DGN 
The following section depicts information regarding the DGN file(s) submitted to the 
Designer whenever Survey Enhancements have been incorporated by the SDE. The 
following DGN File(s) are updated by the SDE by merging the new data into the original 
PI#_TOPO.dgn, PI#_PROP.dgn and/or PI#_UTLE.dgn files depending on the data 
collected.  The Designer may not always receive all three of the above mentioned files. The 
Designer will only receive the updated DGN files if changes were made to the DGN files by 
the SDE.   
 
If Enhanced DGN Files are provided by the SDE – the Designer will overwrite his current 
TOPO, PROP and/or UTLE DGN Files and replace them with the new ones provided by 
Survey. 

 
  
**DGN Files –The DGN Files received from the SDE contain an underbar (_) in the file 
name. The reason for this is to assist in differentiating DGN data received from the SDE from 
that of the Design DGN files.  This will assist in organization of data during the enhancement 
processes.  The Designer must rename the DGN files from the SDE naming convention to the 
Design naming convention in order for the MicroStation customized Macros to function 
correctly and to conform to the current EDG (Electronic Data Guidelines).  If the Designer 
does not rename the DGN files (and remove the underbars) – the GDOT MicroStation 
Macros may not function. (See Table 13.1). 

 
Table 13.1 

Re-name SDE DGN Files 

SDE DGN FILE NAME Rename To  DESIGN DGN FILE NAME 
PI#_TOPO.dgn  PI#TOPO.dgn 

PI#_PROP.dgn  PI#PROP.dgn 

PI#_UTLE.dgn  PI#UTLE.dgn 
 

 
**For detailed instructions regarding the above re-naming process -- please refer to Lab 2 in 
the Design Training Manual:   Introduction to InRoads for Design. 
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14. InRoads Style Sheets 

This section provides a brief overview of the requirements and processes for generating InRoads 
Style Sheets to GDOT Standards. For additional information regarding the processing of Style 
Sheets, please refer to Lab 14 in the Design Training Labs.   

This section covers the following topics: 
 
● InRoads Style Sheets Overview 
● Location of GDOT Style Sheets 
● Location of GDOT Style Sheet Help Files 
● Descriptions of GDOT Style Sheets 
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14.1 InRoads Style Sheets Overview 
Style Sheets are used by InRoads to present data in a particular Report Format. The Style 
Sheets are XSL files which can be saved in different extensions depending on the Style 
Sheet used. Formats can be saved as .HTML, .OUT, .TXT, etc. depending on the function of 
the Style Sheet. GDOT has several Style Sheets which can be used to generate Report Data 
in a format for use in submitting Report deliverables for Design, Survey, Construction, etc.  
In order to generate these Style Sheets to GDOT Standards – the following information 
should be adhered and followed.  

 
a) The Style Sheet Data is based on XML (Extensible Markup Language) code 

which is used to generate the data from InRoads into an XSL (Extensible Style 
Sheet Language) Report Format. 
 

b) In order to generate Style Sheets to GDOT Standards for deliverables – the 
Style Sheets in the following location should be utilized: 
 
C:\InRoads Data\Style Sheets\GDOT\ 

 
The above path is set as the default in the Project Defaults Command in 
InRoads. (The process for setting this default path is described in the next 
section of the Guidelines). 

 
c) Following are the categories which are available: 

• Geometry 
• Station Base 
• Station Offset 
• Clearance 
• Stakeout 
• Legal Description 
• Map Check 
• Intersecting Alignment Stations 
• Point Validation 
• Surfaces 
• Surface Check 

 
d) It is very important that only the Style Sheets that have the name GDOT in it 

are used for submitting deliverables according to GDOT Standards. The 
Designer may use the generic InRoads Style Sheets during the Design Process – 
but all deliverable Reports MUST use the GDOT Style Sheets according to 
Design Policy. 
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14.2 Location of GDOT Style Sheets 
As mentioned previously, in order to generate Style Sheets to GDOT Standards for 
deliverables – the GDOT Standard Style Sheets should be utilized.  The GDOT Style Sheets 
are included in the InRoadsALL.exe download executable file.  

Once InRoadsALL.exe is executed and installed – the GDOT Style Sheets will be located 
in the following path: 

C:\InRoads Data\Style Sheets\GDOT\ 
 

In order to access these Style Sheets - the path should be set as the default path in InRoads 
by using the Project Defaults command. The Designer will need to enter this path in the  
InRoads Project by doing the following: 

 
In the InRoads pull-down select: 

 
1. FileProject Defaults from the InRoads pull-down menu.  
2.  Under the Default Directory Paths Section - Click in the Style Sheet  
 (*.xsl): field and then click the Browse button to navigate to the folder:  
 

C:\InRoads Data\Style Sheets\GDOT\.   
 

3. Next - click Open. 
4. The Current Configuration for the Style Sheets will now default to the 

following path: C:\InRoads Data\Style Sheets\GDOT 
5. Click Apply. 
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14.3 Location of GDOT Style Sheet Help Files 
GDOT Style Sheet Help Files are included in the InRoadsALL.exe download executable 
file.  

Once InRoadsALL.exe is executed and installed – the GDOT Style Sheets will be installed 
and located in the following path: 

C:\InRoads Data\Style Sheet Documentation 
 

 These GDOT Style Sheet Help Files depict detailed information regarding the usage of the 
Style Sheets, the format of the Style Sheets and the type of extension (.html, .txt, .etc.)  in 
which the Style Sheet should be saved. 
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14.4 Descriptions of GDOT Style Sheets 
Customized Style Sheets have been created to GDOT Standards in order to provide Reports for InRoads Data.  These Style 
Sheets correspond to GDOT Policy and should be utilized for Report deliverables when required. The following Table lists the 
current available GDOT Style Sheets, the Location to Access the Style Sheets in InRoads and a brief Description of the Style 
Sheets. Detailed Help Files are also available as discussed in the previous Section 14.3. (See Table 14.1). 

 
Table 14.1 

Style Sheet Descriptions  
 
 
Style Sheet Name 

(.xsl) Location Description 

GDOT 3D Alignment 
Comparison Report 

Tools ►            
XML Reports ► 
Station Base 

The GDOT 3D Alignment Comparison.xsl Style Sheet is utilized to report 
the Station, Elevation, Horizontal Offset and Vertical Offset from one 
alignment (Baseline Alignment) to a second alignment (Offset Alignment). 
 

GDOT Alignment File 
Descriptions 

Tools ►            
XML Reports ► 
Geometry 
 

The GDOT Alignment File Descriptions.xsl Style Sheet is utilized to supply a 
text file description of the centerline alignments to the Contractor. 
 

GDOT Alignment Points List Tools ►            
XML Reports ► 
Geometry 
 

The GDOT Alignment Points List.xsl Style Sheet lists all the points in an 
alignment in a format that may be copied and pasted into the View Horizontal 
Annotation dialog’s Cogo Points include: field.  This function is useful during 
Right-of-Way plans preparation when the Cogo points in the Right-of-Way 
alignments need to be viewed.  In InRoads V8i, viewing the Cogo points 
comprising the R/W alignments is the only way to ensure the proper point 
symbols are viewed in MicroStation. 
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Style Sheet Name 
(.xsl) Location Description 

GDOT Alignment Report Tools ►            
XML Reports ► 
Geometry 
 

The GDOT Alignment Report.xsl Style Sheet is utilized to supply Horizontal 
Alignment information to the Contractor for use in GPS equipment. The Report 
depicts the Alignment information located at 50 Foot Station intervals at a Zero 
Offset. The GDOT Alignment Report.xsl will contain each Horizontal 
Alignment with the Feature Styles of MAIN_P_CONSTCL and 
MAIN_P_SIDECL in the InRoads Project Database (.ALG file). The 
Alignments may all be generated at one time and listed in one GDOT 
Alignment Report.xsl. 
 

GDOT Deed Tools ►            
XML Reports ► 
CTRL key + Legal 
Description 
 

The GDOT Deed.xsl Style Sheet is utilized to supply a Deed.out file to the 
Right-of-Way office.  The Right-of-Way office utilizes the Deed.out file to 
generate a Deed. 
 

GDOT Earthwork Volumes 
Report 

Evaluation Cross 
Section  Cross 
Sections  End-
Area Volumes folder  

The GDOT Earthwork Volumes Report.xsl Style Sheet is utilized to supply 
Earthwork volume information.  It is used by the Designer and Earthwork 
coordinator during the design phase and construction phase of a project. 
 

GDOT End-Area Report - 
Compressed 

Evaluation Cross 
Section  Cross 
Sections  End-
Area Volumes folder 

The GDOT End-Area Report-Compressed.xsl Style Sheet writes out an End-
Area file to an ASCII text file format that is similar to the RDS format for 
distribution to Auditors and Contractors when a project is let to Construction.  
This format uses much less paper when compared to the GDOT End-Area 
Report-Standard.xsl. 
 

GDOT End-Area Report - 
Standard 

Evaluation Cross 
Section  Cross 
Sections  End-
Area Volumes folder 

The GDOT End-Area Report-Standard.xsl Style Sheet is utilized to supply 
an End-Area report in a standard GDOT ASCII text file format for distribution 
to Contractors when a project is let to Construction. 
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Style Sheet Name 
(.xsl) Location Description 

GDOT Feature Lengths 
Report  

Tools ►            
XML Reports ► 
Surfaces 
 

The GDOT Feature Lengths Report.xsl Style Sheet is utilized to determine 
lengths of Features used in Finished surfaces.  It requires the Designer to use a 
unique point name in the component utilized to create the surface. 
 

GDOT Feature-
StationElevationOffset Report 

Tools ►            
XML Reports ► 
Clearance 
 

The GDOT Feature-StationElevationOffset Report.xsl Style Sheet is 
utilized to supply a Station, Elevation and Offset Report from the Roadway 
Centerline to selected Surface Features in the Digital Terrain Model (DTM).   
 

GDOT Feature Volumes 
Report 

Evaluation Cross 
Section  Cross 
Sections  End-
Area Volumes folder 

The GDOT Feature Volumes Report.xsl Style Sheet is utilized to supply 
volumes of component shapes placed in the Final design surface.   This Report 
will only work on closed shape components.  Each component for which 
volumes are desired must be set up with a unique Feature Style. 
 

GDOT GPS Grading Report Evaluation Cross 
Section  Cross 
Sections  End-
Area Volumes folder 

The GDOT GPS Grading Report.xsl Style Sheet is utilized to supply an End-
Area report of the Proposed “Finished Surface” in a standard GDOT ASCII 
text file format for distribution to Contractors before the award of the contract 
(pre-award).  The GDOT GPS Grading Report generates a report on the 
proposed Finished Surface and does not report the Existing Surface. This file is 
utilized by contractors to upload data for use in Automated Grading Machines.  
 

GDOT HEC RAS Bridge 
Features Report 

Tools ►            
XML Reports ► 
Clearance 
 

The GDOT HEC RAS Bridge Features Report.xsl Style Sheet is utilized to 
supply a Station, Elevation and Offset Report from the Roadway Centerline to 
selected Surface Features representing the existing Bridge Geometry.  This 
Report is then used for input of the Bridge Geometry data into HEC RAS. 
 

GDOT HEC RAS Cross 
Section Geometry Report 

Tools ►            
XML Reports ► 
Clearance 
 

The GDOT HEC RAS Cross Section Geometry Report.xsl Style Sheet is 
utilized to supply a comma delimited Station and Elevation Report from the 
Roadway Centerline for use in importing Cross Sectional geometric data into 
HEC RAS.  The Cross Sectional data is reported based on the Offset Parallel 
Alignments/Profiles from the Roadway Centerline through a Stream Center. 
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Style Sheet Name 
(.xsl) Location Description 

GDOT HEC RAS (Wide 
Floodplain) Cross Section 
Geometry Report 

Tools ►            
XML Reports ► 
Clearance 
 

The GDOT HEC RAS (Wide Floodplain) Cross Section Geometry 
Report.xsl Style Sheet is utilized to supply a comma delimited Station and 
Elevation Report (for Wide Floodplain Cross Sections) from the Roadway 
Centerline for use in importing Cross Sectional geometric data into HEC RAS.  
The Cross Sectional data is reported based on the Offset Parallel 
Alignments/Profiles from the Roadway Centerline through a Stream Center. 
 

GDOT Intersecting 
Alignment Stations 

Tools ►            
XML Reports ► 
Intersecting 
Alignment Stations 
 

The GDOT Intersecting Alignment Stations.xsl Style Sheet is utilized to 
report the Intersecting Stations, Elevations, Elevation Difference and Northing 
and Easting coordinates between two or more alignments.   

GDOT Roadway Design 
Milling Report 

Modeler ►            
Roadway Designer 
► Tools ►Milling 
Report 

The GDOT Roadway Design Milling Report.xsl Style Sheet is utilized to 
report the Total Planar Area for Milling. A “Process All” should be performed 
before creating a Milling Report.  

GDOT Ponding Report Evaluation ►    
Cross Section ► 
Cross Section Report 
 

The GDOT Ponding Report.xsl Style Sheet is utilized to report profile 
stations where the longitudinal grade < 1.0% and the road cross slope < 0.5%. 
 

GDOT RW Table   Tools ►            
XML Reports ► 
CTRL + Legal 
Description 

The GDOT RW Table.xsl Style Sheet is utilized to create Right-of-Way Table 
text files for placement in MicroStation with the GDOT Tools – Include Data 
Table placement macro. 
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Style Sheet Name 
(.xsl) Location Description 

GDOT Stakeout Report Tools ►            
XML Reports ► 
Point Validation 
 

The GDOT Stakeout Report.xsl Style Sheet is utilized to check for Duplicate 
Points and supply Point information to the Surveyor for use in staking out 
alignments and property.   The Report lists the point name, easting and northing 
for all points with the Feature Styles listed below.  When the report is saved as 
an ASC file it may be used to upload the points directly into the surveyor’s data 
collector for staking in the field. 
 

• PROP_E_PAR • PROP_E_RWE • PROP_E_RWM 
• PROP_E_RWC • PROP_E_RWU • PROP_E_POEL 
• PROP_E_PPC • PROP_E_PCF • TOPO_E_SNGSCM 
• TOPO_E_SLCM • TOPO_E_SLCD • TOPO_E_SDCD 
• TOPO_E_SBNCHMK • REQD_P_* • MAIN_P_CONSTCL 
• MAIN_P_SIDECL  

 
 

 

GDOT Station-Offset Report Tools ►            
XML Reports ► 
Clearance 
 

The GDOT Station-Offset Report.xsl Style Sheet is utilized to supply Station 
and Offset information of selected Cogo Points to a selected Horizontal 
alignment. 
 

GDOT SUE Utility QL-A 
Location Report 

Tools ►            
XML Reports ► 
Clearance 
 

The GDOT SUE Utility QL-A Location Report.xsl Style Sheet is utilized to 
supply a report depicting Test Hole Name, Description, Station and Offsets for 
SUE QL-A Test Hole data. 
 

GDOT Superelevation Data 
Report 

Modeler ► 
Roadway Designer 
► Superelevation ► 
Superelevation 
Report 

The GDOT Superelevation Data Report.xsl Style Sheet is utilized to provide 
superelevation information that was applied using the Create Superelevation 
Wizard.  The GDOT Superelevation Data Report lists the Station, Cross 
Slope and Point Type (Normal Crown, Zero Cross Slope, Reverse Crown, and 
Full Super) for each superelevation transition location. 
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Style Sheet Name 
(.xsl) Location Description 

GDOT Surface Check Report Tools ►            
XML Reports ► 
Surface Check   
 

The GDOT Surface Check Report.xsl Style Sheet is utilized to verify the 
tolerance and accuracy of an Existing Digital Terrain Model (original terrain 
surface) as compared against associated field survey points. 
 

GDOT Vertical Clearance  Tools ►            
XML Reports ► 
Clearance 
 

The GDOT Vertical Clearance Report.xsl Style Sheet is utilized to supply 
the vertical clearance information from selected Cogo Points to a selected 
Horizontal alignment. 
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15. Additional File Deliverables 

This section provides a brief overview of Additional File Deliverables which are required to be 
submitted when using the InRoads Design Software. Several Additional Files are generated in 
InRoads for use by other Offices internal to GDOT. Additional Files are also provided to 
Contractors when a Project is complete and let to Construction. 

This section covers the following topics: 
 
● Additional File Deliverables Overview 
 
● InRoads File Deliverables to GDOT  

o Write Stakeout Data to a Data Collector 
o Generate GDOT Deed File(s) 
o InRoads Project Data Sheet(s) 
o GDOT InRoads Design Data Quality Assurance Checklist  

 
● InRoads File Deliverables to Contractors 

o Alignment File Description(s) 
o Alignment Report File(s) 
o End-Area Report File(s) 
o GPS Grading Report File(s) 
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15.1 Additional File Deliverables Overview 
The following section depicts an overview of the Style Sheets, Data Files and Reports which 
are required as Additional File Deliverables. In order to generate these Additional File 
Deliverables – the following information should be adhered and followed.  

 
a) The GDOT Standard Style Sheets for generating the Additional File 

Deliverables are located in the following path: 
C:\InRoads Data\Style Sheets\GDOT. 
 

b) For Detailed Help Instructions on using the Style Sheets – please see the GDOT 
Style Sheet Help Files which are located in the following path:   
C:\InRoads Data\Style Sheet Documentation 
 

c) To generate the GDOT Stakeout Data File for staking of R/W – the InRoads 
LandXML Generator should be used. 

 
d) To generate the Deed output files for use in writing Deeds – the following Style 

Sheet should be used:  GDOT Deed.xsl. 
 

e) To generate the Alignment File Descriptions which depict the Alignment 
information (including the Curve Data and Coordinate information) for Feature 
Styles MAIN_P_CONSTCL and MAIN_P_SIDECL - the following Style 
Sheet should be used:  GDOT Alignment File Descriptions.xsl. 

 
f)  To generate the Alignment Report files which depict the Alignment 

information at 50’ intervals for use by Contractors – the following Style Sheet 
should be used:  GDOT Alignment Report.xsl. 
 

g) The End-Area Report which is submitted to Contractors for use in the 
Earthwork process utilizes the following Style Sheet:  GDOT End-Area 
Report-Standard.xsl. 

 
h) To generate the GPS Grading Report file(s) for use by Contractors – the 

following Style Sheet should be used:  GDOT GPS Grading Report.xsl. 
 

i) The Project Data Sheet is a required Deliverable that should list all of the 
pertinent InRoads Design information. This file is used by Designers to help 
document associated files and data for use during the Design process. This file 
is also submitted as a deliverable with the InRoads project files so that users 
who inherit the project can easily identify project data. This file is included in 
the InRoadsALL.exe. 

 
j) A Quality Assurance Control Checklist is also required. This is a checklist that 

the Designer should utilize to ensure that all pertinent Design Data is included 
for Project Delivery. This File is included in the InRoadsALL.exe.  
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15.2 InRoads File Deliverables to GDOT 
As mentioned previously, there are several Additional File Deliverables which are required 
to be submitted by the Designer for use by other Offices in the Department.  The following 
Section contains information on how to generate the following Report/Data Files: 

o Write Stakeout Data to a Data Collector using InRoads LandXML 
o Generate GDOT Deed File(s) 
o InRoads Project Data Sheet(s) 
o GDOT InRoads Design Data Quality Assurance Checklist  
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15.2.1 Write Stakeout Data to a Data Collector using InRoads LandXML 
The following procedure is used to export Stakeout Data such as COGO Points, 
Horizontal/Vertical Alignments, etc. from InRoads to a LandXML file. This LandXML file 
can then be uploaded to the GDOT Trimble Business Center/GDOT Trimble Data 
Collectors for use in staking out Survey Data. 

 
Workflow Procedure: 
Open the InRoads ALG file. Then utilize the LandXML Translator to select the COGO 
Points and Horizontal/Vertical alignments which will be written out to create the 
LandXML File. 
 
Feature Styles to Export to LandXML for Stakeout: 

• PROP_E_PAR • PROP_E_RWE • PROP_E_RWM 
• PROP_E_RWC • PROP_E_RWU • PROP_E_POEL 
• PROP_E_PPC • PROP_E_PCF • TOPO_E_SNGSCM 
• TOPO_E_SLCM • TOPO_E_SLCD • TOPO_E_SDCD 
• TOPO_E_SBNCHMK • REQD_P_* • MAIN_P_CONSTCL 
• MAIN_P_SIDECL   

  
Workflow Steps: 

 
A. Open the Geometry Project (.ALG) in InRoads 

1. In InRoads, select File Open 
 

2. Set the Files of type:  Geometry Projects (*.alg) 
 

3. Select the .ALG File (Geometry Project) that contains the Cogo Points and 
Alignments that are to be exported to the LandXML file. 
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B. Create the LandXML File 
1. In InRoads, select File TranslatorsLandXML Translator 

 
2. Select the Export Alignment tab 

 
3. Select the Geometry Project: 
 
4. Click in the Include: field to activate the Filter button 

 
5. The Geometry Selection Filter dialog box opens. Select all of the Alignments that are 

to be included in the XML file. Then click OK. 
 
6. Ensure that LandXML: Version 1.0 is selected. 

 
7. Check the box to “Include All Cogo Points”.  

Note: This box can be left unchecked if no Cogo Points need to be included in the 
             LandXML file. 
 

8. Important - Change the Linear Units to: US Feet 
 

9. Change the State: to  proposed 
10. Click the Save As button. The Export dialog opens. Key in the File Name: and click 

Save. 
 

11. In the File Name: field - the name of the file will be listed. 
 
12.  Ensure your dialog box is similar to the one depicted below: 

Note: If the LandXML file is written by Survey, the ALG file Name will be PI#_SDE. 
      If the LandXML file is written by Design, the ALG file Name will be PI#_Design. 
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Figure 15-1   LandXML 

 
 

13. Next, click Close to close the dialog box. 
 

14. The LandXML file will be created in the Path depicted in the File Name: field. 
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15.2.2 Generate GDOT Deed File(s) 
 In order to write out data from InRoads to use as the Metes and Bounds description for 

generation of Deeds, the GDOT Deed.xsl Style Sheet is used. The GDOT Deed.xsl Style 
Sheet is utilized to create an output (.OUT) file which is imported into the stand-alone 
GDOT Deed Writer program. The Deed Writer Program is used by the Office of Right of 
way to create Deeds for the purchase of Right of Way on the project.   

 
NOTES:  

a) For Detailed Instructions on using the GDOT Deed.xsl Style Sheet – please see the 
GDOT Style Sheet Help Files which are located in the following path: 

           C:\InRoads Data\Style Sheet Documentation 
b) Points must be stored at the PC and the PT of Curves in order to generate an accurate 

Metes and Bounds Deed file. 

c) The Points must be stored in a clockwise direction to facilitate the Deed Writing 
process. 

d) To access the Style Sheet – select the following from the InRoads pull-down menu: 
Tools ►XML Reports ► CTRL + Legal Description 
 

e) The GDOT Deed.xsl Style Sheet Report should be saved with an .OUT Extension. 

f) The Naming Convention for the GDOT Deed .OUT File will be Alignment 
Name.out (Example: DE31.out). 

 
 

Table 15.1 
File Naming Convention – GDOT Deed 

 
 

              Location: Tools ►XML Reports ► CTRL + Legal Description 
 
 

File Name Example 

Alignment Name.out DE31.out   
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15.2.3 InRoads Project Data Sheet(s) 
The Project Data Sheet is used to document the design files and data contained in the 
InRoads Database File(s). This documentation not only assists the Designer during the 
Design process but also is used by other personnel who may inherit the project in latter 
stages to help identify the correct design files and design objects. This Project Datasheet 
File should be submitted as an Additional Deliverable along with the associated InRoads 
Project Database File(s).   

 
NOTES:  

a) The Project Data Sheet is included with the InRoadsALL.exe download and may 
be found in the following location on the hard drive: 

           C:\InRoads Data\Standards  
b) The Designer should create a Documentation Folder under the C:\InRoads Data\PI 

Number directory. The Project Data Sheet and any additional Project Documentation 
should be included in this folder and submitted along with the InRoads Project 
Database File(s). 

c) The following page contains a screen capture of the Project Data Sheet: 
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15.2.4 GDOT InRoads Design Data Quality Assurance Checklist 
The GDOT InRoads Design Data Quality Assurance Checklist will be documented 
and submitted by the Designer or Design Consultant. This document is an overall 
checklist to ensure that the applicable Design Deliverables are submitted to Construction 
(Earthwork Coordinators) and/or GDOT Design Personnel after the Design aspect of the 
Project is completed. Some of the areas listed in the checklist include: Design Data 
submitted, Proposed DTM Surface information, Geometry Data, Templates, Cross-
Sections, etc. The Designer is to use this checklist to verify that the Project Deliverables 
contain all the requisite data before submittal to Earthwork Coordinators during the Field 
Plan Reviews, Letting and Construction Phases.   
 
 
NOTES:  

a) The GDOT InRoads Design Data Quality Assurance Checklist is included with the 
InRoadsALL.exe download and may be found in the following location on the hard drive: 

           C:\InRoads Data\Standards 
 
The GDOT InRoads Design Data Quality Assurance Checklist is available for 
download by navigating to the MicroStation and InRoads links from the following 
location:      
 

    http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx 
 
b) The Designer should create a Documentation Folder under the C:\InRoads Data\PI 

Number directory. The GDOT InRoads Design Data Quality Assurance Checklist and 
any additional Project Documentation should be included in this folder and submitted 
along with the InRoads Project Database File(s). 

c) The following page contains a screen capture of the GDOT InRoads Design Data Quality 
Assurance Checklist: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
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Georgia Department of Transportation   
 

 
      
 
 

GDOT InRoads Design Data Quality Assurance Checklist   
 

(Instructions:  In the Verified Column pull down – enter YES, NO or N/A for the Verification QA Status) 
 

         CATEGORY TASK VERIFIED 

Geometry Project -- (.ALG) The Geometry Project (.ALG) is named the PI#_Design.alg _____ 

  All Alignments stored have the DE Prefix for the Alignment Name _____ 
 All Points stored have the DE Prefix and begin numbering at 10,000 _____ 

 All Alignment Points are converted to COGO Points in the Geometry Project _____ 

 All Required R/W Alignments are stored clockwise and the Alignments close _____ 
 The beginning and ending point of each curve is equated to a point number _____ 

 All Alignments and Points are stored with standard GDOT Feature Styles _____ 
     

DTM Surface(s) -- (.DTM) The Design Surface(s)  DTM’s are named the PI#_Corridor  Name.dtm _____ 
  If a Bogus Surface is utilized – the DTM is named PI#_Bogus1.dtm _____ 

 The Finish Preference is used for the Final DTM Surface Symbology _____ 

 The Bogus Preference is used for the Bogus DTM Surface Symbology _____ 
     

Template Library – (.ITL)  The Project Template Library (.ITL) is named PI#.itl _____ 
  All templates utilized in the Project Design are included in the Template ITL _____ 

  The Standard GDOT Feature Styles are used for all components and points _____ 
     

Roadway Design – (.IRD) The Roadway Design File (.IRD) is named PI#.ird _____ 

  The Roadway Corridor is named PI#_Roadway Name (or Alignment Name) _____ 
    

Final Deliverables -Internal Stakeout Data Report _____ 
 Deed (.OUT) Files _____ 

  InRoads Project Data Sheet _____ 
 GDOT InRoads Design Data Quality Assurance Checklist _____ 

     

Final Deliverable -Contractor Alignment File Descriptions(s) _____ 
 Alignment Report Files(s) _____ 

  End-Area Report File(s) _____ 

P.I. Number:  
County:  
Project Description:   
QA Reviewer:  
Phone Number:  



 Additional File Deliverables  InRoads Design Guidelines SS2 

 15-13 
 
 

15.3 InRoads File Deliverables to Contractors 
As mentioned previously - when a project is complete and let to construction, there are 
several additional File Deliverables which are required to be submitted by the Designer for 
use by Contractors.  The following Section contains information on how to generate the 
following Style Sheets: 

o Alignment File Description(s) 
o Alignment Report File(s) 
o End-Area Report File(s) 
o GPS Grading Report File(s) 

 

NOTE: The Alignment File Descriptions, Alignment Report Files and the End-Area Report 
Files will be provided Pre-Award of the contract. 

 

NOTE: The GPS Grading Report File(s) will be provided Pre-Award of the contract. 
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15.3.1 Alignment File Descriptions 
Text file descriptions of the Alignments with Feature Styles of MAIN_P_CONSTCL 
(Construction Centerline) and MAIN_P_SIDECL (Sideroad Centerline) will be provided to 
the Contractor. These text files will list all of the applicable Centerline Alignment 
information including the associated Curve Data. A Filter may be used to select the Feature 
Styles of MAIN_P_CONSTCL and MAIN_P_SIDECL. The Descriptions can be generated 
for each Alignment at the same time and included in one .TXT output file.   

 
 

NOTES:  
a) For Detailed Instructions on using the GDOT Alignment File Descriptions.xsl 

Style Sheet – please see the GDOT Style Sheet Help Files which are located in the 
following path: 

           C:\InRoads Data\Style Sheet Documentation 
b) A Geometry Filter can be utilized to select all of the applicable alignments with 

Feature Styles of MAIN_P_CONSTCL and MAIN_P_SIDECL. 

c) To access the Style Sheet – select the following from the InRoads pull-down menu: 
Tools ►XML Reports ► Geometry. 
 

d) The GDOT Alignment File Descriptions.xsl Style Sheet Report should be saved 
with a .TXT Extension. 

e) The Naming Convention for the GDOT Alignment File Descriptions will be 
PI#_AL.txt (Example: 1234567_AL.txt). 

f) The following Feature Styles will be written to the Alignment File Descriptions 
Report:  

 
• MAIN_P_CONSTCL 
• MAIN_P_SIDECL 

 
Table 15.2 

File Naming Convention – Alignment File Descriptions 
 
 

                          Location: Tools ►XML Reports ► Geometry 
 
 

File Name Example 

PI#_AL.txt 1234567_AL.txt   
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15.3.2 Alignment Report Files 
Alignment Report Files will be utilized to supply alignment information to the Contractor 
for use in GPS equipment.  This report depicts the alignment information located at 50 Foot 
Station intervals at a Zero offset.  The report is required for each of the alignments with 
Feature Styles of MAIN_P_CONSTCL and MAIN_P_SIDECL. 

 
 

NOTES:  
a) For Detailed Instructions on using the GDOT Alignment Report.xsl Style Sheet – 

please see the GDOT Style Sheet Help Files which are located in the following path: 

           C:\InRoads Data\Style Sheet Documentation 
b) A Geometry Filter can be utilized to select all of the applicable alignments with 

Feature Styles of MAIN_P_CONSTCL and MAIN_P_SIDECL. 

c) To access the Style Sheet – select the following from the InRoads pull-down menu: 
Tools ►XML Reports ► Geometry. 
 

d) The GDOT Alignment Report.xsl Style Sheet should be saved with an .HTML 
Extension. 

e) The Naming Convention for the GDOT Alignment Report will be PI#_Alignment 
Report.html (Example: 1234567_Alignment Report.html). 

f) The following Feature Styles will be written to the Alignment File Descriptions 
Report:  

 
• MAIN_P_CONSTCL 
• MAIN_P_SIDECL 

 
 
 

Table 15.3 
File Naming Convention – Alignment Report Files 

 
 

Location: Tools ►XML Reports ► Geometry  
 

File Name Example 

PI#_Alignment Report.html 1234567_Alignment Report.html   
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15.3.3 End-Area Report Files 
The GDOT End-Area Report-Standard.xsl Style Sheet is utilized to supply an End-Area 
report in a standard GDOT ASCII text file format for distribution to Contractors when a 
project is let to Construction. 

 
 

NOTES:  
a) For Detailed Instructions on using the GDOT End-Area Report-Standard.xsl 

Style Sheet – please see the GDOT Style Sheet Help Files which are located in the 
following path: 

           C:\InRoads Data\Style Sheet Documentation 
b) To access the Style Sheet – Select the following from the InRoads pull-down menu: 

Evaluation Cross Section  Cross Sections  End-Area Volumes folder 
c) The GDOT End-Area Report-Standard.xsl Style Sheet should be saved with an 

.END Extension. 

d) The Naming Convention for the GDOT End-Area Report-Standard.xsl will be 
PI#_Alignment Name.end (Example: 1234567_DE31.end). 

 
 

Table 15.4 
File Naming Convention – End-Area Report Files 

 
 

Location: Evaluation Cross Section  Cross Sections  End-Area Volumes folder 
 

File Name Example 

PI#_Alignment Name.end 1234567_DE31.end   
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15.3.4 GPS Grading Report Files 
The GDOT GPS Grading Report.xsl Style Sheet is utilized to supply an End-Area report of 
the Proposed “Finished Surface” in a standard GDOT ASCII text file format for 
distribution to the Contractor before the award of the contract (pre-award).  

 
 

NOTES:  
a) For Detailed Instructions on using the GDOT GPS Grading Report.xsl Style Sheet 

– please see the GDOT Style Sheet Help Files which are located in the following 
path: 

           C:\InRoads Data\Style Sheet Documentation 
b) To access the Style Sheet – Select the following from the InRoads pull-down menu: 

Evaluation Cross Section  Cross Sections  End-Area Volumes folder 
 

c) The GDOT GPS Grading Report.xsl Style Sheet should be saved with an .END 
Extension. 

d) The Naming Convention for the GDOT GPS Grading Report.xsl will be 
PI#_Alignment Name_GPS.end (Example: 1234567_DE31_GPS.end). 

 
 

Table 15.5 
File Naming Convention – GPS Grading Report Files 

 
 

Location: Evaluation Cross Section  Cross Sections  End-Area Volumes folder 
 

File Name Example 

PI#_Alignment Name_GPS.end 1234567_DE31_GPS.end   
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